in



COLLABORATORS

TITLE -
in
ACTION NAME DATE SIGNATURE
WRITTEN BY December 2, 2024
\ REVISION HISTORY
NUMBER DATE DESCRIPTION NAME




in iii

Contents

1 in 1
L1 main . . .o o e e e e e 1
1.2 welcome . . . . . .o e 9
L3 1-0. . o 11
LA T-1 0 e 12
LS 12 12
Lo 1-3 . 13
L7 1-4 o 14
L8 15 15
1O 1-6 . . 16
LI0 1-7 . o 17
LIT 1-7a . oo o 17
LI2 129 . 18
L3 1-10 .« o o 19
L14 1-10a . . o 19
LIS T-11 .o e e 19
LI6 2-0 . . e 20
LIT7 2-1 0 0 o 21
I8 2-2 1 21
LI9 2-4 0 o 22
L20 2-5 . . o 23
L21 2-0 . . e 24
122 2-7 o 24
123 2-8 . 25
124 2-8a . . L 26
125 2-10 .« o o o 27
126 2-11 . o o 27
127 2-12 28
128 2-12a .« . L o 29
129 2-13 e 29




130 2-14 . o o e 30
L31 2-15 . 30
1.32 2-15a . . . e 31
133 2-16 . . . 31
134 3-00. . o e 31
L35 3-1 . e 32
130 3-2 0 e 32
L37 3-4 . o 34
138 3-0 . . e 35
139 3-8 . 37
140 3-9 . o o e 38
LAL 3-10 . . o 38
142 3-12 L L e 40
LA3 3-14 . 41
144 3-16 . o o e 42
LAS 3-18 . o 43
146 4-0 . . o e 44
LAT 4-1 . 0 o o 44
LA8 4-2 . o e 45
LA 4-3 0 o 46
150 4-4 . o o e 47
LS1 4-5 0 o 48
1.52 4-6 . . o e e 48
1.53 5-00. . o o 50
154 5-1 0 o o e 50
155 5-2 0 o 51
1.56 5-3 L o e 51
157 5-3a . o o 52
1.58 5-3b . o o e 52
1.59 5-4 . 52
1.60 5-4a . . . . e 53
161 5-5 . o o 53
1.62 5-6 . . o e 54
1.63 5-6a . . . . . 54
1.64 5-6b . . . e e 54
1.65 5-7 . o o 55
1.66 5-7Ta . . . e 55
.67 5-8 . o o 56

1.68 6-0 . . . . e e 57




in v
1.69 6-1 . . o e 57
L70 6-2 . . 58
171 6-3 0 e 58
L72 6-4 . . o 59
173 6-4a . . . o e 60
L74 6-5 . . o 61
175 6-6 . 0 o e 61
L76 6-6a . . . . . 62
O 62
L78 6-8 . . o 63
179 6-10 . . e 64
L8O 6-12 . . . 66
L.81 6-13 . . e 67
182 6-13a . . . . . 67
1.83 6-14 . . o e 68
L84 T-0 . . o o 69
185 -1 . o e 70
L8O T-2 . o o 71
187 T-3 o e 72
L.88 7-3a . . o 72
1.89 T-4 . o e 72
190 7-5 . o o 73
LO1 T-6 . o o e 74
192 T-T o o 76
1.93 7-9 o e 76
1.94 T-10 . o o 71
195 T-11 . o o e 78
196 T-12 . o o 79
L.O7 T-12a . . . o o e e 79
198 T-13 . o 80
1.99 T-14 . . e 80
O 0 81
LAOLIT-15 . o o e 81
LI027-15a . . . o o 82
L1037-16 . . o e 82
LI0AT7-16a . . . . o o o e 83
LAOST-1T . o o e 83
LI06T-18 . o o 84

LA0T7-19 . o o e 85




in vi
LI0BT-20 . . . e e 85
LI097-20a . . . . o o 86
LII0T-21 o e e e 87
LITI7-21a . . o 87
LUI27-21b oo e e e 87
LII37-22 o 87
LI1AT-23 o e 88
LIIST-25 o 90
LI16T-25a . . . o o e e 90
LIITT-25b . o 90
LII8T-25C . o o o e 90
LII9T-26 . . . 91
L1207-26a . . o o oo e e e e e e 91
LI217-26b . . . 91
LA227-27 oo e e 92
LA237-28 o o 92
LA247-28a . o o oo e e e e 93
LA257-29 o 93
L1268-0 . . e e e e 94
LA278-1 . o o 95
L1288-2 . e 96
1.1298-2a . . . . 96
L1308-3 . . e 97
LA318-3a . . o 97
11328-3b . . o e 98
LI338-4 . o 98
1A348-4a . . . . e 99
LI358-5 . o 99
11368-5a . . . . e 99
LA378-6 . . o 100
TA388-0a . . . o o e 100
L1308-7 . o 101
L1408-Ta . . . . e 101
LI418-8 . o o 102
11428-8a . . . . e 102
L1438-9 . o 103
L1448-10 . . o o e 104
LI458-11 . o o 104

L1468-12 . . o e 105




in vii
LI4T78-12a . . o o o e e 105
LI488-13 . . . 106
1.1498-13a . . . . o e 106
LISO8-13b . . . 106
LASI8-14 . o e 107
LIS28-14a . . . . o 107
1I538-14b . . e 107
LISA8-14C . . . 107
LAS58-15 . o e 108
LIS68-15a . . . . 108
LAST8-15b . o e 108
LISBB-16 . . o 109
LI598-16a . . . . o e e 109
LI60S-17 . . o 110
LIO18-18 . . e 111
LI628-18a . . . . o 111
11638-19 . . e 111
LI649-0 . . . o 112
LI659-1 . . e 112
LI669-2 . . o 113
LL1679-3 . o e e 114
LI689-4 . . o 114
1.1699-4a . . . . . e 114
LI709-4b . . o o 115
LATIO-5 0 o o e 115
LA729-5a . . o o o 116
LA739-6 . . o e 116
LIT749-6a . . . . . . o 116
LAT59-T © o o e 117
LIT69-8 . . o 117
LATT10-0 . . o o e 118
LAIT8I0-1 . . o 119
LAT910-2 . o o e 119
LIBOT0-3 . . 120
3 O 0 T 120
LAB2I0-4 . . e 121
T I 0 121
LIBAT10-4b . . . o 121

LABSI0-5 . o o o e 121




in viii
LABO10-5a . . . . o o e 122
LISTI0-5b . . . 122
LABBIO-6 . . . e e e 122
LI8IT0-8 . o o 124
L19010-10 .« o o e 125
LIOTI0-11 . o oo 126
119210-14 . o o o e 128
L19310-16 . . . 130
L19410-18 . o o o e 131
LI9510-18a . . . . o o 132
LI96T1-0 . . e e 132
LIOTILI-1 . o 133
L 134
LI99T1-3 L 135
1.20011-3a . . . e e e 135
L20111-4 . o o 135
L20211-5 . e 136
1.20311-5a . . . o o 137
L20411-6 . . o e e 137
L205T1-7 oo 138
1.20611-8 . . e e e 138
L20711-8a . . . . o 139
L.20811-9 . o o e 139
1.20011-9a . . . . o 140
L21011-10 . o o o e 140
L21TTI-T1 0 141
L212101-10a . o e e 141
L213T1-11b . o 142
L21411-13 L o e 143
L21512-0 . . 144
L21612-1 . . o e 145
L21T712-2 0o o e 145
L21812-3 L o o e 145
L21912-4 L 0 o 146
1.22012-5 . 0 o e 147
L22112-6 . o o o 148
1.22212-8 . o e e 149
1.22312-8a . . . . 149

1.22412-9 . L o e 150




in iX
1.22512-9a . . . oL e 150
1.22612-9b . . 150
L22713-0 . . 152
L.22813-1 . o o e 152
1.22913-2 . o o e 152
1.23013-2a . . . o 153
L23113-3 . 153
1.23213-3a . . e 154
1.23313-8 . e 157
L1.23414-0 . . . 203
L.23514-1 . o o e 203
1.23614-2 . o e 203
L23T714-3 L o 204
L23814-4 . . . 205
1.23914-5 . . o e 205
L1.24014-6 . . . . 206
L24114-T o o o 207
L24214-8 . . o 208
1.24314-8a . . . . o 208
1.24414-9 . o o 209
L24514-10 . . . 209
1.24614-10a . . . . . L L e 210
L24T14-11 . o 211
L24814-12 . o o o 211
L.24914-13 . . . 212
1.25014-14 e 213
L25114-14a . . . o o o 213
L25214-15 . . . 214
1.253a . o o e 214
L254b . o o 215
12550 . o o 216
L256d . . . o 218
L257€ o o o e 221
1288t 222
L259g . o 222
12601 . . . o o e 223




in 1/239
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In

1.1 main
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FOR FIREFLASH OTT

0 Welcome to FINAL WRITER
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PREPARING TO USE FINAL WRITER
Making Backup COpPi€s .. ev it ittt e eeeennnns 1-3
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Starting Final Writer ..........ciiiiiiii.. 1-5
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MENUS ottt ittt it ittt ittt ittt i ennnneeeeenns 1-6
Title Bar ittt ittt ettt et e 1-7
User button strip .....c.iiiiii it 1-7
Program command STriP e ev v intteeeeeeennnns 1-7a
SCrOLl BaArS vttt ittt ettt ettt 1-9
Window Gadget s ..ttt it ittt ennneeennn 1-10
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4 PAGE SETUP
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Page Si1ZE ittt it e e e et e 4-2
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"SECTION SETUP’ requester
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CREATING A NEW DOCUMENT
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DELETING TEXT

Deleting a character .......iiuiiiiiiinnnnnn 5-6
Deleting selected text ......cuiiiiinnnnnn 5-6a
Deleting a blank line ........cciiiiiiennnenn. 5-6b

SAVING A NEWLY CREATED DOCUMENT
Saving a newly created document ............. 5-7

CLOSING A DOCUMENT

Closing a document ...ttt iieneeneeennnns 5-T7a
TEXT CLIPS
Creating a text Clip «ovii i ii it iinnnnnn 5-8

6 REVISING A DOCUMENT

OPENING A DOCUMENT
Opening a doCcument ... iii ittt eeeeeeennnennn 6-2

MOVING THROUGH TEXT
Scrolling text ..ttt e e e e e 6-3
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REPLACING TEXT
Replacing text with new text ................ 6-5
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COPYING TEXT
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MOVING TEXT
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1.2 welcome

WELCOME TO FINAL WRITER

Congratulations! You have chosen an advanced and innovative word
processing system for the Amiga. Final Writer is designed for people who
want high quality personal and business documents. It combines word
processing and graphic handling features with a high quality, state of
the art printing technology.
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* * K Fig 0-1 * % K
BEFORE YOU GO FURTHER
Before you begin using Final Writer, please take a few moments to

* BACK UP THE FINAL WRITER DISKS. After you have backed up your disks,
store the originals in a safe place in case you need to revert to them
at a later time.

* FILL OUT AND MATIL THE ENCLOSED WARRANTY REGISTRATION CARD.
SoftWood provides technical support for Final Writer if your warranty
card is on file. Tear off vyour portion of the registration card and
keep it with your manual. Fill out the other portion of the card and
mail it to SoftWood. When you call for technical support, please have
your registration number in case you are asked for it.

Welcome to Final Writer Page 0-1
HOW TO USE THIS MANUAL

This manual is divided into a number of sections that follow this
introduction. These learning and reference chapters are:

* INSTALLING AND GETTING STARTED - Information necessary to begin
working with Final Writer is contained in this chapter. It includes
installation procedures, an overview of basic descriptions of Final
Writer's user interface.

* TUTORIAL - We have produced a set tutorial exercises designed to
familiarize you with using Final Writer as quickly as possible.
Included are exercises on creating , revising, and formatting a
document.

* SETTING PREFERENCES - This chapter describes Final Writer'‘s preference
settings which let you customize certain operations to suit your
personal needs.

* PAGE SETUP - Final Writer is very flexible in allowing you to define
page characteristics for your documents. This chapter discusses
setting up pages.

* CREATING AND SAVING A DOCUMENT - Follow these easy, step-by-step
instructions to create and save a document in Final Writer. Included
are editing functions that you are likely to use as you are actually
writing your document for the first time.

* REVISING A DOCUMENT - This chapter tells you what you need to know
about revising and editing a document.

* FORMATTING A DOCUMENT - This chapter provides an explanation of
various ways in which you can change the appearance or format of your
document. Included are documents, paragraph, and graphic settings;
fonts; rulers; and other important features.

* GRAPHICS AND TEXT BLOCKS - Instructions for working with graphics and
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text blocks are found in this chapter.

* MAKING A DOCUMENT PERFECT - This chapter contains instructions for
using Final Writer'‘s speller, thesaurus, and document statistic
features.

* SECTIONS - Contained in this chapter are guidelines for creating
sections such as Table of Contents and Index.

* PRINTING A DOCUMENT - Once you have created your document, refer to
these instructions for printing it.

* FORM LETTERS - Instructions for creating and saving merge data, create
a form letter, and merging data with a form letter.

Welcome to Final Writer Page 0-2

* AREXX SUPPORT - A description of Final Writer'‘'s ARexx commands.

* REFERENCE - A descriptive guide to Final Writer'‘s menus and commands,
including references to specific areas of the manual where additional
information can be found.

* APPENDICES - A list of cursor key functions; a description of keyboard
shortcuts; a complication of helpful hints to make the most of Final
Writer'‘s word processing abilities; and a glossary of words
processing, printing, typesetting, and computing terminology.

THANK YOU
SoftWood is committed to making excellent software for the Amiga. In
fact, Amiga is the only computer for which SoftWood publishes software.
We have done everything we can to ensure that Final Writer is an
enjoyable product in which you can have confidence.

If you should find anything about Final Writer that you believe needs

improvement, mail us your suggestion. We read each letter and continually

compile a list of changes requested by users of our programs.

Good luck with Final Writer, and thank you for purchasing it. We hope
you like Final Writer well enough to tell your friends about it.

Woody, Terry, Mary, Pat, and Jim

SoftWood, Inc.
1993
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1 INSTALLING AND GETTING STARTED

BEFORE YOU BEGIN
Things you should know .........ccoieieeennnns 1-2
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PREPARING TO USE FINAL WRITER
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Installing Final Writer ..........cciiiiie... 1-4
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I I 2 O 1-7
User button Strip .. eiii ittt ittt eennennn 1-7
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QUITTING FINAL WRITER
Quitting Final Writer ............c.ccciiinnnn. 1-10a

TECHNICAL SUPPORT

American English version .........c..ceeeene... 1-11

British English version ...........ciiiieean.. 1-11

Limits ON SUPPOTEL v vt ittt ittt i et eee e ennnnan 1-11
1.4 1-1

1 INSTALLING AND GETTING STARTED

This chapter is designed to get you started using Final Writer. It
guides you through installing Final Writer on an Amiga with a hard drive.
it explains the basics of operating Final Writer and describes its user
interface. The goal of this chapter is to get you acquainted with Final
Writer so you may begin using it right away.

Installing and getting started 1-1

1.5 1-2

BEFORE YOU BEGIN

Before you begin using Final Writer you should know a few basic concepts
and verify that your computer and system software are compatible with
Final Writer.

THINGS YOU SHOULD KNOW
To use Final Writer effectively, you need to understand a few basic
concepts. Before you begin, you should know how to:

* Start your Amiga.
* Use the mouse to point, click, double-click, and drag.
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Start a program from the Workbench.
Initialize and duplicate disks.

Use menus to choose commands.
Scroll, move, and resize windows.
Use a requester.

P S R

Some of these concepts are discussed in this chapter, others are found
in the manuals that came with your Amiga.

REQUIRED HARDWARE AND SOFTWARE

Before installing or using Final Writer, make sure your computer and
system software are compatible with Final Writer.

HARDWARE REQUIRED

Final Writer has a thesaurus database, spelling dictionary, hyphenation
database, and many outline fonts. In addition, the program size is over
500k. Because of this you will need a hard disk to use Final Writer. If
the system software is correct (see below), Final Writer will work on any
Amiga with at least 1.5 megabyte of available internal memory. If your
computer has less than 1.5 megabytes of memory available after Workbench
is loaded, you will not be able to run Final Writer.

SYSTEM SOFTWARE REQUIRED
Final Writer requires version 2.0 or higher of the Amiga
Workbench. If you have any Workbench before 2.0, Final Writer will not

work properly and perhaps not at all.
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1.6 1-3

FINAL WRITER CONCEPTS

The following are some basic terms used throughout this manual.
Experienced Amiga users may wish to skip over this section.

POINT To move the mouse so that the mouse pointer is either
pointing at or pointing on top of some object.

PRESS To hold the left mouse button down.

CLICK To press and quickly release either the left or right
mouse button.

NOTE. In this manual ’'Click the mouse’ will mean to click
the left mouse button. The right mouse button is only
used for accessing menus.

DOUBLE-CLICK To quickly click the left mouse button twice. Depending
on what you are doing, double-clicks are used to open
documents, access drawers, or select words. A double-
click is always performed using the left mouse button.
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SELECT To specify something (e.g. to select lines of text or to
select a document to be opened).
DRAG To press the left mouse button and move it in some
direction while still holding the mouse button down.
Dragging is used to select areas of text. Dragging with
the right mouse button down is used to choose a menu
command.
HIGHLIGHT Text that has been selected appears to be highlighted on

the screen. <THIS IS HIGHLIGHTED TEXT.>
PREPARING TO USE FINAL WRITER
Now that you are sure your computer and system software are compatible
with Final Writer, make backup copies of the Final Writer master disks.
Afterwards, follow the steps in 'Installing FINAL WRITER’ to prepare your
computer for using Final Writer.

MAKING BACKUP COPIES

Use the Workbench commands to copy all Final Writer disks. If you are
unsure how to do this, refer to your Amiga manual.

Installing and getting started 1-3
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INSTALLING FINAL WRITER
Final Writer is not copy protected and can be installed on a hard disk.
The "HD_Install’ program located on the disk named "Disk 1" must ALWAYS

be used to install Final Writer. You need at least 3 megabytes of space
on your hard drive to install Final Writer.

TO INSTALL FINAL WRITER ON A HARD DISK:

1. Start your Amiga, 1if it is not already running.

2. After the computer completes its startup, eject any disk in your
internal floppy disk drive, and insert the disk named "Disk 1".

3. Double-click the mouse on the Disk 1 disk icon.
This will open the main window for the "Disk 1" disk.

4. Double-click the mouse on the ’"HD_Install’ program icon.
This will start the installer program.

5. Click the mouse on the "Proceed with Install" button.

The installer will display a screen with some additional options.
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6. Click the mouse on the "Proceed with Install" button.

The installer program will display a screen that lets you specify
where Final Writer is to be installed. On this screen, beneath the
title "Selected Drawer", will be a destination the installer program
has chosen for the installation. You can modify this destination if
you choose to.

7. If you want to change the "Selected Drawer" location, do so now.

NOTE. Do not specify "Final Writer" as part of the "Selected Drawer".

The installer program automatically creates a drawer named
"FinalWriter" within the "Selected Drawer" location.

8. Click the mouse on the "Proceed" button.

9. When the program asks you to insert a disk, remove the disk that is
currently in the drive, and insert the one that is requested.

10. The "HD_Install" program will notify you when the installation is

complete. When this occurs, click the mouse on the "Proceed" button.

11. Close the "Disk 1" window.
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STARTING FINAL WRITER

Final Writer requires that you have a hard drive in your computer. It
does not come with a system disk an relies upon the system that is
installed on your hard drive. If you do not have a hard drive, you will
not be able to use Final Writer.

To start Final Writer:

1. Turn on your Amiga and follow the normal startup procedures you go
through to get your computer running.

2. Once you are running on your hard drive, locate the "Final Writer"

drawer that was created during the Final Writer installation process.

3. Double-click the mouse on the "FinalWriter" drawer.

Shortly, you will see several icons, including the Final Writer
program icon.

4. Double-click on the "Final Writer" program icon.
In a few seconds, Final Writer will be running, and you will see

the"Startup Screen". This screen gives you the opportunity to choose
the type of screen Final Writer will use.
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* kK See Fig 1-1 %%
5. Click the mouse on the "OK" button.
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1.9 1-6

WORKING IN FINAL WRITER

Once you have started Final Writer, you will see an untitled Final
Writer document window. The following are descriptions of the various
elements of a Final Writer document window.

MENUS
Most of Final Writer’s features are accessed by choosing a menu item. As
you know, on the Amiga you can access the menus by moving the mouse along
the top of the screen while pressing the right mouse button. Below are
brief descriptions of Final Writer’s menus.

"PROJECT" MENU

This menu includes commands to create, open, save, print, and delete a
document. It also contains commands that let you specify page setup
parameters, set preferences, and quit Final Writer.

"EDIT" MENU

Commands in this menu will allow you to cut, copy, paste, clear, and
select text. Also included are commands to insert and update date and
time, and to copy and paste the ruler.

"VIEW" MENU
The View Menu is used to choose a page view, and show or hide various
screen display elements.

"LAYOUT" MENU

This menu enables you to define page, section, and paragraph
characteristics. It also is used to define and apply paragraph styles,
insert and remove page breaks, insert and remove sections.

"TEXT" MENU

Contained in this menu are commands to set the characteristics of the
text contained in your document, including the font size, leading, style,
position, width and case of text. You may also use this menu to select a
colour for your text, and specify the oblique percentage (or degree of
slant) for italic text. The Type Specs features enable you to define
specifications for any amount of selected text in your document or for
text which has yet to be entered.

Installing and getting started 1-6

"GRAPHICS" MENU

This menu includes commands to insert IFF graphics; select settings for
these graphics; specify settings for lines, boxes and ovals drawn with
Final Writer’s tool icons; and to determine if graphics are to appear in
front of or behind other elements on you page.
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"TOOLS" MENU

Included in this menu are commands to find or replace text, as well as
commands to initiate a spell check, consult the thesaurus, or obtain
document statistics. This menu also contains commands used to create
special sections such as table of contents and index.

"USER" MENU
This menu is available for you to add your own items to.

1.10 1-7

TITLE BAR

A window’s title bar will show the name of the document in the window.
If the document has not been saved, the name will be "Untitled".

USER BUTTON STRIP

Final Writer’s user button strip is the area at the top of a document
window that contains one or more buttons you set up for accessing often
used operation.

1.11 1-7a

PROGRAM COMMAND STRIP

Final Writer’s program command strip is the area just above a document’s
ruler which contains button-activated commands you can use to control
various aspects of the program’s operation.

JUSTIFICATION SELECTORS

Final Writer allows you to justify your paragraphs in four different
ways —— left, right, centred, or full -- using the justification
selectors. Each paragraph may be justified independently.

SPACING SELECTORS

The spacing selectors enable you to space your paragraphs a single. 1
1/2, double, or variable spaced. Each paragraph may be space
independently using these selectors.

Installing and getting started 1-7

TAB STOP SELECTORS

Final Writer’s tab stop selectors allow you to mark tab stops on the
ruler. Four different tab alignments --left,right, centre, and decimal --
may be specified using the tab stop selectors. Each paragraph in your
document may have its own unique tab configuration.

HYPHENATION "ON/OFE"
The hyphenation selectors allow you to turn Final Writer’s automatic
hyphenation feature off and on as you wish.




in 18 /239

TOOL BOX

By selecting the appropriate tool, you may enter text; select graphics;
draw horizontal, vertical or 45 degree diagonal lines; draw lines in any
direction; draw a rectangle/square; draw an oval/circle; and crop
graphics.

MASTER/BODY PAGE SELECTORS

The master pages selectors enable you to designate a page as a master
guide for your entire document. Any text or graphics entered on a master
page will appear on every page of the document. You may select left
and/or right master pages.

RULER MODE
These selectors enable you to determine whether your document displays
no rulers, the top ruler only, or both side and top rulers.

USER COMMAND STRIP SELECTORS
These buttons let you hide or show the user command strip.

LEFT AND RIGHT MARGINS
Left and right margins may be marked on the ruler using the margin
selectors. Each paragraph may have its own margins.

FIRST LINE INDENT
The first line indent margin allows you to specify the indentation
distance for the first line in a paragraph.

HYPHEN "HOT ZONE"
This margin allows you to specify the point in a line of text where a
word becomes eligible for hyphenation.

Installing and getting started 1-8

PAGE NUMBER

This tells you which page of your document is currently in the window,
and can be used to go to a previous, next, first, or last page of the
document.

*xx See Fig 1-2 #x*x

1.12 1-9

SCROLL BARS

Scroll bars are used to adjust the viewing area of a window. Dragging
the scroll bar allows you to move to a desired position within the
document. Clicking in the scroll box moves the text either horizontally
or vertically in large increments within the document window. Clicking on
the scroll arrows results in a small movement either horizontally or
vertically with in the document window.

Installing and getting started 1-9
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1.13 1-10

WINDOW GADGETS

In addition to the above Final Writer gadgets, there are several Amiga
gadgets also on the window.

CLOSE BOX
When the mouse is clicked on the Close box, the Final Writer window will
be closed.

FRONT TO BACK GADGET
This gadget places the current window behind other windows that might be
simultaneously open.

SIZE GADGET
You may alter the size of the document window by dragging the mouse
while clicking on the size gadget.

1.14 1-10a

QUITTING FINAL WRITER

TO QUIT FINAL WRITER:

1. CHOOSE "QUIT" FROM THE "PROJECT" MENU

If you only have one window open, that window will be closed and you
will return to the Workbench screen. If other Final Writer windows are
open, only the current window will be closed. Before closing a window,
the program looks to see if you have made any changes to the document
since the document was last saved. If there are unsaved changes, Final
Writer will ask you to inset the Workbench disk.

* %% See Fig 1-3 **x*
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TECHNICAL SUPPORT

We have tried our best to explain Final Writer in this manual. If you
have problems that you can’t solve by using this manual, you can call
SoftWood’s technical support. The phone number you should call, and the
hours you can call are listed below.

AMERICAN ENGLISH VERSION
Technical support for the American English version of Final Writer is

available from SoftWood, Inc, in Arizona by calling (602) 431-9151. The
hours you may call for technical support are from 10:00 Am to 12:00 PM
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MST and 2:00 PM to 4:00 PM MST Monday through Friday. MST is Mountain
Standard Time. Arizona’s never changes during the year. During winter
10:00 AM in Arizona is the same as 12:00 AM EST. In the summer months
10:00 AM MST is the same as 1:00 PM EST. Technical support is not
available on Saturdays, Sundays, and holidays.

BRITISH ENGLISH VERSION
Technical support for the British English version of Final Writer is
available from Gordon Harwood Computers in Derbyshire, England by calling
0773-520252. The hours you may call for technical support are 10:00 AM to
12:00 PM, Monday through Friday.

LIMITS ON SUPPORT

In order to receive technical support your registration card must be
sent in. In order to serve legitimate owners of Final Writer, we will not
give support to anyone who is not a registered user. Every time we take a
call from someone who has an illegal copy of our program, it keeps us
from taking a call from a registered owner. It only takes a few moments
of your time to complete and send in your registration card.
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2 TUTORIAL

CREATING A DOCUMENT
Creating a document .........c.ciiiiiieeennnnn. 2-2
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Deleting text ...ttt ittt 2-5
Moving texXt .ottt e e e e e e e e 2-6
Saving and closing a document ............... 2=17
Opening a document . ...ttt eneeeeennnnns 2-8

FORMATTING A DOCUMENT

Aligning texXt .ttt ittt e e e e 2—-8a
Setting margins .. ...ttt ittt e e 2-10
Changing font size ...ttt eennnnnn 2-11

WORKING WITH MASTER PAGES

HEADERS AND FOOTERS ... ittt ittt it iitenenn 2-12
Specifying the height of header
headers and footer area ................ 2-12a
Accessing the master page .......ccciiiiieen.. 2-13
Entering header text ........ ... 2-14
Entering footer graphics ......... i 2-15
Returning to the body page .................. 2-15a

QUITTING AND SAVING CHANGES
Quitting and saving changes ................. 2-16
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1.17 2-1

TUTORIAL

This chapter contains a set os exercises designed to introduce you to
some of Final Writer’s important basic features. When you finish this
section, you will know how to:

Create a document
Enter text

Insert text

Move text

Delete text

Save a document
Close a document
Open a document
Align text

Set a margin
Change font size
Create a header
Save a changed document

L S S S T e

Keep in mind that the purpose of this section is to lead you through a
set of simple tasks using some of Final Writer’s features. Step by step
instructions for other Final Writer commands may be found in other
chapters of this manual.

Tutorial Page 2-1

1.18 2-2

CREATING A DOCUMENT

The following exercise will show you how to create a new document. In
this practice session, you will type a letter. As you do so, you will not
need to hit the RETURN key when you get to the end of the line. Final
Writer will automatically take you to the next line when a word will not
fit on the line you are typing. To end a paragraph or insert a blank
line, you will need to press the RETURN key.

In the letter that you will be typing on the following page, the =
symbol shows you where to press the RETURN key.

If you make a mistake while typing, use the BACKSPACE key to erase the
characters.

TO CREATE THE TUTORIAL DOCUMENT:

1. START FINAL WRITER IF IT IS NOT ALREADY STARTED.

An untitled document will appear on your screen. Notice that the text
tool icon on the horizontal ruler has been selected and that the
insertion point is located in the upper left corner of the window.
When you begin typing, text will be inserted at the insertion point.
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* Kk See Fig 2-1 * Kk
Tutorial Page 2-2
2. TYPE THE FOLLOWING LETTER:

NOTE. Remember the x in the letter below indicates where you should
press the RETURN key.

Professor Sean O’Boylex

Department of Irish Studiesx

*

Mary Williamsx

222 S. Main Streetx

Hometown, Arizona 85007«

U.S.A.x

*

*

Dear Mrs. Williamsx

*

I received your letter asking for information on Irish literature.
You are absolutely correct that reading a nation’s literature is
the best way to prepare for travels there. Listed below are
selected works by some of Ireland’s greatest authors. Happy
Reading!x

*

The Playboy of the Western World, by J.M. Syngex

*

The Collected Works of Yeatsx

*

A Guide to Dublin Pubs, by Eamon O’Farrallx

*

Ulysses, by James Joycex

*

*

Sincerely,

*

Prof. Sean O’'Boylex

Tutorial Page 2-2

1.19 24

REVISING A DOCUMENT

Now that you have created your tutorial document, you can proceed with
several exercises.

INSERTING TEXT
You will often wish to add characters to existing text in a document.

With Final Writer, this process is quick and easy. Characters are always
inserted at the insertion point.
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TO INSERT TEXT INTO THE TUTORIAL DOCUMENT:

1. Move the mouse so that the text toll is positioned just before the
word "Happy" in the main paragraph.

2. Click the left mouse button.

You have just set the insertion point, and any characters that you
type will be inserted before the word "Happy".

* kK See fig 2-2 * kK

3. Type the words "You may find these books at your local library."
followed by two spaces.

Notice that the text ruler. automatically readjusts itself within the
margins of your document. The two spaces were entered to separate

your new sentence from the one following it.

Tutorial Page 2-4
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DELETING TEXT

If you create a document and decide at a later time that the text needs
to be removed, you may do so easily by using Final Writer’s "Edit" menu.

TO DELETE A BLOCK OF TEXT IN THE TUTORIAL DOCUMENT:

1. Position the mouse at the first of the blank line that appears above
the line reading "A Guide to Dublin Pubs, by Eamon O’Ferrall".

2. Press the left mouse button and continue to hold it down.

3. While holding the mouse button down, drag the mouse down and to the
right until the blank line and entire line of text are highlighted.

4. Release the mouse button.

This process of dragging the mouse over text is known as "selecting".
Selected text always appears highlighted on your screen.

5. Choose "CUT" FROM THE "EDIT" MENU.
* ok See Fig 2-3 * k%

The selected text will be removed, and Final Writer will
automatically reformatted the document.

Tutorial Page 2-5
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1.21 2-6

MOVING TEXT

You may move text within a document using Final Writer’s "Cut" and
"Paste" commands.

TO MOVE TEXT IN THE TUTORIAL DOCUMENT:

1. Drag the mouse over the words "Happy Reading!"
Dragging involves pressing the left mouse button, then moving the
mouse while continuing to hold the mouse button down. When
finished dragging, release the mouse button, and the select text will
appear highlighted on your screen.

* % K See Fig 2-4 * % K

3. Choose "Cut" from the "Edit" menu.

* Kk See Fig 2-4 * Kk

The highlighted text is removed from your document and stored in a
special place called the "clipboard".

4. Position the mouse pointer after the last character of the line
reading "Ulysses, by James Joyce", and click the left mouse button to
set the insertion point.

5. Press the RETURN key twice.

6. Choose "Paste" from the "Edit" menu.

* %% See Fig 2-5 *xx

Final Writer will insert the sentence at the insertion point.
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SAVING AND CLOSING A DOCUMENT

Now that you have practised some of Final Writer’s basic editing
techniques, it is time to learn to save and close your document. While
you were creating and revising the tutorial document, you may have
noticed that the name "Untitled" appeared in the title bar of your
window. This is the name that Final Writer assigns to a new document
until it is named and saved.

TO SAVE THE TUTORIAL DOCUMENT FOR THE FIRST TIME:

1. Choose "Save..." from the "project" menu.
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* kK See Fig 2-6 * kK

A file requester will appear so that you can give your documents a
name and choose where you wish to save it.

2. Click in the data entry area following the word "Untitled", backspace

over "Untitled", then type in Lesson 1.
* %% See Fig 2-6 * K x
3. Click on "Save".

Your tutorial document has now been saved for the first time. Notice
that the document remains on the screen.

TO CLOSE THE DOCUMENT:

1. Click the mouse in the windows’s Close Box located in the upper left
corner of the document window.

x %% See Fig 2-6 *xx

The program will remove the document from the window and ask if it is

OK to gquit the program.
2. Click the mouse on the "No" button.

If you had chosen "Yes", the program would have ended and returned
you to the Workbench window.

Tutorial Page 2-7
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OPENING A DOCUMENT

In the previous exercise you closed the document you had created.
Normally, if you were going to make additional changes to the document,
you would not have closed it. But since this is a tutorial, you need to
know about closing a document. Now you will make changes to your
document. Before you can do this it is necessary to "Open" the document.

TO OPEN THE TUTORIAL DOCUMENT:

1. Choose "Open" from the "Project" menu.

* %% See Fig 2-7 * K x
A file requester will appear on your screen.

2. Locate the document you just saved and double-click the left mouse
button on its name.

Final Writer will load the document from the disk and display it in
the window.
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FORMATTING A DOCUMENT

The following set of exercises shows you how to perform some of Final
Writer’s many exciting formatting commands.

ALIGNING TEXT
Using Final Writer you can align your text in several ways:

Left Justified Left justified text is displayed so the each line
starts at the same position on the line

Right Justified Right Jjustified text is displayed so that each line
ends at the same position on the line.

Centred Centred text is displayed so that each line is centred
between its margins.

Full Justified Full Jjustified text is displayed so that each line
starts and ends at the same position on a line.

You can change the justification of one or more paragraphs using either
the ruler or requester. Next you will learn to change the justification
of two paragraphs using the "Justification Selector" on the ruler.

Tutorial Page 2-8

TO CENTRE TEXT USING THE RULER:

1. Position the mouse before the very first word in the document,
"Professor".

2. Drag the mouse down and to the right until the first two lines of the
document are highlighted and release the mouse button.

Two lines are now selected.

* %% See Fig 2-8 * K x

5. Click on the "Centre justification" icon in the ruler.
The two selected lines will be centred on the page. Notice the lines
are still selected. If you were going to make other changes to these
lines, you could do so without reselecting them. Since you will be
doing something else now, you will want to deselect the lines.

6. Click the mouse somewhere else on the document.

The lines will be deselected.

To change Jjustification of two or more paragraphs at the some time, it




27 /239

is necessary to drag the mouse through text contained in the paragraphs.
If you only want to change justification of one paragraph, you simply
click the mouse in the paragraph to be changed.
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1.25 2-10

SETTING MARGINS

The Final Writer ruler may be used for many different purposes related
to the appearance of your document on the page. Margins may be easily set
or changed by moving the left margin, right margin, and the first line
indent horizontally along the ruler. For any paragraph (text ended by a
return), the first line indent sets the left position of the first line
of a paragraph; the left margin set the left position of the remaining
lines in the paragraph; and right margin sets the right position of all
lines in the paragraph.

TO CHANGE THE LEFT MARGIN USING THE RULER:

1. Click the mouse anywhere in the document’s main paragraph.
The main paragraph is the one that starts "I received...".

2. Position the mouse on the left margin marker.

* ko See Fig 2-9 * kK

On your document window the left margin and first line indent are set
a 1 inch. Since they are set at the same value, their markers are
drawn at the same location. The markers are distinguished in that the
first line indent marker is drawn above the left margin marker.

3. Press and hold the left mouse button and drag the left margin marker
horizontally to the right until it is directly over the "2" on the
ruler.

Final Writer will automatically reformatted the left margin of all
lines of the paragraph except the first line. As explained above, the
starting position of the first line in a paragraph is determined by
the first line indent marker. In order to set the left margin of the
first line, you must use the first line indent. Experiment by moving
the first line indent marker to some other position to the right of
where it is now.
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1.26 2-11
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CHANGING FONT SIZE

Final Writer contains a number of special features that allow you to
change the appearance of text in your document. You may change the
typeface, alter the spacing, and use a number of special effects to give
your type just the right appearance. In this exercise, you will alter the
appearance of the text in the body of your document by changing the font
size.

TO CHANGE FONT SIZE:

1. Drag the mouse over the line "Professor Sean O’Boyle".
The text is now selected and ready to have its size changed.
2. Choose "24" from the "Size" sub-menu of the "Text" menu.
* kK See Fig 2-10 * kK
The text will now appear in 24 point size.
* kK See Fig 2-10 * %k
3. Click the mouse anywhere in the document to deselect the text.
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1.27 2-12

WORKING WITH MASTER PAGES

A master page 1s a place in a Final Writer document where you define
text and graphics that are to appear on each of your document’s body
pages. There are many uses for master pages, including document titles,
chapter names, special graphics, dates, page backgrounds, and page
borders. Any text or graphics placed on a master page appear
automatically on each of the document’s body pages (excluding optional
title page). It is entirely up to you whether you enter anything on a
document’s master page.

The information on master pages that follows in this tutorial
illustrates one specific master page application —-- how to set up a
typical document header and footer.

USING MASTER PAGES FOR HEADERS AND FOOTERS

"Header" is a term used to identify text and graphics that appear at the
top of a document’s pages. "Footer" is a term used to identify text and
graphics that appear at the bottom of a document’s pages. In Final Writer
you create these special areas using the master pages feature.

Text and graphics that you would normally place in a header are placed
at the top of a master page. Text and graphics that you would normally
place in a footer are placed at the bottom of a master page. If you are
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going to use master page for headers and/or footers, you should first
specify the height of the area on a master page that will be used for
header and footer information. If you do this, Final Writer will not
allow you to enter text on a body page in the areas where header or
footer information appears.

1.28 2-12a

TO SPECIFY THE HEIGHT OF HEADER AND FOOTER AREAS:

1. Choose "Section Setup" from the "Layout" menu.
* Kk See Fig 2-11 * Kk
The "Section Setup" requester will appear on your screen.

2. Locate the section of the requester entitled "Master Page" then click
in the data entry area beneath the word "Header".

3. Replace the contents with the value "1".
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This instructs Final Writer to offset the top of the body of your
document pages by 1 inch from the top.

4. Now click in the data entry area beneath the word "Footer".
5. Replace the contents with the value "1".

This instructs Final Writer to offset the bottom of the body of your
document pages 1 inch from the bottom.

* kK See Fig 2-12 * kK

6. Click on the "Use" button at the bottom of the requester.
This instructs Final Writer to use your header and footer setup for
the current document only. Had you wished to save your setup as a

default to be applied to all future documents, you would have clicked
on "Save".

1.29 2-13

TO ACCESS THE MASTER PAGE:

1. Click the mouse on the right master page icon in the horizontal ruler
at the top of your window.

* kK See Fig 2-13 * kK
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The blank master page will appear. The page does not show the text
you have already entered during this tutorial, because the text was
entered on the body page.

Notice that the insertion point appears automatically in the top left
corner of the master.

1.30 2-14

TO ENTER HEADER TEXT ON THE MASTER PAGE:

* kK

Type the following text:

Trinity Collagex
Dublin, Ireland

(Remember the x symbol means press the RETURN key).

See Fig 2-13 * kK
When you eventually return to the body pages of your document, the
header text will appear Jjust as you have entered it on the master

page. If your document contained more than one page, the header text
would appear on all pages in the document.
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1.31

2-15

TO ENTER A LINE GRAPHIC IN THE FOOTER ON THE MASTER PAGE:

* kK

Click on the "New Line" tool.

Scroll the document to the end of the page, and position the mouse
pointer approximately 1 inch from the bottom of the page.

Drag the mouse horizontally across the page.
As you drag the mouse, a line is drawn.
See Fig 2-13 * kK

When you reach the far right of you footer, stop dragging the mouse
and release the mouse button.

The line is now inserted in the footer of the master page and will
appear identically on ever page of your document.
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1.32 2-15a

TO RETURN TO THE BODY PAGE:

1. Click on the body page icon at the top of your window.
The master page will disappear, and the body page of your document
will appear on your screen. Notice that the header text and footer
graphic appear appear on the body page just as you entered them on
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the master page. While in the body page(s) of your document, any text

or graphics entered on a master page may not be edited. You must
return to the master page to do so.

1.33 2-16

QUITTING AND SAVING CHANGES

You have almost reached the end of the tutorial. By now you should have
a good idea of how to create a document in Final Writer. Of course there
is much more to Final Writer than the features covered in the tutorial.
Refer to the remaining chapters for instructions on operations such as
type, styling, spelling, using the thesaurus, printing, and working with
graphics.

The last exercise in the tutorial is about quitting the program. If you
have followed the steps in the tutorial, you should have a document with
changes that have not been saved.

TO QUIT THE PROGRAM AND SAVE CHANGES AT THE SAME TIME:

1. Choose "Quit" from the "Project" menu.

* ko See Fig 2-14 * kK

The program will ask if you want to save changes to your document.

* Kk See Fig 2-14 * kK

2. Click the mouse on the "Yes" button.

The program will save your document to disk, and then return you to
the Workbench screen.

1.34 3-0
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SETTING PREFERENCES

Final Writer’s preferences settings let you inform the program of your
preferred way of doing certain operations. Final Writer comes to you with
these preferences set to SoftWood’s default values. You can modify any of
these settings as you see fit. This chapter describes the preference
settings so you can modify them to suit your needs. Preferences described
in this chapter are:

User Menu preferences

User Button Strip preferences
Display preferences

ASCII Input/Output preferences
Startup preferences
Speller/hyphenation preferences
Documentation item preferences
Document colours preferences
Document save preferences
Screen colour preferences

b T R S S S S
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1.36 3-2

"USER" MENU PREFERENCES

You can specify menu items of your choice in Final Writer’s "User" menu.
Menu items specified in this menu may be assigned one of the Amiga
function keys seen at the top of your keyboard. Each menu item can be
assigned to:

Run an ARexx script

Open a text clip

Activate a Final Writer menu command
Execute a string command

X X %

The "User Menu Preferences" requester is where you specify menu items
for the User menu.

TO ACCESS THE "USER MENU PREFERENCES" REQUESTER:
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1. Choose "User Menu from the "Preferences" sub-menu found in the
"Project" menu

* %% See Fig 3-1 K%
Final Writer will open the "User Menu Preferences" requester.
* %% See Fig 3-2 * K x

TO ADD A NEW ITEM TO THE "USER" MENU:

1. Click the mouse on the "new" button.
2. Enter a name for the menu item and press RETURN.

3. Indicate the type of command that is to be assigned to the menu item
you are creating by selecting from the "Type" popup menu

* %% See Fig 3-2 *xx
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4. Specify the source of the command by clicking on the "Select" button
and choosing an item from the list that appears.

NOTE. If you are assigning a menu command, a list of Final Writer
menu
commands will be displayed for you to select from. If you are
assigning an ARexx script, a file selector is displayed in which you
can locate and specify an ARexx script to be assigned to the menu
item. If you are assigning a text clip, a file selector is displayed
in which you can locate and specify a text clip to be assigned. If
you are assigning a string command, a list of Final Writer string
commands will be displayed for you to select from.

5. Indicate the menu position the new item is to appear in.

6. If you want a function key assigned to the menu item, choose one from

the list Fkeys. If you do not want a function key assigned, choose
"None" from the list of FKeys (First item in the list).

7. Click the mouse on the "Accept" button to add the new menu item
definition to the "User" menu.

TO REMOVE AN UNWANTED ITEM FROM THE "USER" MENU:

1. In the "Menu Items" list click the mouse on the name of the item to
be removed.

2. Click the mouse on the "Remove" button.

TO MODIFY AN EXISTING ITEM IN THE "USER" MENU:

1. In the "Menu Items" list click the mouse on the name of the item you
want to modify.
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2. Make whatever changes you want to make.

3. Click the mouse on the "Accept" button.

When you are finished making settings you can save them just for the
current document by pressing "Use", or save them for the current document

and as default values for new documents by pressing "Save".
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1.37 34

USER BUTTON STRIP

Final Writer’s button strip contain buttons that you click on to
activate commonly used program operations. Each button can be designated
to activate one of the following type of operation:

Run an ARexx script

Open a text clip

Activate a Final Writer menu command
Execute a string command

* ok ok *

You specify which buttons and commands are to appear in Final Writer’s
button strips in the "User Button Strip" preferences requester.

TO ACCESS THE "USER BUTTON STRIP" PREFERENCES REQUESTER:

1. Choose "User Button Strip" from the "Preferences" sub-menu within the
"Project" menu.

* %% See Fig 3-3 * K x
Final Writer will display the requester.
* Kk See Fig 3-4 * K %

Final Writer gives you 8 button strips in which to place buttons. When
the requester is displayed, Button Strip 1 are displayed.

TO ACCESS A DIFFERENT BUTTON STRIP:

1. Choose the desired button strip from the popup menu located just
above the list titled "Commands".

* % * See Fig 3-4 * Kk
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TO ADD A NEW BUTTON TO A COMMAND STRIP:

1. Locate the button to be added in the list titled "Buttons".

2. Press the mouse on the button and while holding it down, drag the
button from the "Buttons" list into the "Commands" list.
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3. Indicates the type of command to be assigned to the button by
choosing an option from the "Type" popup menu.

* %% See Fig 3-4 K%

4. Specify the source of the command by clicking on the "Select" button
and choosing an item from the list or file selector that appears.
NOTE. If you are assigning a menu command, a list of Final Writer
menu commands will be displayed for you to select from. If you are
assigning an ARexx script, a file selector is displayed in which you
can locate and specify an ARexx script to be assigned to the button.
If you are assigning a text clip, a file selector is displayed in
which you can locate and specify a text clip to be assigned. If you
are assigning a string command, a list of Final Writer string
commands will be displayed for you to select from.

5. If you want extra space to appear after the button when it is shown
in the button strip, click the mouse on "Add Extra Space" so a check
mark appears.

* Kk See Fig 3-4 * Kk

TO REMOVE A BUTTON FROM A BUTTON STRIP:

1. In the "Commands" list, press the mouse on the line that contains the
button definition to be removed and drag the button outside of the
"Commands" list.

TO MODIFY AN EXISTING BUTTON IN A BUTTON STRIP:

1. In the "Commands" list, click the mouse on the line that contains the
button definition to be modified.

2. Make any desired changes.

When you are finished defining button strips you can save them for the
document by pressing "Use", or save them for the document as a default

valu

Set

es for new documents by pressing "Save".
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Fin
that

TO

DISPLAY PREFERENCES

al Writer’s "Display" preferences let you define various elements
effect the way a document is displayed on your computer.

SET THE DISPLAY PREFERENCES:

Select "Display" from the "Preferences" sub-menus in the "Project"
menu.
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* kK See Fig 3-5 * kK
The "Display Preferences" requester will appear.

* %k See Fig 3-6 * %k

2. Set the preference values according to you needs.
NOTE. Descriptions of the settings are given below.

3. Click on "Use" to save the settings for just the current document.
Click on "Save" to also save the settings so they will be used for
new documents.

Descriptions of the display preference settings are as follows:

SCREEN DPI

The screen dpi setting is used to specify the horizontal and vertical
resolution for your screen display. Resolution is measured in dots per
inch (DPI). The default values are 80 for horizontal and 72 for vertical.
The larger the number used, the more screen area will be required to show
and inch of document information.

Setting the screen DPI will have no effect on printouts. Regardless of
the screen’s resolution, printing will always be performed at the
printer’s resolution. The purpose of the screen DPI preference is to
allow you to match your display to your computer monitor and its
settings. If the screen DPI default settings seem inadequate for your
monitor, you may wish to experiment with different settings.
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PAGE GUIDES

The PAGE GUIDES preferences are used to turn on or off grey lines that
appear as guides in a Final Writer document. These lines provide a
visually representation of your print area, edit area, header/footer
areas, and columns.

RULERS

The RULER setting is used to define which screen rulers, if any, will be
displayed. The "Top Only" option will display only the horizontal ruler
at the top of your window. The "Left and Top" option will display both
the horizontal top ruler and the vertical ruler at the left of the
window. "No Rulers" will produce a window in which neither the horizontal
nor vertical ruler are shown.

MEASURE IN

The MEASURE IN setting is used to specify the measurement system for the
document.

IFF 'ON SCREEN’ COLOURS
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The IFF ’'ON SCREEN’ COLOURS preferences specify the ways a graphic’s
original colours are converted to screen colours for display on your
screen. This setting has nothing to do with the printed output.

WB DOCUMENT COLOUR
The WB DOCUMENT COLOUR preference item lets you set the document’s
background (paper) colour when using a Workbench screen. The screen shots
on the back of the Final WRITER box were taken with Final WRITER running
on a 16 colour Workbench screen with the "WB Document Colour" option set
to "Use Highlight Pen".
WINDOW SIZE

The WINDOW SIZE preferences lets you save your current document window
size as a default setting. All subsequent document windows will
automatically open to this size.

NOTE. If you check the "Window Size" preference, the settings will
affect all subsequent new document windows regardless of whether you

click on "Save" or "Use".
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1.39 3-8

ASCII FILE INPUT/OUTPUT PREFERENCES

Final Writer preferences determine how an ASCII file is read and/or
written.

ASCII Input preferences are used for:

* Opening and reading ASCII file.

* Pasting data from the clipboard created in another program.

* Accepting data through ARexx.

ASCII Output preferences are used for:

* Writing an ASCII data file.

* Copying data to a clipboard that will be used in another program.
* Sending data to ARexx.

TO CHANGE ASCII I/O SETTINGS:

1. Select "ASCII I/O" from the "Preferences" sub-menu in the "project"

* Kk See Fig 3-7 * K x
The "ASCII File Input/Output Preferences" requester will appear.

* %% See Fig 3-8 * K%
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2. Click on the button preceding the ASCII input and output preferences
you wish to implement.

3. Click on the "Save" button to indicate that you have changed the
default settings, or on "Use" to change the settings for the current

document only.
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1.40 3-9

STARTUP PREFERENCES

The "Startup" preferences are used by Final Writer when it starts up to
determine what kind of screen to use. If you have not saved any startup
preferences. Final Writer will display the Startup Screen requester each
time you start the program.

You will probably find it convenient to specify the screen type you
prefer in the "Startup" preferences so that each time you start Final
Writer the program will automatically open on that type of screen. The
alternative, and the way the program comes from SoftWood is that the
startup requester is displayed each time you run Final Writer. With the
default setting, you indicate the desired screen type each time the
program runs.

TO SPECIFY STARTUP PREFERENCES:

1. Select "Startup" from the "Preferences" sub-menu in the "Project"
menu.

x %% See Fig 3-9 *xx
The "Startup" window will appear.
* kK See Fig 3-9 * kK
2. Click on the button preceding the "Screen Type".
3. Choose the desired screen "Mode".
4. Click the mouse on the "Save" button.
NOTE. No "Use" facility exists for the "Startup Preferences"
requester because Final Writer does not let you assign startup

preferences to individual documents.
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1.41 3-10




in 39/239

SPELLER/HYPHENATION PREFERENCES

These preferences let you define options the program will use during
spell checking and paragraph hyphenation. For spell checking you can
indicate whether spelling alternatives are given automatically, adjust
the size of memory Final Writer’s speller uses for certain operations,
and specify error reporting tolerances. For hyphenation you can indicate
whether hyphenation is to be on or off, and how much memory the program
can use for hyphenation.

TO SET SPELLER/HYPHENATION PREFERENCES:

1. Choose "Speller/Hyphenation" from the "Preferences" sub-menu in the
"Project" menu.

*x % See Fig 3-10 * % %

The "Speller and Hyphenation Preferences" requester will appear.
* %% See Fig 3-11 * %%
2. Set the preference values according to your needs.

NOTE. Descriptions of the settings are given below.

3. Click on "Use" to save the settings for just the current document.
Click on "Save" to also save the settings so they will be used for
the new documents.

The following are descriptions of this requester’s settings.
RAM DICTIONARY, CACHE SIZE, AND SKIP CACHE

The RAM dictionary size represents the amount of internal memory

devoted to the speller -- larger sizes result in faster spell checking. A
cache is an internal-memory list used to store recently used words,
eliminating the need for further access to the speller when those words
occur again in your document. The size of a cache impacts the speed with
which the speller checks a document. A higher setting means a speedier
spell check, but less internal memory available for other uses. The first
cache stares the words that you have used to replace misspelled words in
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your document. The second cache, called the skip cache, stores words that
you have instructed the speller to skip..

AUTOMATIC SUGGESTIONS
When this option is on, suggested words will be automatically given for
each word found in the dictionaries during spell checking.

ERROR REPORTING
This option lets you turn off the reporting of some conditions detected

by the spell checker.

HYPHENATION
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Enable this option to allow hyphenation for your document. Disable the
option to prevent hyphenation. Individual paragraphs also have
hyphenation settings which must be ON in order for hyphenation to occur
in the paragraph.

MEMORY USAGE
Use this option to indicate the amount of memory the hyphenation process

can use. Higher memory yields faster hyphenation.
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1.42 3-12

DOCUMENT PREFERENCES
Document Item preferences tell Final Writer how much space to insert
when you press the TAB key and no tab stop has been set, how to format

dates and times when inserted via the insert date and insert time
commands, and what character to use for decimal points in amounts.

TO SET DOCUMENT ITEM PREFERENCE:

1. Choose "Document Items" from the "Preferences" sub-menu in the
"Project" menu.

x %% See Fig 3-12 * % %
The "Document Item Preferences" requester will appear.

* %% See Fig 3-12 * %%

2. Set the preference values according to your needs.
NOTE. Descriptions of the settings are given below.

3. Click on "Use" to save the settings for just the current document.
Click on "Save" to also save the settings so they will be used for

the new documents.

The following are descriptions of Document Item preferences.

TAB EVERY
In Final Writer you can set tab stops in two ways. One 1is to use the
ruler (explained in Chapter 7). The other way is to set tab stops in

specified increments using the space defined in this requester. Final
Writer comes to you with default tab stops set at .5 increments. These
default tab stops do not show on the ruler. If you set normal tab stops
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using the ruler, any default tab stops up to and including the position

of a normal tab stop are removed. Default tab stops will continue to
exist past the final normal tab stop.
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Tab stops set with the "Document Item Preferences" requester are always
"Left Tab" stops. If you want to use other types of tab stops, you must
set them using the ruler. Since tabs may be set on a paragraph-by-
paragraph basis using the ruler, you might wish to use the "Document"
requester to specify your most frequently used tab configuration as
default setting. Then, if you need a specific paragraph to deviate from
this configuration, you can reset its tabs on the ruler.

DECIMAL

You may specify one of two decimal styles —-—- period or comma —-- for your
documents. If period is chosen, decimals will be displayed as periods; if
comma is chosen, the will appear as commas.

DATE FORMAT AND ORDER

Using the "Document Item Preferences" requester, you can define the
format and order that you insert in your documents with the "Insert Date"
command.

TIME FORMAT
The "Document Item Preferences" requester offers you two format options
for times inserted in your document with the "Insert Time" command.
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1.43 3-14

DOCUMENTATION COLOUR PREFERENCES

These preferences enable you to determine the shading of 16 colours that
may be used in your document for text, lines,boxes, and ovals. These 16
colours have nothing to do with either the screen colours used in Final

Writer or colours that are embedded in IFF pictures that are imported.
The colours you define here are only for text and any lines, boxes and
ovals you draw inside Final Writer. Furthermore, the colours defined here
may or may not be displayed on your screen in the way you define them. As
with IFF picture colours, these 16 colours are converted to the colours
that are available on your screen. These colours will, however, print as
you defined them.

TO DEFINE A DOCUMENT COLOUR:

1. Choose "Document Colours" from the "Preferences" sub-menu in the
"Project" menu.

* kK See Fig 3-13 * kK
The "Document Colour Preferences" requester will appear. In the
requester you will see a list containing 16 colour choices, some of
which may be titled "Undefined". You may change the name and/or
shading of any of these colours.

* %% See Fig 3-14 **x

2. Click on the line containing the colour you wish to define.
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When you click on the line, the program will change the colour of the
mouse pointer to reflect the shade of the colour selected, and then
transfer the name and definition of the colour into the definition
portion of the requester.

3. If you want to change the name of the colour, modify its name as it
appears under "Name" and press RETURN key.

When you press RETURN the new name will appear in the list.
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4. If you want to change the colour’s shade, move one or more of the
colour sliders horizontally.

As you change the slider the colour in the mouse pointer will change
to reflect the colour you have chosen.

5. If you make a mistake and you wish to undo the changes you have made
to a colours’s name or shade, click on the "Undo" button.

6. Repeat this process for as many colours as you want to define.

7. When you are finished defining colours, click on "Use" to implement
the colour definitions for only the current document, or click on
"Save" to implement the colour definitions as default setting for all
new documents, as well as for the current document.

NOTE. If you click on "Save" other documents you have already created
will retain their colour definitions - only the current and new

documents will utilize the revised definitions.
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1.44 3-16

DOCUMENT SAVE PREFERENCES
This set of preferences is used to specify how much information you want
saved with each document, and to set the program’s Auto Save feature to

ON or OFF.

TO SET DOCUMENT SAVE PREFERENCES:

1. Choose "Document Save" from the "Preferences" sub-menu in the
"Project" menu.

* %% See Fig 3-15 * K%
The "Save Document Preferences" requester will appear.
* %% See Fig 3-16 * K%

2. Set the preference values according to your needs.
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NOTE. Descriptions of the settings are given below.

3. Click on "Use" to save the settings for just the current document.
Click on "Save" to also save the settings so they will be used for
the new documents.

Descriptions of Document Save preferences are as follows.

SAVE WITH EACH DOCUMENT

When you save a document to disk Final Writer can also save any
preferences and style settings with the document. When you open a
document, Final Writer will replace any program default preferences and
style settings with those saved with a document. The more settings that
are saved with a document the larger the disk space required to store the
document. If you want to conserve disk space, you should not save any
preference or style settings with a document that are the same as your
program defaults. A check mark in front of any Preferences or styles item
indicates that item will be saved with a document.
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AUTO SAVE

Whenever you work on a document it is a good idea to save the document
periodically. This protects you from losing your work after a hardware
failure of loss of electricity. When the Auto-Save feature is ON, the
program will wait a specified length of time and then ask if you want to
save the document. The length of time is set using the "Every" popup
menu.

*x % See Fig 3-16 * %%
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1.45 3-18

SCREEN COLOUR PREFERENCES

These preferences enable you to define the shading of 4 colours Final
Writer uses to display window images such as rulers in. These colours
have nothing to do with the colours you use to draw text or graphic
objects. The sole purpose of these preferences is to give you the
opportunity to pick your own colour scheme for viewing the Final Writer
window in.

TO DEFINE A SCREEN COLOUR:

1. Choose "Screen Colours" from the "Preferences" sub-menu in the
"Project" menu

* Kk See Fig 3-17 * Kk

The "Screen Colour Preferences requester will appear. In the
requester you will see a list containing 4 colour choices.
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* ko See Fig 3-18 * kK

2. Click on the line containing the colour you wish to define.
When you click on the line, the program will change the colour of the
mouse pointer to reflect the shade of the colour selected, and then
transfer the name and definition of the colour into the definition

portion of the requester.

3. If you want to change the colour’s shade, move one or more of the
colour sliders horizontally.

As you move the slider the colour in the mouse pointer will change
to reflect the colour you have chosen.

4. If you make a mistake and you wish to undo the changes you have made
to a colours’s name or shade, click on the "Undo" button.

5. Repeat this process for as many colours as you want to define.

1.46 4-0

4 PAGE SETUP

PAGE SETUP requester

Page SiZe ittt e e e e e 4-2
Orientation ....... ..., 4-3
T £ 4-3
Print area. ..o . e e ittt teeeeeeeeeenenns 4-3
Number Pages and Page #S ............... 4-3

"SECTION SETUP’ requester

In List ShoW ..ttt ittt iie it eeeennn 4-4
Section List i iiiii ittt ittt 4-4
Section Name . ...t iiiinnteeeeenenennns 4-4
Edit Area & ittt ittt ettt eeeeeeeaens 4-5
Page #s: Prefix and First .............. 4-6
Page #s: Format .......c.iuiuiiiiiiennnnnn. 4-6
COLUMNS vttt e et ettt eeeeeeesoennneeesss 4-6
Headers and Footers .........uiiieeeenn.. 4-6

1.47 4-1

PAGE SETUP
This chapter describes the process of defining page attributes. in Final
Writer some page attributes are set for the entire document and others
are set for individual sections.

Attributes set for the entire document include:

* Paper dimensions
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Orientation (wide or tall).

Right or Left/Right pages.
Printable area on page.

How the document is to be numbered.

b

Attributes set for individual sections include:

Section name.

Editable area on page.

Prefix (if any) before page numbers.
Format of page numbers.

Number of columns

Space between columns.

Header and footer margins.

b S R S S

Page Setup Page 4-1
"PAGE SETUP" REQUESTER

Page attributes that affect the entire document are defined in Final
Writer’s "PageSetup" requester. These attributes are originally set to

SoftWood’s default values, and may be modified to suit your needs. When a
document is saved, its page setup instructions can be saved with it. When
a document is opened, any page setup instructions saved with the document

are used.

TO DEFINE PAGE ATTRIBUTES THAT AFFECT THE ENTIRE DOCUMENT:

1. Choose "Page Setup" from the "Layout" menu.
* ko See Fig 4-1 * % K
The "Page Setup" requester will appear.
* Kk See Fig 4-2 * kK
2. Make the desired settings.
3. Click on "Use" to save the settings for only the current document.

Click on "Save" to also save the settings as default values for new
documents.

Attributes set in this requester are:

1.48 4-2
PAGE SIZE
* Kk See Fig 4-3 * Kk

Page Size is used to define the physical dimensions of the page you
are using. There are six predefined page types to choose from, as well
as a custom page type. If your document’s page is different from one of
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the predefined types, Choose "Custom page type and specify the height of
the page.

Page Setup Page 4-2

1.49 4-3

ORIENTATION
* %% See Fig 4-3 *x %

This setting is used to tell Final Writer whether to print your document
in tall or in wide mode. A document printed in tall mode will have its
top at the narrow end of the paper.

PAGES
* %% See Fig 4-3 * K%

Use this setting to indicate whether you want to use Left/Right or
simply Right only pages. Usually the only time you will use Left/Right
pages is when your document will be bound with pages facing each other
like ones in this manual. For letters and other documents. Right only
pages are generally used.

PRINT AREA
* %% See Fig 4-3 *x %

Each type of printer has limitations on the area of a page in which it
can print. For example, a continuous feed printer with a narrow carriage
can only print 8 inches wide even though the paper you feed into it is 8
1/2 inches wide. In this case the non-printable area is 1/4 in. on the
left, and 1/4 in. on the right; and the "Left" and "Right" Print Area
margins would be set to .25 inches. On a laser printer or printer with a
sheet feeder, there will also be an area on top and bottom of a page
where the printer can not print.

Below are examples of printer print areas:

PRINTER TOP BOTTOM LEFT RIGHT

HP LaserJet .625 in. .625 in. .25 in. .25 in.
HP Deskjet .1875 in. .375 in. .25 in. .25 in.
Sheet fed 1.0 in. 1.0 in .25 in. .25 in.
Continuous 0.0 0.0 .25 in. .25 in.

Final Writer will set the print area margins to one of the above values
depending upon which Print Area option you choose. If none of these print
areas will work for you, choose "Other" and specify your own margins.
Usually you can consult your printer’s user manual for information on
your printer’s print area. When you print using a sheet fed printer, and
you get an extra blank page, it is usually because the print area or page
type are not defined correctly.
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NUMBER PAGES AND PAGE #s
* %% See Fig 4-3 * K%

If you are going to have more than one section in your document, and you
want page numbers to begin numbering at each type of section, choose the
"By Section" option. If you want your document to be numbered
consecutively from the beginning to end, choose the "By Document" option
and specify the value that page numbering should begin with.

Page Setup Page 4-3

1.50 44

"SECTION SETUP" REQUESTER

When you begin a new document Final Writer creates the document with one
section. You can leave your document containing only one section or you
can insert additional ones. Each section can have its own master pages
and page attributes. Page attributes defined for each section are found
in the "Section Setup" requester.

TO DEFINE PAGE ATTRIBUTES THAT AFFECT A SECTION:

1. CHOOSE "SECTION SETUP" FROM THE "LAYOUT" MENU.

* kK See Fig 4-4 * kK

The "Section Setup" requester will appear.

* %% See Fig 4-5 * %%

2. Make the desired settings.

3. Click on "Use" to save the settings for only the current document.
Click on "Save" to also save the settings as default values for new
documents.

Attributes set in this requester are:
IN LIST SHOW
The "Section Setup" requester can be used to define attributes for
sections that exist in a document, and for default attributes to be used
for new sections to be inserted in your document. Use this setting to
tell the program which attributes you want to define.
SECTION LIST
This list will show all existing sections in your document when "In List
Show" is set to "Existing Sections", and will show Final Writer section

types when the "Preferences" option is selected.

SECTION NAME
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This will be name that is selected in the "Section List".

Page Setup Page 4-4

1.51 4-5

EDIT AREA

Four edit area settings define the area in which text may appear on a
page. Final Writer uses them as limits for the left margin, right margin,
first line indent, tab stop, and hyphenation hot-zone margin. When you
specify any of these settings, Final Writer will not let you specify a
value that is out side the edit area. The recommended way of using the
edit area is as follows: If you want a one inch margin around your page,
set the edit area’s top, bottom, left, and right margins to 1.0 inch.
Never set the edit area so that it is closer to the edge of the page than
the print area. If you edit area extends outside the defined print area,
some of your text may not show on the page when it is printed.

* Kk See Fig 4-6 * Kk

You will need to enter separate settings for the top, bottom, inner, and
outer boundaries of the edit area. If you have selected the left/right
pages options (described later in this chapter0, the outside boundary
will be on the left side of the left side and the right side of the right

page.
* %% See Fig 4-6 * %%
Page Setup Page 4-5

The preceding example shows the relationship between inside and outside
margins and the left and right pages. Typically, when using left/right
pages, you should set the Inside Margin larger that the "Outside Margin".
By doing this, when the document is printed, the printed area of a page
will be offset into the page to allow room for binding. If your document
is a letter, memo, or other document that will not be bound, you will
normally set the inside and outside margins to the same value, and not
use the "left/right page" option.

1.52 4-6

PAGE #s: PREFIX and FIRST #

In the "Page Setup" requester described earlier in this chapter there is
an attribute setting titled "Number Pages". When the "Number Pages"
attribute is set to "By Section" the requester’s "Prefix" and "First #"
attributes under the title "Page #s" are active. the "Prefix" attribute
is used to define text that you want prefixed to any page numbers in your
section. For example, this page of the manual has a prefix of "4 - " (see
below). The "First #" attributes is used to define the starting value for
page numbering in this section.
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FORMAT

* k% See Fig 4-7 * % %

This attribute defines how you want page numbers to appear.

* Kk See Fig 4-7 * kK

In Final Writer you can define your page to include up to 6 side-by-
side, newspaper style columns. You may wish also to define the space that
is to appear between each column.

Text entered in a document with multiple columns will automatically flow
from one column to the top of the next as you type. If you are revising a
document that has already been saved and wish to change the number and/or
width of columns your text will automatically reformatted when you alter
the column settings.

HEADERS AND FOOTERS

"Header" is a term that refers to an area at the top of a page that
contains text and/or graphics that repeat on pages through out the

document. "Footer" is a term that refers to a similar area at the bottom
of pages. "Body" refers to the area between the "Header" and "Footer".
* Kk See Fig 4-6 * kK

In Final Writer, header and footer margins define the portion of a
master page (see Chapter 7) where header and footer information appear.
These margins redefine the size of the "Body" area of a page so that text

Page Setup Page 4-6

entered into it will not cover up areas where header and footer

information show. For example, if you set up a master page with a page
number that is to appear on each of your document’s pages, you would not
want text to you enter to go on top of and cover the page number. To keep
Final Writer from placing "Body" text in the where your page number is, you
define either a header of footer margin in such a way that normal "Body"
text will not flow on top of he page number.

The header and footer settings in the "Page Setup" requester allow you
to specify the size of any header or footer area you want in your
document. For instance, if you enter"2" in the "Header" data entry area,
the "Body" area of your pages will begin 2-units (inches, centimetres, or
picas, depending on the unit or measurement specified in your
preferences) from the top of the "Edit "area". So, as you change the
boundary of the header and/or footer in a document, the height of the
body area also changes.

NOTE: The header and footer areas reside within the edit area. Therefore
if you set you Edit Area Top at 1 inch, and your Header margin at 2
inches, the body of your document will be 3 inches down the top of the

page.
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1.53 5-0

5 CREATING A DOCUMENT

CREATING A NEW DOCUMENT
Creating a new document ..........oiiieunnnn. 5-2

INSERTING TEXT

Setting the insertion point ................. 5-3
Inserting characters .......c.ciiiiiiiiiinne.. 5-3a
Inserting blank lines .......iiiiiiiiio.. 5-3b

CORRECTING MISTAKES AS YOU TYPE
Correcting mistakes as you type ......ceeueo.. 5-4

SELECTING TEXT
Selecting text ...ttt ittt et 5-4a
Selecting a block of text ................... 5-5

DELETING TEXT

Deleting a character ........ ... 5-6
Deleting selected text ........ciiiiiiiiinin.. 5-6a
Deleting a blank line .........c.iiiieeenenn. 5-6b

SAVING A NEWLY CREATED DOCUMENT
Saving a newly created document ............. 5=17

CLOSING A DOCUMENT
Closing a document .. ii ittt tneeeeeeennnnnn 5-T7a

TEXT CLIPS
Creating a text clip ...ttt 5-8

1.54 5-1

CREATING AND SAVING A DOCUMENT

This chapter gives you an overview of the basic information and commands
you will need to begin your document project. Because the initial
creation of a document usually involves a lot of typing and very little
editing or formatting, these more advanced commands will be discussed in
the chapter entitled "Revising a Document" and "Formatting a Document".

Discussed in this section are commands that will enable you to:

Create a new document window
Insert text
Correct mistakes as you type
Select text
Delete text

L S e
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* Save a document
* Close a document
* Create text clips

Creating and Saving a Document Page 5-1

1.55 5-2

CREATING A NEW DOCUMENT

In order to begin a new document project, you will want to have an
untitled Final Writer window

TO CREATE A NEW DOCUMENT WINDOW:
1. Start the Final Writer program or select"New" from the "Project"
menu.

A blank document window with "Untitled" in the title bar will appear.
The insertion point is automatically set in the upper left corner of
the new window.

2. Begin typing your document.

As you type, if the last word of a line does not fit in ita entirety
on a line, the word will either be wrapped around to the next line or
hyphenated. Because of this feature, there is no need to press RETURN
key at the end of each line as you type, unless you want to force a
line to end, or start a new paragraph.

* %% See Fig 5-1 * K x
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1.56 5-3

INSERTING TEXT

"Inserting" is the term used to describe the process of adding
characters to existing text in a document. For example, as you are typing
a document, you may wish to add a sentence in the middle of a paragraph
you have already written. Or, you may need to insert spaces or blank
lines in your document.

In our discussion here, text will refer to any typed character contained
in a Final Writer document. Numbers, letters, punctuation marks, blank
lines, and spaces will all be considered text.

SETTING THE INSERTION POINT

Text can only be inserted at the insertion point. The insertion point
may be moved within the text by pressing the keyboard arrows keys or by
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using the mouse. In a new document window, the insertion point is preset
in the upper left corner of the window.

TO SET THE INSERTION POINT USING THE MOUSE:

1. Move the mouse to the area in the document where you wish to enter
text.

2. Click the mouse button.
If you click the mouse button at any point beyond the last character

in a document Final Writer will automatically place the insertion
point just after the last character in the document (if any).

1.57 5-3a

INSERTING CHARACTERS

When you enter characters on the keyboard, Final Writer inserts them
into your document at the location of the insertion point.

TO INSERT CHARACTERS:
1. Set the insertion point where you wish to add new text.

2. Type the characters you wish to insert.

Creating and Saving a Document Page 5-3

1.58 5-3b

INSERTING BLANK LINES
Blank lines may be inserted by using the RETURN key.
TO INSERT BLANK LINES:
1. Set the insertion point where you wish to add blank lines.
2. Press the RETURN key once for each line you wish to add.
If you are at the end of a line when you first press the RETURN key

Final Writer will go to the next line. It is from that point that
blank lines may be entered.

1.59 54

CORRECTING MISTAKES AS YOU TYPE

The ability to correct mistakes as you type is one of the most important
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features of any word processor. Final Writer makes it easy for you to
remove typographical errors as you go along.

TO CORRECT A TYPING MISTAKES:

1. Use the BACKSPACE key to delete the characters you wish to remove.

Each time you press the BACKSPACE key, the character or space
immediately to the left of the insertion point will be deleted.

2. Type the correct characters once you have removed the mistake.

1.60 5-4a

SELECTING TEXT

Selecting text 1is often performed during the creation of a document to
specify an area of text where you would like to make a change. For
example, you might decide to change text to bold, that a certain phrase
should be replaced by another, or that an entire paragraph should be
deleted. When you have selected text in Final Writer, it is highlighted on
the screen. You may select individual characters, words, lines,
sentences, paragraphs, or even the entire document.

Creating and Saving a Document Page 5-4

x %% See Fig 5-2 * K%

1.61 5-5

SELECTING A BLOCK OF TEXT
You may select a block of text by dragging the mouse over it.

TO SELECT A BLOCK OF TEXT: See picture

1. Position the mouse at the beginning of the text to be selected.

2. Press the mouse button and drag the mouse until all desired text is
selected.

As you drag the mouse, Final Writer will highlight the selected text.
If you drag the mouse above or below the window border, the document
will automatically be scrolled for you.

TO SELECT A SINGLE WORD QUICKLY:

1. Double click the mouse on the word to be selected.

When you double-click on a word, Final Writer selects all characters
that could be part of that word, plus the space following the word.
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1.62 5-6

DELETING TEXT
Deleting is the act of removing text from a document. Characters may be
deleted one at a time or in selected blocks of text. As text is deleted,
your document will reformatted automatically to fill in where the deleted
text used to be.
DELETING A CHARACTER

You can use the BACKSPACE key to remove characters in a right to left
direction from the insertion point.

TO DELETE A CHARACTER WITH THE BACKSPACE KEY:

1. Set the insertion point to the right of the text to be deleted.

2. Press the BACKSPACE key once for each character to be deleted.

1.63 5-6a

DELETING SELECTED TEXT
When you need to delete several characters at once, it is sometimes more
efficient to first select the text to be deleted, and then delete it
using one of the following methods.
TO DELETE SELECTED TEXT:

1. Select the text to be deleted.

2. Press the BACKSPACE key one time, or choose "Clear" or "Cut" from the
"Edit" menu.

* kK See Fig 5-3 * ok Kk
If you choose the "Cut" command, the deleted text may later be
"Pasted" in another place in the document. If you choose "Clear", the

text 1s permanently removed and cannot be pasted. Use "Clear" only
when you know you do not want the text.

1.64 5-6b

DELETING A BLANK LINE (RETURN CHARACTER)

A blank line is one that contains only a RETURN character.
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TO DELETE A BLANK LINE WITH BACKSPACE KEY:

1. Place the insertion point at the left margin of the line below the
blank line you wish to delete. If there is not a line below the blank
line to be deleted, Place the insertion point on the blank line
itself.

2. Press the BACKSPACE key once.
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1.65 5-7

SAVING A NEWLY CREATED DOCUMENT

Once you have finished writing your new document, you should save it to
either the hard drive or to a floppy disk. Once saved, the document can
be reopened for editing or formatting. Even if you are going to edit your
document immediately after completing the first draft version, you should
save the document to safeguard it in case of power outage or other
unforeseeable events.

TO SAVE A DOCUMENT FOR THE FIRST TIME:
1. Select "Save" from the "Project" menu.

* K% See Fig 5-4 *xx

A file requester will appear in which you can give your document a
name and choose where you wish to save it.

* %% See Fig 5-4 * K x

2. Click in the data entry area following the word "File", delete the
word "Untitled", Then type in the desired document name.

3. You may assign your file to a drawer by either using the "Parent" and
"Volumes" buttons, or by clicking in the data entry area following
the word "Drawer" and typing in the appropriate drawer name, then

pressing the RETURN key.

4. Click on "OK"

1.66 5-7a

CLOSING A DOCUMENT

After you have created and saved your document, you may close it using
the window close gadget.

TO CLOSE A DOCUMENT:
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1. Click the mouse in the window close gadget.

* %% See Fig 5-4 * K x
Your document will close. If you have made any changes to the
document, and have forgotten to save them, a requester will appear to

remind you to do so.
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1.67 5-8

TEXT CLIP

Many times when you create a document, you will enter text that has
previously been entered in other documents. A good example is your name
and address as it appears at the top of a letter. Other examples include:

FAX headings
Memo headings
Names and addresses of clients
Common text used over and over

* ok ok *

You can automate the task of entering these and other commonly used bits
of text by using Final Writer’s text clip feature. For example, you can
save your name and address, complete with type and paragraph settings, in
a text clip. Then, when you create a document and need to insert your
name and address in it, you instruct Final Writer to place the text clip
in your document, saving yourself the bother of typing it all over again.
This process is especially useful when you assign a text clip to either a
User Button or User Menu Item. Let’s say you have assigned your name and
address to a button labelled "M". To have Final Writer insert the
contents of the text clip in your document, complete with formatting, all
you need do is click the mouse on the "M" button.

TO CREATE A TEXT CLIP:
1. Enter and format the text that is to be in the text clip.
2. Select the text that is to comprise the text clip.

* %% See Fig 5-5 * K x
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3. Choose "Save Text Clip" from the "Project" menu.

* %% See Fig 5-5 *xx

Final Writer will display a file requester.

4. Use the file requester to give the text clip a name and a place to
save it.

Final Writer will save the text along with all format settings to a
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disk file having the name entered.

Refer to Chapter 3 - Setting Preferences for details on assigning a text

clip to a button or menu item.
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1.68 6-0

6 REVISING A DOCUMENT

OPENING A DOCUMENT
Opening a document .. ...ttt iiiinenneennnnnn 6-2

MOVING THROUGH TEXT

SCrolling LeXL ittt ittt ittt e 6-3
Using "Go To’ commands . .....ouiuuuuuuneeeeeenn 6—-4
Using the 'Page Number’ icon ................ 6-4a

REPLACING TEXT
Replacing text with new text ................ 6-5
Replacing text using ’'Paste’ command ........ 6-6

COPYING TEXT
Copying text ..ttt ittt ittt 6-6a

MOVING TEXT
Moving text ..ttt e e e e e 6-7

FINDING AND REPLACING TEXT
Find text ... e 6-8
Finding and replacing text .................. 6-10

INSERTING THE DATE AND TIME
Inserting the date or time .................. 6-12

UPDATING DATE AND TIME
Updating date or time ........iiiiiiiiienen.. 6-13

SORTING PARAGRAPHS
Sorting two or more paragraphs .............. 6-13a

ADDING A COLUMN OF NUMBERS
Adding a column of numbers ..........c0000... 6-14

1.69 6-1

REVISING A DOCUMENT

In the previous chapter, you learned to insert text, correct

typographical errors, select text, and delete text. In this chapter you
will learn the following additional editing functions to help you revise
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existing documents:

* Opening an existing document

* Moving through text

* Replacing text

* Copying text

* Moving text

* Finding and replacing text

* Inserting date and time

* Updating date and time

* Sorting paragraphs

* Adding a column of numbers

Revising a Document Page 6-1

1.70 6-2

OPENING A DOCUMENT

A document must be open and visible on the screen before it can be

edit

TO

* Kk K

* k%

ed.
OPEN AN EXISTING DOCUMENT:
Choose "Open" from the "Project" menu.

See Fig 6-1 * %%
A file requester will appear on your screen.

See Fig 6-1 * %%
If necessary, use the scroll arrows to find the document you wish to
open. If you need to go to a different Parent or Volume to locate
your file, click on the appropriate button to do so.
When you have located your document, click on its name to select it.
Notice that the name of the document appears in the data entry area
following the word "File". If you want to type the name of your file
directly in this area instead of scrolling the list and clicking on
the name, you may do so. Simply click the mouse in the data entry
area and type the name exactly as it appears in the list.

Click on the "Open" button to open the document.

Your Document will appear in the Final Writer window.

Revising a Document Page 6-2

1.71

6-3
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in
MOVING THROUGH TEXT
In order to see parts of the document which are not currently visible on
the screen, it is necessary to move the document through the window.

SCROLLING TEXT

The scroll bars allow you to move your document up, down or sideways
within the document window.

TO

* Kk

SCROLL IN SMALL INCREMENTS:

Click the mouse on the scroll arrow that points in the direction you
wish to move in the document.

For example, to move towards the bottom of the document, click on the
down arrow. If you click and hold on the down arrow, you will
eventually scroll the document to its end. There will be a slight
delay when you first press on an arrow.

SCROLL TEXT IN LARGER INCREMENTS USING THE SCROLL BOX:
Click the mouse in the region of the scroll box that corresponds with
the desired direction of scrolling.

See Fig 6-2 * % %

In The illustration, the Scroll Box only appears beneath the

Scroll Drag Bar. This situation occurs when the top of a document
appears at the top of the window. When the document is scrolled
towards the bottom, there will be two Scroll Box areas: one

above and another below the Scroll Drag Bar. Clicking in the Scroll
Box area above a Scroll Drag Bar moves the viewing area toward the
top of the document, clicking in the Scroll Box area below the drag
bar moves the viewing area toward the bottom of the document.

SCROLL TEXT IN LARGER INCREMENTS USING THE SCROLL DRAG BAR:

Drag the horizontal or vertical scroll drag bar until you reach your
desired destination.

* %% See Fig 6-2 * %%

The horizontal scroll bar move left and right through text. The
vertical scroll bar moves up and down through text.
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1.72 6-4

USING THE "GO TO"COMMANDS

Final Writer’s "Go To" commands, found in the "Page" menu, allow you to
move directly to any page or the previously selected text within your
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document. This method of moving through text is especially helpful when
your document is very large and scrolling would take too much time.

TO GO TO A SPECIFIC PAGE IN A DOCUMENT:
1. Choose "Go To Page" from the "Page” memu.
* Kk See Fig 6-3 * Kk
The "Go To Page" requester will appear on your screen.
* kK See Fig 6-3 * kK
2. Type the desired page number.
Notice that the number you type appears in the "Page Number" data
entry area. If you make a mistake, use the delete key to remove the
incorrect information, and then retype the correct page number.
3. Click on "OK".
The desired page will appear on the screen.
TO GO TO SELECTED TEXT IN A DOCUMENT:
1. Choose "Go To Selection® from the "Page® menu.

* kK See Fig 6-4 * kK

Your document will return to any currently selected text.

1.73 6-4a

USING THE "PAGE NUMBER" ICON

The "Page Number" icon in the command strip at the top of a document’s
window can be used to access pages as follows:

TO GO TO THE NEXT PAGE:

1. Click the mouse on the icon.
* %% See Fig 6-2 * % x
Revising a Document Page 6-4

TO GO TO PREVIOUS PAGE:

1. Hold the SHIFT key down, and while it is down, click the mouse on the
"Page Number" icon.

TO GO TO THE LAST PAGE OF A DOCUMENT:

1. Hold the ALT key down, and while it is down, click the mouse on the
"Page Number" icon.
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TO GO TO THE FIRST PAGE OF A DOCUMENT:

1. Hold the ALT and SHIFT keys down, and while they are down, click the
mouse on the "Page Number" icon.

1.74 6-5

REPLACING TEXT
Replacing text is a common editing technigque in which new text is
entered in place of existing text. One way in which text may be replaced
is to backspace over the unwanted text, and type in the new text. The
following are two more efficient ways.
REPLACING SELECTED TEXT WITH NEW TEXT
You can replace selected text by entering one or more characters from
the keyboard. The first character entered replaces the entire range of
selected type.
TO REPLACE SELECTED TEXT WITH A CHARACTER FROM THE KEYBOARD:

1. Select the text to be replaced.

You {can replace selected text by entering one ore more characters
from the keyboard.} Text in between { and } are selected text.

2. Enter the desired character or characters from the key board and
continue typing.

You could

In this example, the letter "c¢" in "could" replaced the entire
selected range of text.
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1.75 6-6

REPLACING TEXT USING THE "PASTE" COMMAND
Selected text can also be replaced with the contents on the Clipboard.
TO REPLACE TEXT WITH THE CONTENTS OF THE CLIPBOARD:
1. select the text to be replaced.

2. Choose "Paste" from the "Edit" menu.

* K% See Fig 6-5 * K%
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The selected text will be replaced with whatever is on the Clipboard.

1.76 6-6a

COPYING TEXT
Final Writer’s "Cut" and "Paste" commands enable you to make a copy of
text in one location in your document and "paste" the copied text to
another location. You can also paste copied text in another Final Writer
document.
TO COPY TEXT WITHIN THE SAME DOCUMENT:

1. Select the text to be copied.

{Please note that only one block of text can be placed on the
Clipboard.} Text in between { and } are selected text.

2. Choose "Copy" from the "Edit" menu.
* %% See Fig 6-5 * K%
The selected text will be copied onto the clipboard.

3. Set the insertion point at the location in the document where you
wish to paste the copied text.

Please note that only one block of text can be placed on the
Clipboard. |

4. Choose "Paste" from the "Edit" menu.
* %% See Fig 6-5 *x %

The text on the clipboard will be pasted into the document at the
insertion point.

Please note that only one block of text can be placed on the
Clipboard. Please note that only one block of text can be placed on
the Clipboard.
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1.77 6-7

MOVING TEXT
Blocks of text may be moved within the document using the "Cut" and
"Paste" commands found in the "Edit" menu. Text may also be moved between

separate documents.

TO MOVE TEXT:
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1. Select the text to be moved.

{This text is to be moved.} This text is to stay.
Text in between { and } are selected text.

2. Choose "Cut" from the "Edit" menu.
* %% See Fig 6-5 * %%
The selected text will be temporarily move to the clipboard.

3. Set the insertion point at the location in the document where you
wish to paste the cut text.

This text is to stay. |
4. Choose "Paste" from the "Edit" menu.
* %% See Fig 6-5 * %%

The text on the clipboard will be pasted into the document at the
insertion point.

This text is to stay. This text is to be moved.
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1.78 6-8

FINDING AND REPLACING TEXT

When revising a document, you may wish to locate and/or replace certain
words, phrases, or numbers. Final Writer’s "Find" and "Replace" commands

enable you to do so without having to read the entire document on screen.

FINDING TEXT

The "Find" feature can be used independently of the "Replace" feature
when you simply want to locate text in a document.

TO FIND SPECIFIC TEXT IN A DOCUMENT:

1. Set the insertion point in the document location where you wish the
search to begin.

For example, if you wish to search an entire document, you would set
the insertion point to the left of the document’s first word.

2. Choose "Find ..." from the "Edit" menu.
* Kk See Fig 6-6 * % *

The "Find" requester will appear on your screen.
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* kK See Fig 6-7 * kK

3. Enter the desired character, word, number or phrase in the data entry
area under the words "Search For".

4. Set the search parameters by clicking in the appropriate option boxes
to add or remove check marks.

Placing a check mark in the box preceding "Ignore Case" will cause
Final Writer to find the specified text regardless of case or
capitalization. The absence of a check mark means that Final Writer
will search for the word exactly as you entered it in the data entry
area. Any variation in case will cause the word to be passed by in
the search.

A check mark in the box preceding "Wrap Around" will instruct Final
Writer to search the entire document regardless of the insertion
point. Similarly, the absence of a check mark before the "Wrap
Around" means that the search will end at the bottom of the document.

Revising a Document Page 6-8
5. Click on the "Find" button to begin the search.

Final Writer will begin the search for the specified text. When the
text 1s located, it is selected. If you wish to edit the text, simply
click on the document and edit the text as you wish.

* Kk See Fig 6-7 * kK

TO FIND THE NEXT OCCURRENCE OF SPECIFIED TEXT:

1. Click the mouse on the "Find" button again.
* %% See Fig 6-7 * K%
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1.79 6-10

FINDING AND REPLACING TEXT

If you want to locate text and replace it with alternative text, you may
do so with Final Writer’s "Replace" command. For example, you may wish to
search for all occurrences of "1986" and replace them with "1987". You
may direct Final Copy to replace all instances of certain text, or you
may personally review each occurrence to determine whether or not it
should be replaced.

TO SEARCH FOR ALL OCCURRENCES OF SPECIFIC TEXT AND AUTOMATICALLY

REPLACE THEM WITH ALTERNATIVE TEXT:

1. Set the insertion point in the document location where you wish the
words search to begin.
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2.

* kK

* Kk K

If you wish to search an entire document, set the insertion point to
the left of the document’s first word.

Choose "Replace ..." from the "Edit" menu.
See Fig 6-8 * % %

The "Replace" requester will appear on your screen.
See Fig 6-8 * %%

Enter the character, word, number or phrase you wish to find in the
data entry area under the words "Search For".

Enter the replacement text in the data entry area under the words
"Change To".

Set the search parameters by clicking in the appropriate option boxes
to add or remove check marks.

Placing a check mark in the box preceding "Ignore Case" will cause
Final Writer to find the specified text regardless of case or
capitalization. The absence of a check mark means that Final Writer
will search for the word exactly as you entered it in the data entry
area. Any variation in case will cause the word to be passed by in
the search.

A check mark in the box preceding "Wrap Around" will instruct Final
Writer to search the entire document regardless of the insertion
point. Similarly, the absence of a check mark before the "Wrap
Around" means that the search will end at the bottom of the document.
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6.

Click on the "All" button to begin the search and automatic
replacement process.

Final Writer will begin to search for the specified text. When the
text is located, it will automatically be replaced with the
alternative text.

TO SEARCH FOR AN INDIVIDUAL OCCURRENCE OF SPECIFIED TEXT AND
REPLACE IT WITH ALTERNATIVE TEXT:

* K K

* kK

Set the insertion point in the document location where you wish the
words search to begin.

If you wish to search an entire document, set the insertion point to
the left of the document’s first word.

Choose "Replace ..." from the "Edit" menu.
See Fig 6-8 * kK
The "Replace" requester will appear on your screen.

See Fig 6-8 * % K
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3. Enter the character, word, number or phrase you wish to find in the
data entry area under the words "Search For".
4. Enter the replacement text in the data entry area under the words
"Change To".
* Kk See Fig 6-8 * Kk
5. Set the search parameters by clicking in the appropriate option boxes

to add or remove check marks.

Placing a check mark in the box preceding "Ignore Case" will cause
Final Writer to find the specified text regardless of case or
capitalization. The absence of a check mark means that Final Writer
will search for the word exactly as you entered it in the data entry
area. Any variation in case will cause the word to be passed by in
the search.
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A check mark in the box preceding "Wrap Around" will instruct Final
Writer to search the entire document regardless of the insertion
point. Similarly, the absence of a check mark before the "Wrap
Around" means that the search will end at the bottom of the document.

6. Click on the "Find" button to begin the search.
Final Writer will begin the search for the specified text. When the
text is located, it is selected. You must the decide if you would
like to replace the text.
7. To replace selected text, click on "Replace". To continue the search
without replacing the currently selected text, click on "Find".
You may instruct Final Writer to repeat your most recent replacement
decision for the next occurrence by clicking on "Again".
8. When you have completed the "Find" and "Replace" session, click on
the close box in the upper left corner of the "Replace" requester.
The requester will be closed.
1.80 6-12
INSERTING THE DATE OR TIME
You may occasionally want to have the current date or time inserted in
you document. Final Writer utilizes your computer’s internal system clock

to do so quickly and easily when you use the "Insert Date Time" command.

TO

INSERT DATE OR TIME IN YOUR DOCUMENT:

Set the insertion point where you would like the date or time to
appear.
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2. Choose "Date" or
menu.
* % % See Fig 6-9

The current date
according to the
inserts the date

Revising a Document

"Time" from the "Insert Item" sub-menu of the "Edit"

* Kk k
or time will appear in your document formatted
settings in the Documents Preferences. Final Writer

or time to the right of your insertion point.

Page 6-12

1.81 6-13

UPDATING DATE AND TIME

If you have inserted a date or time in your document using the

"Insert Item" command in the ""edit" menu, you may wish to update those
items later to be current. Dates and times are updated with the current
date or time from the system clock.

TO UPDATE DATES OR TIMES IN YOUR DOCUMENT:

1. Drag the mouse through the paragraph(s) containing the dates or times

you want to update.

NOTE. To select all dates and times in the document, choose "Select
All"™ from the "Edit" menu - this will select all paragraphs in the
document.

NOTE. If the dates or times are in a master page, you will have to

first access the master page before selecting the paragraphs.

2. Choose "Date" or "Time" from the "Update Item" sub-menu of the "Edit"
menu.
* %% See Fig 6-9 * %%

1.82 6-13a

SORTING PARAGRAPHS

This feature lets you alphabetize paragraphs to their textual content.
You must choose to sort either from low to high, or high to low. The
"Sort" command is only active when two or more paragraphs are selected
for sorting.

TO SORT TWO OR MORE PARAGRAPHS:

1. Select the paragraphs to be sorted.

{WOODY }
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{TERRY}
{MARY }
{PAT }
{BEN }
2. Choose "Low" to "High" from the "Sort" sub-menu of the "Extra" menu.

* Kk %

See Fig 6-9 * % K
The paragraphs will be sorted from first to last character.

{BEN }
{MARY }
{PAT }
{TERRY}
{WOODY }
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1.83 6-14

ADDING A COLUMN OF NUMBERS

Final writer can be instructed to add column of numbers and insert the
total at a designated place in the document.

TO ADD A COLUMN OF NUMBERS:

Select the text tool if it is not already selected.

Position the mouse to the top and left of the first number to be
added.

Position Mouse here ——>
45.23
100.41

<-—-—- Drag mouse here
The total is:

Press the ALT key while simultaneously pressing and holding the
mouse.

Draw a "marquee" around the column of numbers by dragging the mouse
diagonally from the upper left to the lower right corner of the
column of numbers.

A "marquee" is a special dotted line that "captures" all the
information within its borders. When you release the mouse button,
Final Writer adds the numbers in the marquee and places the total on
the clipboard.
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The total is:

5. Set the insertion point at the location where you would like the
total to be displayed.

45.23
100.41
The total is: | <-—- insertion point
6. Choose "Paste" from the "Edit" menu.
* kK See Fig 6-5 * kK
45.23
100.41
The total is: 145.64
The total of the column of numbers will be pasted at the insertion
point taking the attributes of the text settings in effect at the
insertion point. Once the total is pasted, you can edit it as desired.
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NOTES
Blank Page
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1.84 7-0

7 FORMATTING A DOCUMENT

PAGE VIEW
Page VoW ittt ittt ettt e e e e 7-2

PARAGRAPH SETUP

Using the ruler . ...ttt eeeeeenneens 7-3

Using the ’'Paragraph’ requester ............. 7-3a

Making a paragraph settings ................. 7-4
Left and right margins ................. 7-4
First line indent marker ............... 7-5
Tab StOPS vttt ittt it e e e e e e 7-6
Hyphen ’'Hot Zone’ margin ............... =1
Paragraph alignment .................... 7-9
SPACING i e e 7-10
Hyphenation off/on ....... ..., 7-11

TEXT AND FONTS

Opening Fonts ..ttt ittt ittt eeenennn 7-12
Selecting fonts ittt ittt 7-12a
FONL S1Ze & ittt ittt et e et ettt ee e 7-13
TS U 5 o U O 7-14
Text style ittt et et et 7-14a
Text position ...ttt it e it 7-15

Text width ...ttt i i et et e e e e 7-15a




70/239

TeXE CASE ittt ittt ettt ettt ettt eeeeneeneens 7-16
Text COLOUT ittt ittt et e ettt et et e e e eeeeeenn 7-16a
Oblique PerCentagesS . i ettt eeeeeeennnennn 7-17

TYPE SPECS
Using the ’'Type Specs’ requester ............ 7-18
Inmplementing LypPe SPECS v v vt i vt teeeenenenenn 7-19

TEXT STYLES

Applying paragraph styles .........iiiinnn.. 7-20
The "Defining Text Styles" requester ........ 7-20a
Defining a new text style ........... i 7-21
Modifying an existing text style ........... 7-21a
Deleting a text style ... ..t iinnnnnn 7-21b

PARAGRAPH STYLES

Applying paragraph styles ........ciiiiinnn.. 7-22
Accessing the "Paragraph Style" requester ... 7-23
Defining a new paragraph style .............. 7-25
Modifying a paragraph style ................. 7-25a
Deleting a paragraph style .......ciiinnn.. 7-25b
Using the ’'Tabs’ requester .................. 7-25c
Defining a new tab stop ................ 7-26
Modifying an existing tab stop ......... 7-26a
Removing an existing tab stop .......... 7-26b

MASTER PAGES

MasSter PAgES t ittt ittt ittt ettt 7-27
Defining master pages ......ceeeeeeenen.. 7-28
Headers and footers .........cciiiiiiiiinnn.. 7-28a

PAGE BREAKS

Page breaks ... ..l i e e 7-29
Inserting a page break ................. 7-29
Removing a page break .................. 7-29

1.85 7-1

FORMATTING A DOCUMENT

This chapter describes using Final Writer to modify the way your text
appears. Included in this section are instructions to:

* ADJUST THE PAGE VIEW PERCENTAGE - You may view your page at several
different magnifications and reductions to assist you in your document
formatting process.

* SPECIFY PARAGRAPH PARAMETERS - Paragraph parameters may be specified
for indents, spacing, and alignment. These parameters may be set as
default of for a single document.

* USE THE RULER -Final Writer’s ruler is a powerful tool in formatting
your document. You can even copy and paste the ruler settings to save
time defining the style of your paragraphs.
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* USE FONTS EFFECTIVELY - Final Writer enables you to select from a
number of different fonts and specify their style, leading, style
position, width, case, colour, and oblique (or slant) percentage.

* USE, DEFINE, AND EDIT STYLES - Final Writer’s styles feature lets you
quickly and efficiently apply predefined paragraph, tabs, and type
setting to your text.

* USING MASTER PAGES - Text and graphics entered on master pages will
automatically be placed on each of page of your document with the
exception of a title page. You can use master pages in many ways
including specifying header and footer information.

* DETERMINE PAGE BREAKS - Final Writer automatically creates new pages
as you enter text. If you want, you can override these page breaks by
inserting you own forced page breaks.
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1.86 7-2

PAGE VIEW

From time to time when you are reformatting your document, you may wish
to alter the size of your page on the screen. A smaller page view lets
you see a greater portion of the page on the screen, while a larger page
view enables you to see part of a page with a greatly enlarged
perspective. In Final Writer you can view your page at its normal 100%
size, as well as at 25%, 50%, 75%, 125%, 150%, 200% and 400% sizes.

Final Writer also lets you perform full editing at any magnification.

* % Kk See Fig 7-1 xx*x 25% magnification
* %% See Fig 7-2 *xx 50% magnification
* % % See Fig 7-3 xx*x 200% magnification
* %k See Fig 7-4 xx* 400% magnification

TO CHANGE YOUR VIEW MAGNIFICATION:

1. Choose the desired page view percentage from the "Page View" sub-menu
of the "View" menu.

* kK See Fig 7-5
Your page will appear at the desired size on your screen.

Formatting a Document Page 7-2
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1.87 7-3

PARAGRAPH SETUP

Final Writer is a paragraph based word processor. That means that you
can give each paragraph its own unique set of characteristics. This
assignment of characteristics may be accomplished in two ways. One way is
by using the Final Writer ruler. The other way is by using the
"Paragraph"
requester.

USING THE RULER
The Final Writer ruler contains all the tools you will need to set up
your paragraphs. The various elements on the ruler may be changed for a
single paragraph by clicking in that paragraph, then making the desired

changes. Settings for multiple paragraphs may be altered by first
selecting the desired paragraph and then making changes to the ruler.

1.88 7-3a

USING THE "PARAGRAPH" REQUESTER

For certain paragraph settings, it may be desirable in some situations
to use the "Paragraph" requester. The settings for left margin, right
margin, first line, indent, and hyphenation hot-zone can be set with a
numeric value using the requester. Using the ruler, you can move a marker
horizontally along the ruler until you reach the desired location. If you
need to specify a precise value for these settings, you may wish to use
the "Paragraph" requester.

You will also need to use the "Paragraph" requester if you want your
settings to be used as default values for new documents.

TO OPEN THE "PARAGRAPH" REQUESTER:
1. Choose "Paragraph ..." from the "Layout® memu.
* %% See Fig 7-6 * %%
The "Paragraph" requester will appear.

* kK See Fig 7-6 * %k
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1.89 74

MAKING PARAGRAPH SETTINGS

The following instructions describe Paragraph settings. All settings can
be made via the ruler. Everything but tab stops can also be accomplished
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using the "Paragraph" requester.

LEFT AND RIGHT MARGINS
The left and right margins define your text’s distance from the sides of
the page.

* % * See Fig 7-7 * Kk

TO CHANGE THE LEFT OR RIGHT MARGIN USING THE RULER:

1. To change the margin(s) of a single paragraph, click the mouse in
the paragraph to be changed. To change the margin(s) of multiple
paragraphs at once, select the desired paragraphs by dragging the
mouse through them.

2. Position the mouse on the appropriate margin marker.

3. Press and hold the mouse button and drag the appropriate margin
marker horizontally along the ruler.

4. Release the mouse button when the margin marker is where you want it
to be on the ruler.

Final Writer will automatically reformat the paragraph or paragraphs
to reflect the new margin.

TO CHANGE THE LEFT OR RIGHT MARGIN USING THE REQUESTER:

1. To change the margin(s) of a single paragraph, click the mouse in
the paragraph to be changed. To change the margin(s) of multiple
paragraphs at once, select the desired paragraphs by dragging the
mouse through them.

2. Choose "Paragraph ..." from the "Layout" menu.

* %k See Fig 7-6 * %k

3. Enter the appropriate values in the "Left and Right indents" area in
the "Paragraph" requester.

4. Click on the "OK" button.

Final Writer will automatically reformat the paragraph or paragraphs
to reflect the new margin.
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1.90 7-5

FIRST LINE INDENT MARGIN
The first line indent margins tells Final Writer how far to indent the
first line of a paragraph.

* Kk k See Fig 7-7 * % %
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TO CHANGE THE FIRST LINE INDENT MARGIN USING THE RULER:

1. To change the first line indent margin of a single paragraph, click
the mouse in the paragraph to be changed. To change the first
line indent margin of multiple paragraphs at once, select the desired
paragraphs by dragging the mouse through them.

2. Position the mouse on the first line indent marker.

3. Press and hold the mouse button and drag the appropriate margin
marker horizontally along the ruler.

4. Release the mouse button when the first line indent marker is where
you want it to be on the ruler.

Final Writer will automatically reformat the paragraph or paragraphs
to reflect the new margin.

TO CHANGE THE FIRST LINE INDENT MARGIN USING THE REQUESTER:

1. To change the first line indent margin of a single paragraph, click
the mouse in the paragraph to be changed. To change the first
line indent margin of multiple paragraphs at once, select the desired
paragraphs by dragging the mouse through them.

2. Choose "Paragraph ..." from the "Layout" menu.
* kK See Fig 7-6 * Kk

3. Enter the appropriate values in the "First" area in the "Paragraph"
requester.

4. Click on the "OK" button.

Final Writer will automatically reformat the paragraph or paragraphs
to reflect the new margin.
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1.91 7-6

TAB STOPS

Tab stops let you align text to form lists, outlines, tables, and other
elements precisely. When you press the TAB key while typing, the
insertion point will automatically advance to the location of the next
tab stop. The Final Writer ruler has four different tab stop options:

LEFT TAB - Text is aligned left justified at the tab stop.
RIGHT TAB - Text 1is aligned right justified at the tab stops.
CENTRE TAB - Text is centred at the tab stops.

DECIMAL TAB - Decimal points are aligned at the tab stop. This tab type
is used mostly for numbers that must be properly lined up
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in a column. Characters to the left of the decimal point
are inserted to the left of the tab stop. Characters to
the right of the decimal point are inserted to the right
of the tab stop. Numbers without a decimal and other text
are aligned to the left of the tab stop.

* Kk See Fig 7-7 * K x

TO SET TAB STOPS USING THE RULER:

1. To set tab stops for a single paragraph, click the mouse in the
paragraph to be changed. To set tab stops multiple paragraphs at
once, select the desired paragraphs by dragging the mouse through
them.

2. Click on the appropriate tab icon.

3. Click on the ruler at the point where you wish to insert the tab
stop.

All default tab stops to the left of the new tab stop will be
removed.

4. Repeat this procedure as often as you like until all tab stops are
set.
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TO MOVE A TAB STOPS USING THE RULER:

1. To move a tab stops for a single paragraph, click the mouse in the
paragraph to be changed. To move a tab stops multiple paragraphs at
once, select the desired paragraphs by dragging the mouse through
them.

2. Click and hold the mouse on the tab stop you would like to move.

3. Drag the tab stop horizontally along the ruler until it is located
where you want it.

4. Release the mouse button.
TO DELETE A TAB STOPS USING THE RULER:

1. To delete a tab stops for a single paragraph, click the mouse in the
paragraph to be changed. To delete a tab stops multiple paragraphs at
once, select the desired paragraphs by dragging the mouse through
them.

2. Click and hold the mouse on the tab stop you would like to delete.

3. Drag the tab stop below the ruler.

4. Release the mouse button.
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1.92 7-7

HYPHEN "HOT ZONE" MARGIN

This margin marker tells Final Writer that when the last word of a line
starts before the marker, it is eligible for hyphenation. When you set
the "Hot Zone" marker too close to the right margin, your lines will
appear less ragged along the margin, but you may have excessive
hyphenation. If you set the "Hot Zone" marker too far from the right
margin, you will have less hyphenation, but your lines will appear more
ragged.

Formatting a Document Page 7-7
* Kk See Fig 7-7 * k%
TO MOVE THE "HOT ZONE" MARKER USING THE RULER:

1. To move the "Hot Zone" marker for a single paragraph, click the mouse
in the paragraph to be changed. To move the "Hot Zone" marker for
multiple paragraphs at once, select the desired paragraphs by
dragging the mouse through them.

2. Click and hold the mouse on the hyphen "Hot Zone" marker.

3. Drag the marker horizontally along the ruler until it is located
where you want it.

4. Release the mouse button.
TO MOVE THE "HOT ZONE" MARKER USING THE REQUESTER:

1. To move the "Hot Zone" marker for a single paragraph, click the mouse
in the paragraph to be changed. To move the "Hot Zone" marker for
multiple paragraphs at once, select the desired paragraphs by
dragging the mouse through them.

2. Choose "Paragraph ..." from the "Layout" menu.

* %k See Fig 7-6 * ok k

3. Click the mouse in the "Hot Zone" data entry area, and enter the
desired value.

4. Click on the "OK" button.

Formatting a Document Page 7-8

1.93 7-9

PARAGRAPH ALIGNMENT
In Final Writer you can align paragraph text in the following ways:

LEFT JUSTIFIED - Text 1is aligned so that lines start at the left margin
(except the first line which starts at the first line
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indent) .

RIGHT JUSTIFIED - Text is aligned so that lines end at right margin.

CENTRED — Text is aligned so that lines are centred between the

left and right margins (except the first line which is
centred between the first line indent and the right
margin) .

FULL JUSTIFIED - Text is aligned so that lines at the left margin

(except the first line which starts at the first line
indent), and end at the right margin. In order to do
this the program may expand spaces between words.

* k% See Fig 7-7 * % %
TO SET JUSTIFICATION USING THE RULER:
1. To set justification for a single paragraph, click the mouse
in the paragraph to be changed. To set justification for
multiple paragraphs at once, select the desired paragraphs by
dragging the mouse through them.
2. Click on the desired justification icon.
TO SET JUSTIFICATION USING THE REQUESTER:
1. To set justification for a single paragraph, click the mouse
in the paragraph to be changed. To set justification for
multiple paragraphs at once, select the desired paragraphs by
dragging the mouse through them.
2. Choose "Paragraph ..." from the "Layout" menu.
* ok k See Fig 7-8 * ok k
3. Choose the desired "Text Alignment" option.
* ok k See Fig 7-8 * ok k
4. Click on the "OK" button.
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1.94 7-10
SPACING
When text is entered in a document, the space between lines depends
mostly on the size of the font being used. Larger fonts will have larger
areas between lines to allow room for letters that descend below the main
llne, SUCh as "y", "j", "p", and "q".
Final Writer enables you to choose from four spacing -- single, 1-1/2,
double, and variable. The chart below shows you important information for
each type of spacing.




SPACING HEIGHT OF LINE MAXIMUM LINE HEIGHT

Single 120% of line’s largest font 240 pts

1-1/2 180% of line’s largest font 18 pts

Double 240% of line’s largest font 24 pts

Variable Spacing is based on tallest leading value of line
* % * See Fig 7-7 * Kk

TO SET LINE SPACING USING THE RULER:

1. To set line spacing for a single paragraph, click the mouse
in the paragraph to be changed. To set line spacing for
multiple paragraphs at once, select the desired paragraphs by
dragging the mouse through them.

2. Click the mouse on the desired line spacing icon.
TO SET LINE SPACING USING THE REQUESTER:

1. To set line spacing for a single paragraph, click the mouse
in the paragraph to be changed. To set line spacing for
multiple paragraphs at once, select the desired paragraphs by
dragging the mouse through them.

2. Choose "Paragraph ..." from the "Layout" menu.

* kK See Fig 7-8 * kK

3. Click on the desired line spacing option.

* %k See Fig 7-8 * %k

4. Click on the "OK" button.
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1.95 7-11

HYPHENATION OFF/ON
The hyphenation off and on selectors are used to enable or disable the
automatic hyphenation function of selected paragraphs.

* k% See Fig 7-7 * %k %

TO SET HYPHENATION STATUS USING THE RULER:

1. To set hyphenation status for a single paragraph, click the mouse
in the paragraph to be changed. To set hyphenation status for
multiple paragraphs at once, select the desired paragraphs by
dragging the mouse through them.

2. Click the mouse on the desired hyphenation selector.

TO SET HYPHENATION STATUS USING THE REQUESTER:
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1. To set hyphenation status for a single paragraph, click the mouse
in the paragraph to be changed. To set hyphenation status for
multiple paragraphs at once, select the desired paragraphs by
dragging the mouse through them.

2. Choose "Paragraph ..." from the "Layout" menu.

* %k See Fig 7-6 * ok k

3. Click on the desired "Enable" status button.

4. Click on the "OK" button.

NOTE. In order for hyphenation to occur for a paragraph, the hyphenation

feature itself must be turned on for the document. See the description of

hyphenation preferences in for more information.
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1.96 7-12

TEXT AND FONTS

High quality output is probably one of the main reasons you chose Final
Writer as your word processor. Final Writer lets you define your text’s
font, size, style, position, width, case, colour, and oblique percentage.
All the commands you will need work effectively with text can be found in
the "Text" menu. The settings may be made all at once using the "Type
Specs" command (explained later in this chapter), or one at a time using
other commands in the "Text" menu.

OPENING FONTS

SoftSans is the Final Writer default font. Before you may use another
font in your document, you must first open it.

TO OPEN A FINAL WRITER FONT:
1. Choose "Open ..." from the "Font" sub-menu of the "Text" menu.
* ok k See Fig 7-9 * ok

The "Font" requester will appear.

2. Scroll through the list of fonts until you reach the font you want to
open.

3. Double click on the desired font.

1.97 7-12a
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SELECTING A FONT
You may select a font prior to text, or you may change the font of
existing text. All font commands are executed through the "Font" sub-menu
of the "Text" menu.

TO SELECT A FONT:

1. Open the desired font if you have not already done so.

2. If you are changing the font of existing text, select the text to be
changed. If you are setting a font for text that has not yet been
entered, set the insertion point where the text is to appear.

3. Choose the desired font from the "Font" sub-menu of the "Text" menu.

If text was selected, it will be redrawn in the new font.
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1.98 7-13

FONT SIZE
You may specify text ranging in size from 4 points to 300 points.
* %k See Fig 7-10 * %k
TO SET FONT SIZE:

1. If you are changing the size of existing text, select the text to be
changed. If you are setting the size for text that has not yet been
entered, set the insertion point where the text is to appear.

2. Choose the desired size from the "Size" sub-menu of the "Text" menu.
To specify a size that does not appear in the "Size" sub-menu, simply
select "Other". When the "Size" requester appears, type the desired
size in the data entry area and click on "OK".

* Kk See Fig 7-11 * kK

If text was selected, it will be redrawn in the new size.
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1.99 7-14

LEADING

Leading, refers to the amount of space between lines of type. If you are
using single, 1-1/2, or double spacing for your text, you need not be
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concerned with leading, since it is preset according to the chosen
spacing and largest font size on a line.

If you are using the variable spacing option, however, you will need to
specify a leading value for your text. When specifying the leading, be
sure to allow enough space for your characters to appear in their
entirety. A leading value that is too small will chop off the tops and/or
bottoms of certain characters.

TO SET LEADING:

1. If you are changing the leading of existing text, select the text to
be changed. If you are setting the leading for text that has not yet
been entered, set the insertion point where the text is to appear.

2. Click on the variable spacing icon if it is not selected.

3. Choose the desired leading measurement from the "Leading" sub-menu of
the "Text" menu. To specify a leading value that does not appear in
the "Leading" sub-menu, simply select "Other". When the "Leading"
requester appears ,type the desired value in the data entry area and

click on "OK".

If text was selected, it will be redrawn with the new leading.

1.100 7-14a

TEXT STYLE
Text may be entered in one of the following styles:
* k% See Fig 7-11 * % %
TO SET TEXT STYLE:

1. If you are changing the style of existing text, select the text to
be changed. If you are setting the style for text that has not yet
been entered, set the insertion point where the text is to appear.

2. Choose the desired style from the "Style" sub-menu of the "Text"
menu.

* Kk See Fig 7-11 * kK
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1.101 7-15

TEXT POSITION

Text may be positioned in one of the following three ways:
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* ko See Fig 7-10 * kK
TO SET TEXT POSITION:

1. If you are changing the position of existing text, select the text to
be changed. If you are setting the position for text that has not yet
been entered, set the insertion point where the text is to appear.

2. Choose the desired text position from the "Position" sub-menu of the
"Text" menu.

* kK See Fig 7-12 * kK

1.102 7-15a

TEXT WIDTH

Text may be set using different width values. These alter the way
characters appear by increasing or decreasing the width of those
characters. Some examples of different widths are shown.

* %% See Fig 7-10 x %%
TO SET TEXT WIDTH:

1. If you are changing the width of existing text, select the text to
be changed. If you are setting the width for text that has not yet
been entered, set the insertion point where the text is to appear.

2. Choose the desired width from the "Width" sub-menu of the "Text"
menu. To specify a width that does not appear in the "Width" sub-
menu, simply select "Other". When the "Width" requester appears, type
the desired value in the data entry area and click on "OK".

* Kk See Fig 7-12 * Kk
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If text was selected, it will be redrawn in the new width.

1.103 7-16

TEXT CASE
You may choose from three different case settings for your text.
* % * See Fig 7-10 * % *
TO SET TEXT CASE:

1. If you are changing the case of existing text, select the text to
be changed. If you are setting the case for text that has not yet
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been entered, set the insertion point where the text is to appear.
2. Choose the desired case from the "Case" sub-menu of the "Text" menu.
* Kk See Fig 7-12 * kK

If text was selected, it will be redrawn in the new case.

1.104 7-16a

TEXT COLOUR

You may specify any of Final Writer’s predefined colours for your text.
NOTE. When entering coloured text, the Final Writer default screen
(which only shows four colours) may not allow you to see your text in the
exact colour selected. However, if you position the mouse in the text and
press the mouse button, the mouse pointer itself will change colour to
reflect the true colour of the text.

TO SET TEXT COLOUR:

1. If you are changing the colour of existing text, select the text to
be changed. If you are setting the colour for text that has not yet
been entered, set the insertion point where the text is to appear.

2. Choose "Colour ..." from the "Text" menu.

* ko See Fig 7-13 * kK
The "Select Colour" requester will appear.
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* Kk See Fig 7-13 * Kk

NOTE. The colours in this requester are defined in the "Colour
Preferences" requester (See Chapter 3)

3. Double-click on the name of the desired colour.

1.105 7-17

OBLIQUE PERCENTAGE

Text may be slanted to the left or right to varying degrees using the
"Oblique Percent" command.

TO SET OBLIQUE PERCENTAGE:

1. If you are changing the oblique percentage of existing text, select
the text to be changed. If you are setting the oblique percentage for
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text that has not yet been entered, set the insertion point where the
text is to appear.

2. Choose the desired oblique percent from the "Oblique Percent" sub-
menu of the "Text" menu. To specify a value that does not appear in
the "Oblique Percent" sub-menu, simply select "Other". When the
"Oblique Percent" requester appears, type the desired value (from -20
to 20) in the data entry area and click on "OK".

* ko See Fig 7-14 * kK

A negative oblique percent will result in text that slants to the
left, while a positive percent results in text that slants to the
right. If text was selected, it will be redrawn in the new oblique
percent.
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1.106 7-18

TYPE SPECS

In some instances, you may wish to change many or all of the text
characteristics for existing text or text you are about to enter. When
this is the case, it may be impractical and time consuming to make all of
the revisions using the individual text commands found in the "Text"
menu. For this reason, Final Writer includes the "Type Specs" requester,
which provides a convenient and speedy way to make numerous adjustments
to text.

TO OPEN THE "TYPE SPECS" REQUESTER:
1. Choose "Iype Specs ..." from the "Text" memu.
* % * See Fig 7-15 * % *
The "Type Specs" requester will appear.
* kK See Fig 7-15 * % Kk
TO SELECT A TYPEFACE USING THE "TYPE SPECS" REQUESTER:
1. Click on the "Select” button in the "Typeface" area of the requester.

A font requester will appear.

2. Scroll through the list of open fonts until you reach the typeface
you wish to use.

3. Double-click on the desired typeface.

The "Type Specs" requester will reappear, and the name of the

typeface you have just selected will appear in the "Name" data entry
area. If you wish, you can also click in the data entry area and type
the name of the desired font rather than using the scrollable list of
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typefaces.
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TO SELECT A COLOUR USING THE "TYPE SPECS" REQUESTER:

1. Click on the name of a colour in the "Colour" list.

TO SET SIZE, WIDTH, LEADING, AND OBLIQUE PERCENT USING THE
"TYPE SPECS" REQUESTER:

1. Click in the appropriate data entry area for size, width, leading, or
oblique percent.

2. Type the desired numeric value for each type characteristic you wish

to set.

TO SET STYLE, TEXT POSITION, AND CASE USING THE "TYPE SPECS" REQUESTER:

1. Click on the desired setting for style, position, and case.

* %k See Fig 7-16 * %k

1.107 7-19

IMPLEMENTING TYPE SPECS

You may implement type specs for text that has been selected for text
that has not yet been entered, or as default settings.

TO IMPLEMENT THE TYPE SPECS SETTINGS:

1. If you want to make the settings the default for new documents, check
the "Set Default" box at the lower left corner of the requester.

2. Click on "OK".
If text was selected, it will be redrawn in the new font. If text was
not selected, the new type spec will be applied to text entered at

the insertion point.
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1.108 7-20

TEXT STYLES

In Final Writer you can define, name, and save text styles. For each
text style you can define preset type specifications attributes, and
indicates which type specification attributes are to be applied to text.
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Atypical use for text styles is to create one text style for each font
you will normally open. Later when you create new documents, you will not
have to open each of these fonts —-- they will already be in "Text Styles"
sub-menu.

TO APPLY A STYLE:

1. If you are applying a text style to existing text, Select the desired
text. If you are applying text style to text that has not yet been
entered, set the insertion point where the text is to appear.

2. Choose the desired text style from the menu

* kK See Fig 7-17 * % Kk

Text styles are defined, modified, and deleted from the "Define Text
Styles" requester

1.109 7-20a

TO ACCESS THE "DEFINE TEXT STYLES" REQUESTER
1. Choose "Define ..." from the "Text Styles" sub-menu.
* Kk See Fig 7-17 * % K

The requester will appear.

The "Define Text Styles" requester contains a list of existing styles
along with areas used to define a text style.

TEXT STYLES NAMES Text styles that have been defined.

FKEY SHORTCUT Used to assign an Amiga function key combination to a
text style.

MENU POSITION The position a text style is to appear in the "Text
Styles" sub-menu.

NAME The name assigned to a text style.
DEFINE BUTTON Provides access to the "Type Specs" requester
(discussed in previous section) where you define type

attributes for a text style.

APPLY Check boxes that indicate which type spes attributes
are to be applied with the text style.
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* %k See Fig 7-18 * %k
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1.110 7-21

TO ADD A NEW TEXT STYLE:
1. Click the mouse on the "New" button.

2. Define the text style’s attributes.

3. Click on the "Accept" button to add the text style to the list of
text styles.

4. Repeat the above steps for each new text style that you want to
define.

1.111 7-21a

TO MODIFY AN EXISTING TEXT STYLE:

1. In the list of text styles names click the mouse on the name of the
text style to be modified.

2. Make desired modifications to the text style.
3. Click on the "Accept" button.

4. Repeat the above steps for each new text style that you want to
modify.

1.112 7-21b

TO DELETE AN EXISTING TEXT STYLE:

1. In the list of text styles names click the mouse on the name of the
text style to be deleted.

2. Click on the "Remove" button.

4. Repeat the above steps for each new text style that you want to
delete.
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1.113 7-22

PARAGRAPH STYLES

In Final Writer you can define, name, and save paragraph styles. Each
paragraph style can have paragraph attributes, tab stops, and text
attributes assigned to it. Paragraph styles differ from text styles
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(discussed above) in two ways:

1. Text styles are applied specifically to text while paragraph styles
are applied to the entire paragraph.

2. If you change the definition of a paragraph style, any paragraphs in
the document that have been defined with that style will be
reformatted automatically to conform with the style’s new definition.
Text styles, on the other hand, only affect text when they are first
applied.

Paragraph styles provide a powerful way of formatting a document. With a
single style you can set the font and its size, type style, text
alignment (left,right, centred, or full), margins, and tab stops.
Paragraph styles free you from the need to apply many formatting
attributes individually to every paragraph. For example, if you want all
section titles to be size 18, in SoftSans_bold, centred, and underlined,
you can apply all of these attributes at once, rather than having to set
each of these formats to every section title you create. Styles also make
changing the definition of the style and the changes are automatically
applied throughout the document.

Using styles ensures that the style of each type of paragraph remains
consistent throughout your document. To prepare this manual we created
styles for body text paragraphs, bulletted text, captions, headlines, and
sub-headings.

Final Writer also uses styles to format the paragraphs it creates for
special sections such as Outline, Index, Table of Contents, Table of
Illustrations, Endnotes, And Bibliography. The number of styles that can
be defined for these types of sections is fixed -- you can not add and
remove "Main" styles. "Main" styles are used for Main, Title Page, and
Preface sections.

TO APPLY A PARAGRAPH STYLE:

1. Set the insertion point in a paragraph, or drag the mouse through
multiple paragraphs that you want to apply a paragraph style to.
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2. Choose the desired style from the "Apply Style" sub-menu of the
"Layout" menu.

* %k See Fig 7-19 * %k

Paragraph styles are defined, modified and deleted using the "Paragraph
Style Definition" requester.

1.114 7-23

TO ACCESS THE "PARAGRAPH STYLES DEFINITION" REQUESTER:

1. From the "Define Styles" sub-menu select either " Main ..." or the
special section type whose styles you want to work with.
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* Kk See Fig 7-19 * %

*

The style requester will appear. The title bar of the requester will

show the type of para

The "Paragraph Styles De
styles along with areas u

* %% See Fig 7-20 * %
PARAGRAPH STYLE NAMES

FKey Shortcut

MENU POSITION

NAME

Formatting a Document Pa

* %% See Fig 7-20 * %

PARAGRAPH SETTINGS

TAB SETTINGS

TYPE SETTINGS

TABLE OF CONTENTS POPUP

OUTLINE POPUP

Formatting a Document Pa

graph style you are defining.

finition" requester contains a list of paragraph
sed to define a paragraph style.

*

Defined paragraph styles.

Used to assign an Amiga function key combination
to a paragraph style.

The position in which a paragraph style is to
appear in the menu.

Name assigned to paragraph style.

ge 7-23

*

The "Define ..." button access the "Paragraph"
requester. Check "Apply" if you want
"Paragraph" requester attributes assigned with
the style.

The "Define ..." button access the "Tabs"
requester. Check "Apply" box if you want tab
stops set in the "Tab" requester to be assigned
with the style.

The "Define ..." button access the "Types Spec"
requester. Check "Apply" box if you want tab
stops set in the "Type Specs" requester to be
assigned with the style.

If a paragraph set with style being defined are
to generate an entry when the Table of Contents
section is created, select from this menu the
level of Table of Contents entry to be
generated. If no Table of Contents entry is to
be generated, choose "None".

If a paragraph set with style being defined are
to generate an entry when the Outline section
is created, select from this menu the level of
Outline entry to be generated. If no Outline
entry is to Dbe generated, choose "None".

ge 7-24
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1.115 7-25

TO DEFINE A NEW STYLE:

1. Click on the button labelled "New".

Remember, you can only add new styles when working with "Main"
styles.

3. Define the style’s attributes.
Descriptions of these attributes appear latter in this section.
4. Click on the "Accept" button to save the new style.

5. Repeat the above steps for each style you want to define.

1.116 7-25a

TO MODIFY AN EXISTING STYLE:

1. In the "Style Names" list click the mouse on the name of the style
you want to modify.

2. Make desired modifications to the style’s attributes.
3. Click on the "Accept" button.

4. Repeat the above steps above for each style to be modified.

1.117 7-25b

TO DELETE AN EXISTING STYLE:

1. In the "Style Names" list click the mouse on the name of the style
you want to delete.

2. Click on the "Accept" button.

3. Repeat the above steps above for each style to be modified.

1.118 7-25c

USING THE "DEFINE TABS" REQUESTER

When you click on the "Define ..." button in the "Tab Settings" area of
the requester, the "Tabs" requester will appear. Within this

requester is a list of existing tab stops and a series of action buttons
that you use to define new, edit existing, and remove existing tab stops
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from a style. Only 8 tab stops may be defined for a style.
TO ACCESS THE "DEFINE TAB" REQUESTER:
1. Click on the Tab Settings "Define ..." button.

Formatting a Document Page 7-25

* Kk See Fig 7-21 * % K

1.119 7-26

TO DEFINE A NEW TAB STOP:

1. Access the "Define Tabs" requester and click on "New".

Default settings for the new tab stop will be provided in the
definition area.

2. Modify the default settings to what you wish them to be.

3. Click on the "OK" button when you are finished defining the style’s
tab stops.

1.120 7-26a

TO MODIFY AN EXISTING TAB STOP:

1. Access the "Define Tabs" requester and click the mouse on the line in
the list of tab stops showing the tab stop you want to modify.

2. Modify the default settings to what you wish them to be.

3. Click on the "OK" button when you are finished defining the style’s
tab stops.

1.121 7-26b

TO REMOVE AN EXISTING TAB STOP:

1. Access the "Define Tabs" requester and click the mouse on the line in
the list of tab stops showing the tab stop you want to remove.

2. Click on the "OK" button when you are finished removing the style’s
tab stops.
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1.122 7-27

MASTER PAGES

A master page is a place in a Final Writer document where you define
text and graphics that are to appear on each of your document’s pages.
There are many uses for master pages, including document titles, chapter
names, special graphics, dates, page backgrounds, headers, footers and
page borders.

* kK See Fig 7-22 * kK

Every time a new document is created, blank master pages are also
created. If you leave master pages blank, they will have no effect on the
body text and/or graphics on a master page, those items will appear on
each page of your document except the optional title page.

If you have set the "Left/Right" page option (See Chapter 4), the left
master page will be used for items that are to be repeated on left-sided
pages, and the right master page will be used for items on right-sided
pages. If you have not set the "Left/Right" page option, only items
entered on the right master page will affect your pages.

Master pages are accessed through the page icons in the horizontal ruler
at the top of a document window. There are three page icons —-- left
master, right master, and body. Clicking on the left or right master page
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icon will bring the appropriate master page up on your screen. Clicking
on the body page icon will return you to the body of your document.

* ko See Fig 7-22 * % K

1.123 7-28

TO DEFINE LEFT AND/OR RIGHT MASTER PAGES:

1. Click on either the left or right master page icon.

The selected master page will appear and the window title will show
which master page is being edited.

2. Enter any text or graphics you wish to include as master items.

Remember that any text or graphics placed on a left master page will
appear on every left-sided page of a document. Similarly, any text or
graphics entered on a right master page will appear on every right
page of your document. If you are not using the "Left/Right" page
option (See Page Setup - Chapter 4), nothing you enter in the left
master page will appear on your body pages.

3. Click on the body page icon in the ruler to return to your document’s
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body page (s) .

1.124 7-28a

HEADERS AND FOOTERS

There are a number of ways in which you may utilize a header or footer.
The most common use for headers and footers is for page numbering. Other
common uses are for inserting the date and time that the document was
written or printed, and for running headlines at the top of each page.

In Final Writer you create headers and footers inside a master page. At
the top of a master page you place header items, and at the bottom of the
same master page, you place any footer items.

Final Writer is a word processor where text must be entered sequentially
from the top of the first page down through a document. This is in
contrast to desktop-publishing programs that allow you to start a text
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* Kk See Fig 7-22 * % K

block wherever you want it. For example, in a desktop-publishing program,
if you want to place text at the bottom of the page, you start a new text
block at the bottom of a page. In a word-processor, however, you need to
advance the insertion point to the bottom of the page by pressing the
RETURN key or by entering text. Therefore, when you want to place a
footer at the bottom of a Final Writer master page, you advance the
insertion point to the bottom of the master page.

When you use a master page to define header and footer items, you will
probably not want text you enter on a body page to be placed on top of
the header and footer items. In order to accomplish this, you will need
to limit the size of the "Body" area of your page by specifying the
height you are using for header and footer areas (See Chapter 4 - Headers
and Footers) .

1.125 7-29

PAGE BREAKS

Page breaks will occur naturally as you type your document. Final Writer
inserts a page break whenever it gets to the end of a page. You may also
manually insert page breaks at any place in your document.

TO INSERT A PAGE BREAK:

1. Set the insertion point where you want the page break to appear in
your document.

2. Choose "Insert Page Break" from the "Layout" menu.
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* %k See Fig 7-23 * %k
TO REMOVE A PAGE BREAK:

1. Set the insertion point at the beginning of the line of text
immediately following the page break you want to remove.

2. Choose "Remove Page Break" from the "Layout" menu.

* %% See Fig 7-23 * %%
If the "Remove Page Break" menu item is disabled, it is because you
did not set the insertion point in the paragraph immediately

following a forced page break.
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1.126 8-0

8 GRAPHICS AND TEXT BLOCKS

SETTING REQUESTERS
Settings requester ........i.iiiiiiiiiiiiiien.. 8-2

CREATING LINES, BOXES, AND OVALS

Creating lines, boxes, and ovals ............ 8-2a
S oL 8-3
Drawing a line ......c.iiiiiiiiiinnneennn. 8-3a
"Line Settings" requester .............. 8-3b
Drawing an arrow-tipped line ........... 8-4
T @ = 8—-4a
Drawing a boOX ..ttt ieenneneeenns 8-5
"Box Settings" requester ............... 8-5a
Drawing a rounded-cornered box ......... 8-6
Drawing a perfect square ............... 8-6
Drawing a prefect square with
rounded COXNETS ..o eenenns 8-6
(072 8-6a
Drawing an oval ...ttt eennn. 8-7
"Oval Settings" requester .............. 8-T7a
Drawing a perfect circle ............... 8-8

IMPORTING GRAPHICS
Importing graphics ........cciiiiiiii. 8-8a
"Imported Graphic Settings" requester ....... 8-9

TEXT BLOCKS
Creating a text block ......... ... 8-10

SELECTING OBJECTS
Selecting a single object .........cciciiio... 8-11
Selecting with the marquee .................. 8-12

DELETING OBJECTS
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Deleting objects ... i, 8-12a

SIZING OBJECTS

Sizing ObJeCL S i ittt ittt e e e e e e 8-13
Constrained sizing of IFF ILBM’S ............ 8-13a
"Snap To! Sizing ...ttt e e 8-13b
TQUick! S1ZINg v i it e e e e e e e e 8-14

MOVING OBJECTS

Moving ObDJECLS i ittt ittt e ettt e 8-14a
Constrained mMOVINg ... iii ittt eennnns 8-14b
"Snap To/ MOVING . iii ittt ittt et 8-14c

ROTATING OBJECTS

Rotating using the menu ..........0iiinnnn.. 8-15
Rotating using the mouse .........cciinn.. 8-15a
Resizing a rotated object ............. ... ... 8-15b

MODIFYING A OBJECT’S SETTINGS
Modifying settings ......c.cciiiiiiiiinnnnnnnn. 8-16

SPECIFYING EXACT SIZE AND LOCATION
Specifying size and position ................ 8-16a

CROPPING IMAGES
Cropping images ..ttt teeeeeneeenenns 8-17

CANCELLING GRAPHIC ACTIONS
Cancelling graphic actions .........c.ccoio... 8-18

GROUPING OBJECTS
Grouping oObjJects .ttt ittt e e 8-18a
Ungrouping objects ......iiiiiiiiiiie.. 8-18a

GRAPHIC COLOURS VS SCREEN COLOURS VS PRINTED COLOURS
AbOUL COLlOULS t ittt ittt ettt et eeeeeeeeeennns 8-19

1.127 8-1

WORKING WITH GRAPHICS

Nothing adds interest to a word processing document like carefully
created, well placed graphic. Graphics that can be used in Final Writer
are:

Diagonal, horizontal, and vertical lines
Arrow-tipped lines

Boxes and perfect squares

Rounded-corner boxes and prefect squares
Oval and perfect circles

Movable text boxes

L S T

In addition, you can also import into Final Writer the following images
created in other programs:
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x» IFF ILBM images
* EPS (Encapsulated Postscript) images

Each graphic in Final Writer is treated as an independent object and may
be deleted, sized, or moved according to your needs. Text can be made to
automatically flow around or on top of any graphic objects according to
you instructions.

In this chapter are instructions to help you:

Create graphics

Insert IFF ILBM graphics

Change graphic settings

Select graphics

Delete graphics

Size graphics

Move graphics

Specify exact size and position of graphics
Crop IFF ILBMs

Rotate graphics and text blocks.
Cancel a graphic operation

b . R S S S

1.128 8-2

SETTING REQUESTERS

There are five settings requesters each corresponding to one of the
graphic types supported in Final Writer. These requesters are:

Imported Graphic Settings
Line Setting

Box settings

Oval Setting

Text Block Settings

b S T

These requesters may be used in several different ways:

* Set permanent default values for a type of graphic object. When a new
document is created these default values define the attributes for
graphic objects placed in documents.

* Set temporary default values for a type of graphic object. When a new
graphic object is created, these temporary default values are used as
the attributes for the objects, however the permanent default values
remain the same.

* Reset the attributes of existing objects. Attributes of any existing
graphic object can be modified at any time.

1.129 8-2a
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CREATING LINES, BOXES, AND OVALS

Graphic elements like (horizontal, vertical, and diagonal),
rectangles/squares, and ovals/circles may be created in your document
using the tool icons found in the command strip at the top of the window.

When you create a graphic Final Writer creates it using the default
settings for the type of graphic being created. For example, if the
default settings for a line are 2 points thick and coloured red, when you
draw a new line, it will be drawn as a 2 point, red line. You can, of
course, change a graphic's current or default settings at any time.

You have two choices of how a new graphic is to be drawn when you create
it. One choice is to set the default settings to the way you want the
graphic drawn, and then create the graphic. The other choice is to just
create the graphic using the default settings, and then after the graphic
is drawn, change its settings to suit your needs. In the instructions
that follow for creating graphics, the default setting are defined, and
then the graphic is created.

1.130 8-3

LINES

In Final Writer you can draw lines at any angle, and with any thickness
ranging from hairline (thinnest at any given resolution) to 12 points.
Lines may be created in any of the 16 colours defined in (Document Colour
Preferences). Text can be made to flow around or on top of lines. A
special option allows you to create a line with an arrow at one of the
line's end points.

Lines are drawn to confirm with the default settings for new lines. If
you want to override these settings, you can either access the "Line
Settings" requester and define line settings before you draw a line; draw
a line and while it is selected access the requester to change its
settings.

1.131 8-3a

TO DRAW A LINE:

1. Click on the desired line tool icon.

* %% See Fig 8-1 * K%
The "New Line" tool will produce perfectly horizontal, vertical, or
45 diagonal lines. The "New Free Line" tool will produce diagonal
lines of any angle. Once a line is drawn, you can change its angle no

matter which tool you used to create it.

2. Position the mouse pointer at the place in your document where you




98 /239

wish your line to begin.

3. Hold the mouse button down and drag the mouse in the direction you
want the line to be drawn.

4. Once the line has reached the desired length, release the mouse
button.

1.132 8-3b

TO ACCESS THE "LINE SETTINGS" REQUESTER:

* Kk %

* kK

Select "Lines ..." from the "Settings" sub-menu.
See Fig 8-2 * %%
The "Line Setting" requester will appear.

See Fig 8-3 * kK

Graphics and Text Blocks page 8-3

Below are brief descriptions of the "Line Settings" requester.

TEXT FLOW OPTIONS - The way in which text is to flow around (or over)
a line. Text may flow on the left or right side of a line, following
either the line‘s contour or a vertical line created by the line‘s
frame. If the "None" option is selected, the line will become a back
ground element, and the text will flow over it.

TEXT FLOW DISTANCE - The amount of space between the line and the
text that flows next to it. For example, a setting of 0.25 will leave
1/4" of empty space between a line and the text flowing around it.
The minimum flow distance is 1/8" (0.125).

LINE WEIGHT - The lines thickness.

COLOUR — The line‘s colour.

1.133 84

TO DRAW AN ARROW-TIPPED LINE:

Follow the steps above for drawing a line except
hold the LEFT ALT key before pressing the mouse button, and continue
to hold the ALT key down while dragging the mouse.

The size of the arrow depends upon the thickness of the line. The
arrow will draw on the end where the mouse is released.
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1.134 8-4a

BOXES

Final Writer lets you create boxes in any width and height combination.
A box can have a line as a border, and can be filled with a colour, or
left empty. Special option for boxes are the ability to make boxes with
rounded corners and/or perfect squares.

Boxes are drawn to conform with the default settings for new boxes. If
you want to override these settings, you can either access the "Box
Settings" requester and define settings before you draw a box; or draw
the box and while it is selected access the requester and change the

settings.

Graphics and Text Blocks Page 8-4

1.135 8-5

TO DRAW A BOX:
1. Click on the "New Box" tool icon.

* %% See Fig 8-1 * %%

2. Position the mouse pointer at the place in your document where you
wish your box‘s corner to begin.

3. While holding the mouse button down, drag the mouse in the proper
direction to draw the box.

4. Once the box has reached the desired size and shape, release the
mouse button.

1.136 8-5a

TO ACCESS THE "BOX SETTINGS" REQUESTER:
1. Select "New Box" from the "Settings" sub-menu.
* %% See Fig 8-2 * % %
The "Box Settings" requester will appear.

* %% See Fig 8-4 * K%

Below are brief descriptions of the "Box Settings" requester.

TEXT FLOW OPTIONS - The way in which text is to flow around (or over)

a box. Text may flow on the left or right side of a box, following
either the box‘'s contour or a vertical line created by the box'‘s
frame. If the "None" option is selected, the box will become a back
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ground element, and the text will flow over it.

TEXT FLOW DISTANCE - This specifies the amount of space between the
box and the text that flows next to it. For example, a setting of
0.25 will leave 1/4" of empty space between a box and the text
flowing around it. The minimum flow distance is 1/8" (0.125).

BORDER WEIGHT - The box'‘s border thickness.
BORDER COLOUR - The box'‘s border‘'s colour.
Graphics and Text Blocks Page 8-5

FILL INTERIOR - Determines whether the box is filled with a colour
(Solid) or left empty (Transparent).

FILL COLOUR — The colour of fill when the "Fill Interior"™ is set to
"Solid".

1.137 8-6

TO DRAW A ROUNDED-CORNERED BOX:

1. When drawing a box hold the LEFT ALT key before pressing the mouse
button, and continue to hold the ALT key down while dragging the
mouse.

TO DRAW A PERFECT SQUARE:

1. When drawing a box, hold the LEFT SHIFT key before pressing the
mouse button, and continue to hold the SHIFT key down while dragging
the mouse.

TO DRAW A PREFECT SQUARE WITH ROUNDED-CORNERS:

1. When drawing a box, hold the LEFT ALT and the LEFT SHIFT key before
pressing the mouse button, and continue to hold the ALT and SHIFT key
down while dragging the mouse.

1.138 8-6a

OVALS

Final Writer lets you create ovals in any width and height combination.
An oval can have a line as a border, and can be filled with a colour, or
left empty. A special option for ovals is the ability to make ovals as
perfect circles.

Ovals are drawn to comfort with the default settings for new ovals. If
you want to override these settings, you can either access the !Oval
Settings" requester and define settings before you can draw an oval; or
draw the oval and while it is still selected access the requester and
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change its settings.
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1.139 8-7

TO DRAW AN OVAL:

1. Click on the "New Oval" tool icon.
* K% See Fig 8-1 * K%

2. Position the mouse pointer at the place in your document where you
wish your oval to begin.

3. While holding the mouse button down, drag the mouse on the proper
direction to draw the oval.

4. Once the oval has reached the desired size and shape, release the
mouse button.

1.140 8-7a

TO ACCESS THE "OVAL SETTINGS" FROM THE "GRAPHICS" MENU:

1. Select "Oval Settings" from the "graphics" menu.
* %% See Fig 8-2 * %%

Final Writer will display the "Oval Settings" requester.
* kK See Fig 8-5 * kK

Below are brief descriptions of the "Oval Settings" requester.

TEXT FLOW OPTIONS - The way in which text is to flow around (or over)

an oval. Text may flow on the left or right side of an oval,

following either the oval‘s contour or a vertical line created by the
oval's frame. If the "None" option is selected, the oval will become

a back ground element, and the text will flow over it.

TEXT FLOW DISTANCE - This specifies the amount of space between the

oval and the text that flows next to it. For example, a setting of
0.25 will leave 1/4" of empty space between an oval and the text
flowing around it. The minimum flow distance is 1/8" (0.125).
BORDER WEIGHT - The oval‘s border thickness.

BORDER COLOUR - The oval‘s border‘s colour.

Graphics and Text Blocks Page 8-7
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FILL INTERIOR - Determines whether the oval is filled with a colour
(Solid) or left empty (Transparent).
FILL COLOUR — The colour of fill when the "Fill Interior" is set to
"Solid".
1.141 8-8

TO DRAW A PERFECT CIRCLE

1. When drawing an oval, hold LEFT SHIFT key before pressing the mouse
button, and continue to hold the SHIFT key down while dragging
the mouse.

1.142 8-8a

IMPORTING GRAPHICS

In addition to graphics drawn with Final Writer'‘s drawing tools, you may
also import pictures and brushes created by other programs in either EPS
(Encapsulated PostScript) format or the Amiga graphic format IFF ILBM,
HAM, Extra Halfbrite, and 24 bit IFF ILBMs may also be imported.

Imported graphics may be inserted before or after text is entered. Text
will always reformat to flow around a graphic according to that graphic's
text flow setting.

IMPORTING GRAPHICS

An imported graphics may be inserted into a Final Writer ‘s document as
long as it is in either EPS or IFF ILBM graphic format. Imported graphics
are drawn to conform with the default settings for new imported graphics.
If you want to override these settings, you can either access the
"Imported Graphic Settings" requester and define settings, before you
import as graphic; or import the graphic and while it is selected access
the requester and change its settings.

TO IMPORT A GRAPHIC:
1. Select "Import" from the "Graphics" menu.
* %% See Fig 8-6 * %%

A file requester will appear.

2. Use the file requester to locate the graphic you want to import, and
click the mouse in its name.

3. Click the "OK" button.
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1.143 8-9

TO ACCESS THE "IMPORTED GRAPHIC SETTINGS" REQUESTER:

* Kk %

* kK

Select "Imported Graphics" from the "Graphics" menu.
See Fig 8-6 * % K
Final Writer will display the requester.

See Fig 8-7 *xx

The following are descriptions of this requesters settings

TEXT FLOW OPTIONS - The way in which text is to flow around (or over)
a graphic element. Text may flow on the left or right side of a IFF
ILBM, following either the graphic‘s contour or a vertical line
created by the graphic‘'s frame. EPS graphics can only have text
flowed to the left or right of the graphic’s frame .If the "None"
option is selected, the graphic will become the background element,
and text will flow over it.

TEXT FLOW DISTANCE - The amount of space between text and a graphic.
For example, a setting of 0.25 will leave 1/4" of empty space between
a graphic and the text flowing around it.

BORDER WEIGHT - The graphic’s border thickness.
BORDER COLOUR - The graphic’s border colour.

BACKGROUND - The background of an IFF ILBM graphic can be treated as
solid or transparent. If the background is transparent, the picture‘'s
"transparent" colour (usually colour 0) will not be used when
rendering the graphic. If you plan to wrap text to the contour of a
graphic, you will want to make the background transparent. If a HAM
graphic was clipped as a brush, it will use the shape of the brush.

Graphics and Text Blocks page 8-9

SAVE/LINK OPTION - The "Save graphic" option actually stores a copy
of the inserted graphic in your document. The "Save link"

option does not save the graphic itself in your document, but rather
saves a link to that graphic. However, when you open your document,
the graphic will also be opened through the link and will appear on
the page where you have placed it. The "Save 1link" option is helpful
when your graphics takes up a great deal of memory, or when you
anticipate changing your graphic before your document reaches its
final draft stage. In this latter instance, the link will open the
revised graphic and insert it when you reopen your document.
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1.144 8-10

TEXT BLOCKS

You can use Final Writer’s text block feature to create short lengths of
text that are independent of the text in your document. Text blocks may
be moved anywhere on a page, resized, rotated, and modified.

TO CREATE A TEXT BLOCK:

1. Click the mouse on the "Text Block Tool" icon.

* %% See Fig 8-1 * K%

the "Text Block Settings" requester will appear.

* % K See Fig 8-8 * % K

2. In the area titled "Content" enter the text of the text block you are
creating.

3. Modify or define Text Flow Options, Distance, and Type Specs to suit
your needs, or use the settings as they are.

4. Click the mouse on the "OK" button.
Graphics and Text Blocks page 8-10
The text blocks will be drawn in the upper left hand corner of the
window. Now that the text block is drawn you can manipulate it just
as you do other graphic objects.
TO CHANGE THE TEXT OR SETTINGS USED IN A TEXT BLOCK:
1. Double-click the mouse on the text block.
The "Text Block Settings" requester will appear.
2. Make any desired modifications.

3. Click the mouse on the "OK" button.

The text block will be redrawn according to the new settings.

1.145 8-11

SELECTING OBJECTS

Final Writer treats all lines, boxes, ovals, images, and text blocks as
independent objects. In order to size, move, crop, delete, or redefine a
graphic you must first select it.

TO SELECT A SINGLE GRAPHIC:
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1. Click the mouse on the "Graphic Select" tool.

* %% See Fig 8-1 * K%

2. Click the mouse on the object you want to select.

* % Kk See Fig 8-9 * %k
Notice that "anchor points" (tiny boxes in the corner and midpoints
of the graphic) appear around or on the graphic. The presence of

anchor points indicates that the object has been selected.
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1.146 8-12

TO SELECT ONE OR MORE GRAPHICS BY DRAWING A MARQUEE:

1. Click the mouse on the "Select" tool.

* %% See Fig 8-1 * K%

2. Position the mouse pointer above and to the left of the first graphic

you want to select.

3. Hold down the left mouse button and drag the mouse to the right and
bottom of the last graphic you want to select.

* ko See Fig 8-9 * kK
As you drag the mouse the program will draw a marquee rectangle on
the screen. When you release the mouse, all graphics that fit within

the marquee will be selected.

4. Release the button.

1.147 8-12a

DELETING OBJECTS

Lines, boxes, ovals, images, and text blocks may be deleted at any time.

TO DELETE ONE OR MORE OBJECTS:

1. Select the object(s) you wish to delete.

2. Press the BACKSPACE or DELETE key, choose "Delete" from the
"Graphics" menu.

* %% See Fig 8-6 * %%

The selected graphic will be deleted.
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1.148 8-13

SIZING OBJECTS

A graphic already inserted in a document can be made smaller or larger
at any time. When you make an IFF ILBM or EPS smaller, it may appear to
lose resolution (dots) on the screen, but on printouts you probably won'‘t
lose any resolution.

TO CHANGE THE SIZE OF A OBJECT IN YOUR DOCUMENT:

1. Select the object to be sized.

2. Press and hold the mouse on one of the anchor points at the corners
or midpoints of the selected graphic.

3. Drag the mouse inward toward the middle of the graphic to reduce its
size. Drag the mouse outwards away from the middle of the graphic to
increase its size.

4. Release the mouse when the graphic has reached the desired size.

1.149 8-13a

CONSTRAINED SIZING OF IFF ILBM IMAGES

OPTION 1 If you hold the SHIFT key down while pressing on an IFF ILBM'‘s
anchor point and continue to hold it down while dragging the
mouse, Final Writer will keep the graphic'‘'s original
proportions intact.

OPTION 2 If you want an IFF ILBM to be sized to take maximum advantage
of your printer‘s resolution, hold down the LEFT CTRL,SHIFT, and
ALT keys while dragging the mouse on the lower right anchor
point. Since your printer‘'s aspect ratio is usually different
than a graphic‘'s original aspect ratio, this method of
constraining will produce an image that may look out of
proportion on your screen. It will, however, result in the best
printouts. This method of constraining is known as INTEGER
SCALING.

1.150 8-13b

"SNAP TO" SIZING

If you hold the CTRL key down while pressing on an anchor point, and
continue to hold it down while dragging the mouse. Final Writer will snap
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the size of the graphic to the nearest tick mark on the ruler.
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1.151 8-14

"QUICK" SIZING
If you want to reduce an image by 1/2, hold down the SHIFT key and
double-click the mouse on the image to be reduced. You can continue
reducing the image in this manner. Each time the image is reduced, it
will be by 1/2.
If you want to double the size of an image, hold the CTRL key and double

click the mouse on the image to be enlarged. Each time the image is
enlarged, its size is doubled.

1.152 8-14a

MOVING OBJECTS
A object can be moved anywhere within a document.
TO MOVE AN OBJECT FROM ONE LOCATION TO ANOTHER:

1. Select the object to be moved.

2. Click and hold the mouse button on the selected object while dragging
the mouse to the desired position.

1.153 8-14b

CONSTRAINED MOVING

If you hold the SHIFT key down while dragging the mouse Final Writer
will move the selected object either vertically or horizontally depending
upon your initial mouse movement.

1.154 8-14c

"SNAP TO" MOVING
If you hold the CTRL key down while dragging the mouse. Final Writer
will move a selected object so that its left/top is snapped to the
nearest tick mark on the ruler.

Graphics and Text Blocks page 8-14
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1.155 8-15

ROTATING OBJECTS

Any object created in final writer may be rotated. Since IFF ILBM and
EPS images are not created in Final Writer, they cannot be rotated. You
can rotate an object using a menu command, oOr you can rotate in real time
using the mouse.

TO ROTATE AN OBJECT USING A MENU COMMAND:

2.

* Kk %

Select the object to be rotated.
Select the desired rotation menu command.
See Fig 8-10 * % %
The "Rotate" sub-menu is used to rotate an object a specified number
of degrees from its current rotation. The "Rotate To" sub-menu is

used to rotate an object to a specific rotation regardless of the
object’s current rotation.

1.156 8-15a

TO ROTATE AN OBJECT USING THE MOUSE:

Select the object to be rotated.

Position the mouse over one of the selection anchors and hold down
the mouse button.

Press the LEFT ALT key and move the mouse in the direction you want
the object rotated.

When an object has been rotated it can be moved and rotated again, but
not resized. To resize a rotated object you must first set its rotation
to 0, resize the object, and then return the object to its rotated
position.

1.157 8-15b

TO RESIZE A ROTATED OBJECT:

2.

Select the object to be resized.
Choose "Other" from the "Rotate To" sub-menu.
See Fig 8-10 * % K
A requester will appear showing the current rotation amount.

Remember the rotation amount, replace the amount with "0", and click
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n OK n .
4. Resize the object.

5. Choose "Other" from the "Rotate To" sub-menu, enter the original
rotation amount, and click on "OK"

* %k See Fig 8-10 * %k
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MODIFYING AN OBJECT'S SETTINGS

1.158 8-16

An existing object can have its settings modified at any time. These
settings are the ones that comprise the settings requester for that
graphic.

TO MODIFY AN EXISTING OBJECT'S SETTINGS:

1. Click the mouse on the "Select" tool if it is not already selected.
2. Double-click the mouse on the object that is to be modified, or
click once on the object to be modified, and choose the appropriate

item from the "Settings" sub-menu of the "Graphics" menu.

Final Writer will display the settings requester for the object
along with the data that is currently being used for it.

3. Change any of the settings you wish to change.

4. When you are finished making changes, click on the "OK" button.

1.159 8-16a

SPECIFYING EXACT SIZE AND LOCATION

An alternative way of sizing and moving graphics with the mouse is to
use the "Position" requester. This requester is accessed while in one of
the settings requesters. Access to the "Position" requester is only
possible when viewing an object ‘s "settings" requester.

TO SPECIFY EXACT SIZE AND/OR POSITION SETTINGS:

1. If the object's settings requester is not already on the screen:

A. Click the mouse on the "Select" tool if it is not already
selected.

* kK See Fig 8-1 * Kk
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B. Double-click the mouse on the object that is to be modified, or
click once on the object to be modified, and choose the
appropriate settings item from the "Graphics" menu.

Final Writer will display the selected object‘'s settings requester
along with its definition data.

Graphics and Text Blocks page 8-16
2. Click on the "Position" button.

The "Position" requester will be displayed showing the graphic'‘s
exact size and position.

* %% See Fig 8-11 * % %

3. Modify the size and position data to your desired values.

4. When you are finished making changes, click on the "OK" button.
The program will return to the settings requester.

5. Click on the "OK" button.

Final Writer will redraw the selected graphic using the new values.

1.160 8-17

CROPPING IMAGES
Cropping is the process of cutting out unwanted portions of an IFF ILBM
or EPS image. The cut portions are limited to rectangular areas on the
left, top, right, or bottom of the graphic. An image inserted in a
document can be cropped at any time.
TO CROP AN IFF ILBM OR EPS IMAGE:

1. Choose the "Crop" tool from among the tool icons in the ruler at the
top of your window.

* %% See Fig 8-1 * K%
2. Click the mouse on the image you want to crop.
Anchor points will appear.

3. Press and hold the mouse on one of the anchor points in the corners
or midpoints of the selected graphic.

4. Drag the mouse to crop the area of the graphic the anchor point is
in.

Graphics and Text Blocks page 8-17
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5. Release the mouse when you have cropped the desired amount of the
graphic.

TO RESTORE AN IMAGE TO ITS UN-CROPPED SIZE:

1. Select the image to be restored.

2. Press the ALT key and while holding it down double-click the mouse on
the image.

1.161 8-18

CANCELLING GRAPHIC ACTIONS

You can cancel a size, move, or crop operation by pressing the right
button before releasing the left mouse button.

1.162 8-18a

GROUPING OBJECTS

Many times it is convenient to group more than one object together. A
group of objects can be selected, moved, rotated, and resizing all
together, rather than each object separately.

TO GROUP OBJECTS:

1. Select the objects that are to be grouped.
2. Choose "Group" from the "Graphics" menu.

TO UNGROUP OBJECTS:

1. Select the group to be ungrouped.
2. Choose "Ungroup" from the "Graphics" menu.
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1.163 8-19

GRAPHICS COLOUR VS SCREEN COLOURS VS PRINTED COLOURS

Final Writer tries to print in the colours in which they were defined.
However, when graphics are displayed on the screen they probably will not
be drawn in their true colours. When rendered on the screen, a graphic's
colours are changed to the colours that are currently available. If you
are using a Final Writer custom screen, for example, only four colours
(Black, White, Grey, and Blue/Grey) are available. So no mater what
colour you define for a graphic, that colour will be modified to one of
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the colours used in the screen.

If you are using Workbench 2.0 or higher, you can set the

colours used for the Workbench to more than 4 colours.

you set your Workbench to 8 colours, and open Final Writer
screen, 8 colours will be used to show graphics on screen.

number of
example, if

on a Workbench
The downside

to this is that when you increase the number of colours for the Workbench

screen, the screen display may slow down.

When the "Graphic Select" tool is selected, and you hold the mouse down

on a graphic (does not apply to IFF ILBM or EPS image),

the colours of

the mouse pointer will change to reflect the graphic'‘'s colour.
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1.164 9-0

9 PERFECTING A DOCUMENT

USING THE SPELLER

Word Verify mode . ...t iiiiieeeeennneeennn 9-2
Document Scan Mode ........iiiiiiiiiinnnnn. 9-3
Correcting spelling €rrors ........cceeeeeennn. 9-4
Correcting from the keyboard ........... 9-4a
Asking for spelling suggestions ........ 9-4b
Using the ’'Alternatives’ list .......... 9-5
SKkipping @ Word ... ve ittt eeeeeeeennennn 9-5a
Adding WOTrdS v i ittt it ittt et e 9-6
Deleting words . ...ttt ittt 9-6a

USING THE THESAURUS
Using the thesaurus .........cuiiiiiitinnnnnn 9-17

OBTAINING DOCUMENT STATISTICS
Obtaining document statistics ............... 9-8

1.165 9-1

PERFECTING A DOCUMENT

Now that you have created, edited, and formatted your document, it'‘s
time to turn to Final Writer's speller, thesaurus, and statistics feature

to help make your document as perfect as possible.

In this section, you will learn how to

% USE THE SPELLER - Includes information on checking a document,
obtaining spelling suggestions from Final Writer,
and working with your own personalized user

dictionary.

* USE THE THESAURUS - Final Writer allows you to obtain lists of




113/239

synonyms for words in your document.

* OBTAIN STATISTICS - Once your document is complete, you may
instruct Final Writer to count its various
elements, Including characters, words, lines,
sentences, paragraphs, and pages. Averages are
also provided.

Perfecting a Document Page 9-1

1.166 9-2

USING THE SPELLER

Final Writer's built in spelling detector will scan your document for
words it does not recognize and give you the opportunity to revise the
spelling. Final Writer'‘s spelling corrector will provide spelling
suggestions for words that it flags as possible misspellings.

All spelling functions are accessed through the "speller" requester.
Once the speller requester is open, it can be moved to any place on the
screen, or depth arranged behind a document window.

There are two ways the speller can be used: "Word Verify" mode, and
"Document Scan" mode. In "word Verify" mode you instruct the speller to
verify a single word in your document text. In "Document Scan" mode, you
instruct the speller to scan a document starting at the insertion point,
and continue until the end of the document or until you tell it to stop.

"WORD VERIFY" MODE

When checking a single word, the speller will check and word that you
have selected. If you have selected more than one word, the speller will
only check the first word in the selected range.

TO CHECK A SINGLE WORD IN YOUR DOCUMENT:

1. Double-click the mouse in the word to be verified.

* Kk See Fig 9-1 * % *

2. Choose "Speller ..." from the "Tools" menu.

Perfecting a Document Page 9-2

The "Speller" requester will appear and the word is verified. The
speller will display a message indicating whether or not the word is
spelled correctly.

* Kk See Fig 9-2 * % *

If the word is not spelled correctly, you can use any of the

"Speller" requester'‘s options for obtaining suggestions or adding the

word to your user dictionary.
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3. Click the mouse in the "Seller" requester’s close box when you are
finished using it.

1.167 9-3

"DOCUMENT SCAN" MODE

When scanning a document, the speller will start at the position in the
document where the insertion point is.

TO BEGIN A DOCUMENT SPELL CHECK:
1. Set the insertion point where you want the spell check to begin, and
choose "Speller ..." from the "Tools" menu.

The "Speller" requester will appear on the screen.
2. Click on the "Spell" button.

The spell check will begin at the insertion point, wrapping around if
necessary to examine the entire document for errors. As they are
found, potentially incorrect words will be highlighted in your
document, and the highlighted word will appear in the "Word" data
entry area of the "Speller" requester. A message indicating the
potential error simultaneously appears in the "Alternatives" section
of the requester.

Perfecting a Document Page 9-3

1.168 9-4

CORRECTING SPELLING ERRORS

Once a potential error has been identified Final Writer offers you
several ways in which to correct it. You may enter the replacement from
the keyboard, ask Final Writer to provide a list of potential
alternatives from which to choose, or you may skip a word that has been
incorrectly flagged by the spell checker. Please remember that if you
have turned on the "Auto Suggest" feature in the "Speller Preferences"
requester, spelling alternatives will be provided automatically for every
flagged word.

In any of these correction scenarios, the spell checker will
automatically resume its document scan after the revision has been made.

1.169 9-4a
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TO CORRECT AN ERROR FROM THE KEYBOARD:

1. Click the mouse in the data entry area next to "Change To", and type
in the correct word.

* kK See Fig 9-3 * Kk

2. After verifying that the word you have typed in appears as you wish
it to, click on the "Replace" button.

The original highlighted word in your document text will be replaced
with the characters you typed.

1.170 9-4b

TO ASK FOR SPELLING SUGGESTIONS:
1. After the word has been highlighted on he screen, click on the
requester ‘s "Suggest" button.

A list of correctly spelled alternatives will appear in the
"Alternatives" section of the requester. The first word in the list
is the one the spell checker considers the most likely replacement
for the word highlighted in your document. This most likely word will
automatically appear in the "Change To" data entry area.

Perfecting a Document Page 9-4

* Kk See Fig 9-4 * % x

2. If the spell checker's most likely alternative is not the correct
replacement, you may examine the remainder of the list. If the list

is lengthy, use the scroll bar to move through the remaining
alternatives.

1.171 9-5

TO MAKE A CORRECTION USING THE "ALTERNATIVES" LIST:

1. Once you have determined which of the alternatives is the correct
replacement, select that word by clicking the mouse on it.

The word you selected will appear in the "Changes To" data entry area
in the requester.

2. Click on the requester‘'s "Replace" button.

The highlighted word in your document will be replaced with the
alternative word you selected.
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1.172 9-5a

TO IGNORE A WORD THE SPELLER THINKS IS MISSPELLED:

1. Determine if the word highlighted by the spell checker is actually
spelled correctly.

Final Writer‘'s spell checker will automatically flag any word that
does not appear in the main or user dictionaries. It is always a
good idea to verify the correct spelling of such words before
skipping the word.

2. Click on the requester‘'s "Skip" button.

The spell checker will automatically skip over other instances of the
same word as long as the "Speller" requester is open.
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1.173 9-6

ADDING WORDS

Final Writer flags words as possible misspellings when it cannot find
them in either the main or user dictionary. You can add any word to the
user dictionary so it will not be flagged again.

TO ADD A WORD TO THE USER DICTIONARY DURING A SPELLING CHECK:

1. Verify that the highlighted word is spelled correctly and that it
should be added to the user dictionary.

2. Click on the requester‘s "Add" button.

The word will be added to the user dictionary. If you are examining
your entire document for errors, the spell checker will automatically
continue its scan. All future instances of the word will be verified
against the spelling you have entered in the user dictionary. The
word will only be highlighted in the future if it does not match the
entry in the user dictionary.

1.174 9-6a

DELETING WORDS

You can delete words from the user dictionary when you no longer want
that word to be accepted as a correctly spelled word.

TO DELETE A WORD FROM THE USER DICTIONARY:

1. Click on the requester‘s "User" button to bring up the list of words
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in the user dictionary.

The list will appear in the "Alternatives" section of the requester.
2. Click on the word to be deleted.
* Kk See Fig 9-5 * Kk
3. Click on the "Delete" button.
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1.175 9-7

USING THE THESAURUS

Final Writer‘'s thesaurus is a tool that helps you find the best word for

given situation. The thesaurus gives a list of synonyms for words you
specify.

TO USE THE THESAURUS FOR A WORD IN THE DOCUMENT:

1. Double-click on the desired word.

2. Choose "Thesaurus ..." from the "Tools" menu.

* Kk See Fig 9-6 * % *
The "Thesaurus" requester will appear on your screen. Notice that a
selected word appears in the "Word" data entry area, and that a
number of alternatives are listed.

* % K See Fig 9-6 * kK

3. Review the list, using the scroll bars if necessary.

4. If you like to view additional lists of alternatives, click on any
word in the current list, then click on the "Find" button.

A new list of definitions and synonyms will appear.

5. Once you have found the desired word to replace the selected word in
your document, click on that word in the list.

6. Click on the "Replace" button.

The selected word in your document will be replaced with the word
from the list.

Perfecting a Document Page 9-7

1.176 9-8
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OBTAINING DOCUMENT STATISTICS

Final Writer‘s document statistics feature is helpful if you are writing
a document that has certain limitations on the number of words.

TO OBTAIN DOCUMENT STATISTICS:

1. Choose "Statistics" from the

* %k See Fig 9-7 * %k k

The "Document Statistics" requester will appear on your screen.

* %k See Fig 9-7 * %k
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NOTES
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1.178 10-1

10 SECTIONS

This chapter describes Final Writer sections including how to divide a
document into sections, how to specify page layout settings for
individual sections, and how to create special sections such as Table of
Contents, Table of Illustrations, Endnotes, Bibliography, Index, and
Outline

Sections Page 10-1
SECTIONS

A section is part of a document that consist of text and page settings
that are different from other parts of the document. For example, if you
are writing a novel, you might want to place each individual chapter in
its own section. Even if you are not writing a novel, you can use
sections to go from one page layout setting to another within the same
document. For example, you might change some of the following settings
for each section in a document:

Number of columns

Page number prefix

Page number format
Master page items
Header and footer areas
Edit area margins

% % ok X ot

Final Writer sets up one section automatically when you begin a new
document. If you do not intend to use multiple sections, section setting
and text entered will be consistent for the entire document. If you do
not wish to use multiple sections in your document, think of the entire
document as a single section.

When using multiple sections, text from one section can not flow into
another. in other words, when you enter text a the end of a section, the
section simply gets bigger —-- the text does not go into the next section.
Furthermore, you can only edit and view one section at a time.

1.179 10-2

SPECIAL SECTIONS

Some of the section types that can be created in Final Writer are called
"special sections". Special sections are ones the Final Writer generates
for you, as opposed to you creating the text for the section yourself.
Special sections in Final Writer include:

Outline

Table of Contents
Table of Illustrations
Endnotes

Bibliography

P S T
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Creating special sections is described later in this chapter.

Section Page 10-2

1.180 10-3

NORMAL SECTIONS

Normal sections are those in which you enter text. The three types of
normal sections are:

*

Title Page
Preface
Main

*

>*

A document can have more than one "Main" section, but it can only have
one of each of the other section types. For example, your documents might
be an instruction book consisting of the following sections:

Title Page
Preface

Table of Contents
Chapter 1 (Main)
Chapter 2 (Main)
Chapter 3 (Main)
Index

I

The manner in which Final Writer positions sections within a document is
consistent with the way you would expect certain section types to appear
in a Main section and decide to create a Title Page section, Final Writer
will automatically place the title Page section before the Main section.

1.181 10-3a

CREATING A NEW SECTION

The process of starting a new section depends on whether it is a special
section or a normal section. Special sections such as Index, Table of
Contents, etc., are generated by Final Writer using information you have
set up in your document. The creation of special sections will be
described later in this chapter. The following are instructions for
beginning a normal section.

TO BEGIN A NEW TITLE PAGE, PREFACE, OR MAIN SECTION:
1. Choose the desired section type from the "New Section" sub-menu.

* Kk See Fig 10-1 * kK

Sections Page 10-3
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1.182 10-4

GOING FROM ONE SECTION TO ANOTHER

In Final Writer you may edit and view one section at a time. The
vertical scroll bar which you use to move through text will only let you
move within the current section.

TO ACCESS A DIFFERENT SECTION THAN THE ONE YOU ARE WORKING IN:

1. Choose the section you want to access from the "Go To Section" sub-
menu.

* ko See Fig 10-2 * % Kk
NOTE. The "Go To Section" sub-menu will consist only that already

exists in your document. You can not begin a new section using the
"Go To Section" command.

1.183 10-4a

DELETING A SECTION

You can remove all but the first "Main" section from your document at
any time. When you delete a section, Final Writer deletes all text and
graphics that you are deleting, you should copy the text or graphics to a
different section.

TO DELETE A SECTION:

1. Choose the section you want to delete from the "Remove Section" sub-
menu.

* Kk See Fig 10-1 * kK

1.184 10-4b

PRINTING SECTIONS

When you print a document you can print one section at a time or all
sections. Final Writer will print multiple sections in order in which
they exist in your document . Refer to Chapter 11 of this manual,

Printing a Document, for details on printing.

Sections Page 10-4

1.185 10-5
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SECTION TYPES

The remainder of this chapter describes the types of sections you can
create in Final Writer. Remember that each section can have its own page
layout settings. For example, your Table of Contents might have 2
columns, your Main sections 1 column, and your Index 3 columns.

TITLE PAGE

Final Writer will position the Title Page section page of your document.
Use this section for titles of papers, stories, novels, etc. Title Page
sections use the same set of paragraph styles as Main sections. You are
responsible for entering any text and graphics that need to appear in
your title Page section.

1.186 10-5a

PREFACE

Use the Preface section to introduce your document. A Preface is usually
a statement or essay that introduces a book and explains its scope,
intention, or background. Final Writer will place the Preface section
after any Title Page section. You can use the same set of paragraph
styles for a Preface section that you use for Main and Title Page
sections. You are responsible for entering any text and graphics that
need to appear in your Preface section.

1.187 10-5b

MAIN

Use Main sections for the body of your document. You can create as many
Main sections as you want for a document. Typically you would use Main
sections for different chapters of a book or paper. You can also use Main
sections simply as a way of changing page layout and/or master pages
within the same document. Final Writer places all Main sections together
after any title Page or Preface sections. Paragraph styles created for
one Main section are shared with other Main sections, as well as Title
Page and Preface sections.

Sections Page 10-5

1.188 10-6

OUTLINES

An Outline section is a summary of a document analysed in headings and
subheadings. To produce an outline of your document you are required to:
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* Define which Main section paragraph styles you want to trigger the

creation of an outline entry. You do this by assigning an outline
level to the style. For complete information on paragraph styles see
Chapter 7.

Create your document and assign the appropriate Main section paragraph
style to each paragraph that you want in your outline.

* %% See Fig 10-3 * %%

When Final Writer creates an outline, it scans a document looking for
paragraphs that are supposed to generate an outline entry. When it finds

one of these paragraphs it creates an outline entry prefixing the
paragraph's text with a sequential letter or number that is determined by
the level being created and where the entry falls sequentially within the
outline. It formats the outline entry according to the Outline section's
paragraph style corresponding with the level being created. Typically you
would set up Main section paragraph for topics, headings, and sub-
headings in such a way as to generate an outline in the order these items
should appear in an outline. For example, if you look at the default
paragraph styles Final Writer uses, you will see the following styles and
their outline assignments:

STYLE NAME OUTLINE ASSIGNMENT
Section Name Level 1
Topic Name Level 2
Sub Topic 1 Level 3
Sub Topic 2 Level 4

Sections Page 10-6

An example of an outline created using the above styles is:

1.

Section Name
A. Topic Name
B. Topic Name
1. Sub Topic 1
2. Sub Topic 1
a. Sub Topic 2
b. Sub Topic 2
3. Sub Topic 1
C. Topic Name

You can assign one of 8 outline levels to any Main section paragraph
style. In the above example only 4 levels of outline are used. You can
also modify the outline section'‘s paragraph styles to suit your needs.

TO SET UP A DOCUMENT SO AN OUTLINE CAN BE CREATED:

Either use Final Writer'‘s default styles with outline levels already
assigned, or create your own.

Create your document, and whenever you enter a paragraph such as a
heading or topic name, assign it one of the paragraph styles that has
been set up to generate an outline entry level.
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TO CREATE AN OUTLINE:

1. Choose "Outline ..." from the "Tools" menu.

* %% See Fig 10-4 * % %
The "Outline" requester will appear.

* Kk See Fig 10-4 * % K

2. Make whatever settings you want in the requester and press "OK".
Final Writer will create and then display the outline section.

Sections Page 10-7

1.189 10-8

TABLE OF CONTENTS

The Table of Contents is a list of your document ‘s headings and
subheadings and includes page numbers where these items appear in the
document. To produce a Table of Contents you are required to:

* Define which Main section paragraph styles you want to trigger the
creation of a Table of Contents entry. You do this by assigning a
Table of Contents level to the style. For complete information on
paragraph styles see Chapter 7.

* Create your document and assign the appropriate Main section paragraph
style to each paragraph that you want in your Table of Contents.

* %% See Fig 10-3 x %%

When Final Writer creates a Table of Contents, it scans a document
looking for paragraphs that are supposed to generate a Table of Contents
entry. When it finds one of these paragraphs it creates a Table of
Contents using the paragraph'‘s text along with the page number the
paragraph is on. It formats the outline entry according to the Table of
Contents section‘s paragraph style corresponding with the level being
created. Typically you would set up Main section paragraph for topics,
headings, and sub-headings in such a way as to generate a Table of
Contents in the order of importance these items are to appear. For
example, 1if you look at the default paragraph styles Final Writer uses,
you will see the following styles and their Table of Contents

assignments:
STYLE NAME TABLE OF CONTENTS ASSIGNMENT
Section Name Level 1
Topic Name Level 2
Sub Topic 1 Level 3
Sub Topic 2 Level 4

Sections Page 10-8
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An example of a Table of Contents created using the above styles is:

Section Name
Topic Name
Topic Name
Sub Topic 1
Sub Topic 1
Sub Topic 2
Sub Topic 2
Sub Topic 1
Topic Name

g b W w w wN -

You can assign one of 8 levels of Table of Contents to any Main section
paragraph style. In the above example only 4 levels are used. You can
also modify the Table of Contents section‘s paragraph styles to suit your
needs.

TO SET UP A DOCUMENT SO A TABLE OF CONTENTS CAN BE CREATED:

1. Either use Final Writer'‘'s default paragraph styles with Table of
Contents levels already assigned, or create your own.

2. Create your document, and whenever you enter a paragraph such as a
heading or topic name, assign it one of the paragraph styles that has
been set up to generate a Table of Contents entry level.

TO CREATE A TABLE OF CONTENTS SECTION:

1. Choose "Iable of Contents ..." from the "Tools" memu.

* %% See Fig 10-5 * %%

The "Table of Contents" requester will appear.
* %% See Fig 10-5 * %%
2. Make whatever settings you want in the requester and press "OK".

Final Writer will create and then display the outline section.
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1.190 10-10

TABLE OF ILLUSTRATIONS

A Table of Illustrations section consists of a list of graphics and
image objects in your document, along with the page numbers on which
these objects appear. To produce a Table of Illustrations, you are
required to assign titles to all graphics and imported images within your
document that you want referenced in the Table of Illustrations.

When Final Writer creates a table of Illustrations, it scans a
document ‘s graphics and imported image objects looking for objects
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containing an "Illustration Title". When it finds one of these objects it
generates a Table of Illustrations entry using the "Illustration Title"
text along with the page number the object appears on.

TO INDICATE THAT A GRAPHIC OR IMPORTED IMAGE IS TO APPEAR IN
THE TABLE OF ILLUSTRATIONS:

1. Access the object's "Settings" requester by either
1) double-clicking the mouse on an object

2) selecting the object and choosing the appropriate item from the
"Settings" sub-menu.

* %% See Fig 10-6 * %%
See Chapter 8 for more information on the "Settings" requester

2. Enter the title or name of the object in the requester'‘s
"Tllustration Title" data entry area. If you do not enter anything in
this area, the object will not be included in the Table of
Illustrations.

TO CREATE A TABLE OF ILLUSTRATIONS SECTION:

1. Choose "Table of Illustrations ..." from the "Tools" menu.

*x % See Fig 10-6 x %%
The "Table of Illustrations"™ requester will appear.

* %% See Fig 10-6 * %%

2. Make what ever settings you want to in the requester and press "OK".

Final Writer will create and display the section.
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1.191 10-11

ENDNOTES

Endnotes are bibliographical information linked to a source and placed
at the end of the document. Final Writer creates the Endnotes section
using endnotes text you enter as you insert endnotes into your document.
The endnotes section is always placed after the last Main section in your
document.

TO INSERT AN ENDNOTE IN YOUR DOCUMENT:

1. Set the insertion point (click the mouse) in your document where you
want to insert an endnote.

2. Choose "Insert .." from the "Endnotes" sub-menu.
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* ko See Fig 10-7 * %k
Final Writer will display the "Insert Endnote" requester.
* kK See Fig 10-7 * kK

3. Click the mouse in the text rectangle so that you see an insertion
point, and enter the text for the endnote.

* kK See Fig 10-7 * kK

4. Click on the "OK" button.

Final Writer will save the endnote text and place an endnote marker
in your document at the insertion point is. The marker is a number
whose value depends upon where the endnote‘s location is in relation
to other endnotes in the document. Final Writer will automatically
calculate which number to use.

Endnotes that you have inserted into a document may be edited or viewed
at any time using the "Edit Endnotes" requester. Formatted endnotes only
appear when you create the Endnotes section.

TO ACCESS THE "EDIT ENDNOTES" REQUESTER:

1. Choose "Edit ..." from the "Endnotes" sub-menu.

* kK See Fig 10-8 * kK

Final Writer will display the "Edit Endnotes" requester.
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TO EDIT AN EXISTING ENDNOTE:

1. In the list titled "List of Endnotes" click the mouse on the line
that contains the endnote to be edited.

* Kk See Fig 10-8 * Kk

Final Writer will enter the complete text of the selected endnote in
the data entry area titled "Endnote Text".

2. Click the mouse in the area of the endnote text where you want to
begin editing.

3. When you are finished editing, click on the "Save" button.

4. Repeat steps 1-3 for each endnote you wish to edit.

TO REMOVE AN ENDNOTE FROM A DOCUMENT:
1. Choose "Create ..." from the "EndNotes" sub-menu. |

* %k See Fig 10-9 * Kk

The "Endnotes" requester will appear.
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* Kk See Fig 10-9 * Kk
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2. Make whatever settings you want to in the requester and press "OK".

Final Writer will create and display the Endnotes section.

The "Marker", "Indent", and "Format" settings in the endnotes. The
"Indent" settings defines the amount of white space that is to appear
between the endnote marker and the endnote text. "Marker" and "Format"
settings are as follows:

MARKER OPTIONS

Superscript
7 Ibid., p. 223

Normal
7. Ibid., p. 223.

FORMAT OPTIONS:

Flush Left

1. John E. Warriner and Francis GRIFFITH, English
Grammar and Composition (New York: Harcourt

Brace Jovamovich, 1977), p. 208.

2. Ruth I. Anderson et al., The administrative
Secretary: Resource (New York: McGraw-Hill, 1970),
p. 357.

Flush and Hang

1. John E. Warriner and Francis Griffith, English
Grammar and Composition (New York: Harcourt
Brace Jovamovich, 1977), p. 208.

2. Ruth I. Anderson et al., The administrative
Secretary: Resource (New York: McGraw-Hill, 1970),
p. 357.

Indented

1. John E. Warriner and Francis GRIFFITH, English
Grammar and Composition (New York: Harcourt
Brace Jovamovich, 1977), p. 208.

2. Ruth I. Anderson et al., The administrative
Secretary: Resource (New York: McGraw-Hill, 1970),
p. 357.
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1.192 10-14

BIBLIOGRAPHY

Use Final Writer'‘s bibliography feature to create a list of all works
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you have found relevant in writing a document. Final Writer places your
Bibliography after the Endnotes section and before the Index section. You
can create and/or edit Bibliography entries at any time during the
creation of a document. Final Writer will save your entries with the
document. When you instruct the program to create the Bibliography, Final
Writer will create the Bibliography section consisting of your entries
automatically arranged in alphabetical order. Bibliography entries are
added, edited, and deleted using the "Edit Bibliography Entries"
requester.

TO ACCESS THE "EDIT BIBLIOGRAPHY ENTRIES" REQUESTER:
1. Choose "Add/Edit ..." from the "Bibliography" sub-menu.
* %% See Fig 10-10 * %%
Final Writer will display the "Edit Bibliography Entries" requester.
* %% See Fig 10-10 * %%
TO ADD A NEW BIBLIOGRAPHY ENTRY:
1. Click the mouse in the data entry area titled "Bibliography Entry".
After you click the mouse you should see an insertion point.

2. Enter the text for the entry and press the ??Save"” button.

Final Writer will add the new entry to the list of bibliography
entries it keeps for your document.

Sections Page 10-14
TO EDIT AN EXISTING ENTRY:

1. In the list titled "List of Entries", click the mouse on the line
containing the entry you wish to edit.

Final Writer will copy the full text of the entry into the data entry
area.

* Kk See Fig 10-11 * kK

2. Set the insertion point (click the mouse) where you want to edit,
make your edits, and press the "Save" button.

Final Writer will replace the old text with the new text.
TO DELETE AN EXISTING ENTRY:

1. In the list titled "List of Entries", click the mouse on the line
containing the entry you wish to delete.

2. Click on the "Delete" button.

TO CREATE THE BIBLIOGRAPHY SECTION:
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1. Choose "Create ..." from the "Bibliography" sub-menu.
* %% See Fig 10-12 * %%

Final Writer will display the "Bibliography" requester.
* % * See Fig 10-12 * %

2. Make any settings you want to make in this requester and click on the
"OK" button.

Final Writer will create the Bibliography section by arranging your
entries in alphabetical order.

Sections Page 10-15

1.193 10-16

INDEX

Final Writer'‘'s index feature makes it very easy to create an excellent
index for your document. You can index the current word, a phrase, or all
words in a selected range. If what you index is on more than one page,
Final Writer will automatically add those pages to the index. When you
ask Final Writer to create your index, the program scans the document
looking for every occurrence of the entries you have indexed. It formats
the index in the Index section, and places this section as the very last
one in the document.

TO INDEX A WORD

1. Set the insertion point (click the mouse) on or before the word you
want to index.

2. Choose "Insert Word" from the "Index" sub-menu.
* %% See Fig 10-13 * %%
Final Writer will add the word to a list of indexed words.

TO INDEX A PHRASE OR WORDS AS ONE INDEX ENTRY:
1. Select the text that want to index as ome entry.
2. Choose "Insert Selection" from the menu.

* %% See Fig 10-13 * %%

TO INDEX ALL WORDS IN A SELECTED RANGE:
1. Select the text that you want indexed.

2. Choose "Insert Word(s)" from the menu.

* %% See Fig 10-13 * %%
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Final Writer will scan the selected range of text for words. Every
time it finds a word or number it will add the word to the list of
indexed entries.

You can edit or delete indexed entries at any time. Indexed entries are
edited and deleted from the "Edit Index Entries" requester.

TO ACCESS THE "EDIT INDEX ENTRIES" REQUESTER:
1. Choose "BAit ..." from the "Index" sub-menu.
* Kk See Fig 10-14 * K x
Final Writer will display the requester.
Sections Page 10-16
* %% See Fig 10-14 * %%
TO EDIT AN INDEX ENTRY:

1. In the list titled "Index Entries" click the mouse on the entry you
want to edit.

2. Change the entry to whatever you want it to be and click on the
"Save" button.

Final Writer will replace the old entry with the edited one.
TO DELETE AN INDEX ENTRY:

1. In the list titled "Index Entries" click the mouse on the entry you
want to delete.

2. Click on the "Delete" button.
Final Writer will remove all words from the list of indexed entries.
TO CREATE THE INDEX SECTION:
1. Choose "Create ..." from the "Index" sub-menu.
* kK See Fig 10-15 * %k
The "Index" requester will appear.
* %% See Fig 10-15 x %%

2. Make any settings you want to make and click on "OK".

Sections Page 10-17

1.194 10-18
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UPDATING SPECIAL SECTIONS

Final Writer creates the contents of the Outline, Table of Contents,
Table of Illustrations, Endnotes, Bibliography, and Index sections. If
you have already created one or more of these special sections, and then
modify the document so that these special sections need to be updated,
you will need to instruct Final Writer to create the section again. When
the program creates the section again, it will remove anything that is
already in it. For example, if you have created an Index section, and
then added pages in the middle of the document, the Index is now probably
invalid. To update the index to reflect the new status of the document,
simply instruct Final Writer to create the Index section. When it creates
the Index section again, it will remove the old Index section
automatically.

WARNING, you can modify any text that Final Writer creates in a special
section, but if you make modifications to your to your document that

force you to create a new special section, you will lose all
modifications you made within the special section.

1.195 10-18a

REFORMATTING SPECIAL SECTIONS
Final Writer formats all text within the Outline, Table of Contents,
Table of Illustrations, Endnotes, Bibliography, and Index sections by
using paragraph styles assigned to the respective section. By redefining
these paragraph styles you can reformat existing sections or change the
format of sections to be created.
Sections page 10-18
NOTES. ..

Blank Page
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PRINTING A DOCUMENT

Now that your document has been created,
perfect in ever way, it is time to print.

revised, formatted, and made
This chapter includes all the

information you will need to print your document successfully.

Printing a Document Page 11-1

PRINTING A DOCUMENT
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Final Writer provides two ways of printing: draft, and final.

DRAFT - In draft mode the program uses the built-in mono-spaced font of
your printer to produce output. Draft mode is used primarily for
quick printouts of your text during proofing. In draft mode all
graphics, headers, footers, and formatting are ignored. You can
set margins to be used for draft printing, but these are used
only in printing - not on the screen.

FINAL - In final mode the program prints a document exactly the way it
appears on the screen. Final mode printed to a graphic printer

is slower. Final mode always results in the best output a
printer is capable of.

1.198 11-2

HOW TO PRINT A DOCUMENT

Printing a document is simple, however it is necessary to ensure that
your computer is prepared to print - this includes installing and
selecting the appropriate printer driver. In addition, you may want to
modify some Final Writer'‘s print settings to suit your needs.

TO PRINT A DOCUMENT:

1. Choose "Print" from the "Project" menu.

* Kk See Fig 11-1 * % K

The "Print Document" requester will appear.
* Kk See Fig 11-2 * % K

2. Modify any settings you wish to change.

Refer to the next section for full details on settings that can be
modified in the "Print Document" requester.

3. Click on the "Print button.

Printing a Document Page 11-2
If you are printing to a PostScript file, a requester will appear
prompting you for the name of a file to write the PostScript
information to.

* % K See Fig 11-2 * %k
Supplied in the requester will be a default name. You can either use

the default name, change the name in the requester, or use the
"Choose" button to specify a name via a file requester.
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HOW TO STOP PRINTING

While a document is being printed, the program will display the
"Printing Document" requester. You can cancel or stop printing while
printing is occurring as long as this requester is on the screen.

TO STOP PRINTING:

1. Click on "Stop" in the "Printing Document..." requester.

Information in the print buffer will still be printed, but no more
information will be sent to the printer by the program.

1.200 11-3a

THE "PRINT DOCUMENT" REQUESTER

Final Writer provides considerable flexibility in the producing printed
output. The options and settings that are available via the "Print
Document" requester can be modified to suit your needs. When the "Print
Document" requester is displayed, all options are set to either their
default values, values that you have saved, or values from your last
print.

TO ACCESS THE "PRINT DOCUMENT" REQUESTER:

1. Choose "Print ..." from the "Project" menu.

* Kk See Fig 11-1 * % Kk
If you have not specifically saved the "Print Document" requester'‘'s
settings, the settings displayed will be the program‘'s default values
set by SoftWood. If you have saved the "Print Document" requester'‘s
settings, those settings will be the program'‘'s default values, and
will be shown in

Printing a Document Page 11-3
the "Print Document" requester. Some settings may be carried over
from a previous printing as long as the document has not been closed
since the last time it was printed.

* Kk See Fig 11-2 * % K

Below are descriptions of the settings found in the "Print Document"”
requester, and how you can use them.

1.201 11-4
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COPIES

PREFERENCES

SECTIONS

Enter the number of copies of your document that you
want printed in the "Copies" data entry area.

Click on these buttons to access additional print
options. These options are discussed in later sections
in this chapter.

If your document has more than just one section, or the
entire document. This popupmenu is used to indicate y
your choice.

* %k See Fig 11-3 * %k

PAGES

COLLATE

Clicking on the button preceding "All" will cause Final
Writer to print your document in its entirety. If you
only want a certain range of pages to print, click on
the button preceding "Ranges" and enter the first and
last pages of your desired range in the data entry
areas under the words "From" and "To".

This option defines which pages are printed when
printing in Final print mode. Normally you will use the
"Al1l" setting. If you are printing two-sided pages, you
can use the "Odd only" option to print pages 1,3,5,
etc., turn the printed pages over, and then use the
"Even only" option to print pages 2,4,6, etc.

* % K See Fig 11-3 * kK

Printing a Document Page 11-4

1.202 11-5

ORDER

— This option is used to specify the order in which pages

of your document are printed when printing in Final
print mode.

* Kk See Fig 11-3 * kK

PRINT TO

— This option specifies where Final Writer is to print.

If you are printing to a printer, you will either
specify Graphic Printer or PostScript Printer. If you
are saving PostScript data to a disk file so you can
take someone who has a PostScript printer, you should
use the "PostScript File" option. See "PostScript
Printing" later in this chapter for more information.

* Kk See Fig 11-3 * kK

PAPER FEED

— This option defines the way your printer handles paper.

Laser printers and printers with sheet feeders are
specified as "Single Sheet": otherwise use
"Continuous".
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* ko See Fig 11-3 * kK

SET DEFAULT - Check this if you want the "Print Document" requester's
settings to be saved as the program‘s default values.

* ko See Fig 11-3 * kK

1.203 11-5a

GRAPHIC PREFERENCES

Settings that affect Final Mode printing on a graphic (non PostScript)
printers are found in the "Graphic Final Preferences" requester.

TO ACCESS THE "GRAPHIC FINAL PRINT PREFERENCES" REQUESTER:
1. Click on the "Graphic" button in the "Preferences" section of the
"Print Document" requester.

* %k See Fig 11-4 * %k
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Below are descriptions of the settings in the "Graphic Final Print
Preferences" requester:

PRINTER DRIVER - The name of the printer driver you have installed is
displayed here. You install a printer driver from the
Workbench Preferences, not Final Writer.

DENSITY — Graphic printers print by creating images out of a
series of dots. Density is a term used to describe the
quantity of graphic dots in a given space on the
printed page. Different printers have different
densities. Some have a number of available densities.
Final Writer lets you select from seven different
density settings (1 is low density, 7 is high density).
However not all density settings may be available for
your printer. If you are unsure of the number of
densities available for your printer, or the dots per
inch of each, click on each density button and observe
how the numbers in the "DPI" box change. A higher
density will increase the time it takes to print your
document and, with some printers, may result in muddy
colours.

THRESHOLD — This setting determines which colours on the screen are
printed as white, and which are printed as black when
the "Shade" option is set to "Black and White".




138 /239

Printing a Document Page 11-6

1.205 11-7

COLOUR CORRECT - If you are printing colour graphics, this setting helps

DITHERING

SHADE

you to better match screen colour to the colour
produced by the printer. Without colour correction, the
printer device can print 4096 colours displayed by the
Amiga on a colour printer. However, as colour
correction is applied, the total number of printed
colours 1is reduced by 308 shades for each colour
selected for correction. The total number of colours
available is always displayed in the area under the
word "Colours".

To see the effect of colour correction, you may wish to
print a picture with solid red,green, and blue shades
once with colour correct on, and once with it off. Then
compare the two pictures with the screen display.

Dithering refers to the way in which colours are
produced on the printed page. It enables you to produce
printouts with various shades on a printer that only
uses four colours. Dithering only applies to colour or
grey scale printing.

ORDERED DITHERING - colour intensities are formed using
an ordered dither method. Ordered dithering produces
shades on the printer using an ordered pattern of dots.

HALFTONE DITHERING - colour intensities on the printer
are formed using halftone dither method. This technique
is similar to the one used in newspapers and comic
books. It works best on high density printers (greater
than 150 dots per inch".

Use this setting to specify whether documents are to be
printed in colour, black and white, or shades of grey.
For faster printouts use black and white.
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POSTSCRIPT PREFERENCES

Settings that affect printing to a PostScript printer, and printing
PostScript information to a disk file are made in the "Postscript

Preferences"

TO ACCESS THE

requester.

"POSTSCRIPT PREFERENCES" REQUESTER:
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1. Click on the

* * * See

Fig

1.207 11-8a

"PostScript" button in the "Print" requester.

11-5 * kK

Below are descriptions of the settings in the "PostScript Preferences"

requester.

PRINTER TYPE -

* kK See
SHADE

* kK See
DOWNLOAD
FONTS

* kK See
HALFTONING
PAGE MODE
* x Kk See

Fig

Fig

Fig

Fig

Use this setting to define to Final Writer
whether your laser is connected to your Amiga through the
Parallel or Serial port.

11-6 * kK

This setting defines whether you want colour PostScript
information generated. If you are not printing to a
colour PostScript printer, set shade to "Grey Scale".

11-6 * ok k

Indicates how you want fonts not on a PostScript printer
to be downloaded.

11-6 * % K

You can either use the default halftonning settings of
your printer or specify your own. When "Custom" is
selected, you can enter Lines Per Inch, Screen Angle,
and Spot Function.

Use this option to indicate whether you want to print in
Normal mode or with thumbnails. If Thumbnails is
selected, you can specify the number of thumbnails that
are to appear on a page.

11-6 *x K
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SCALING

CROP MARKS

PAGE SIZE

When printing in "Normal" Page Mode use this option to
specify special print scaling.

Use this option to specify whether or not you want crop
marks printed on your document.

This setting indicates what size paper you are using in
your printer. If you choose "Custom" you can enter your
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own dimensions.

* Kk See Fig 11-6 * % %
ORIENTATION - If you want your page printed in the normal fashion, set
this option to "Tall". If you want to print sideways, set

this option to "Wide".

* Kk See Fig 11-6 * kK

1.209 11-9a

"DRAFT PREFERENCES" REQUESTER

The settings in the "Draft Preferences" requester affect printing in
draft mode. Draft mode is not available on PostScript printers. If you
choose to print to a PostScript printer or disk file, the Print Draft
option is not available.

TO ACCESS THE "DRAFT PREFERENCES" REQUESTER:

1. Click the mouse on the "Draft" button in the "print" requester.

* kK See Fig 11-7 * kK

Below are definitions for the options and settings in the "Draft
Preferences" requester:

LINES - Use this option to specify the size of your page in terms of
the maximum number of lines that can be printed on it. This
setting will depend upon the vertical size of your page, the
"Spacing" option (also found in the "Draft Preferences"
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requester), and the printable area on the page. Below are few

examples:
Page size Spacing Feed Paper Length
8 1/2 x 11 6 Continuous 66
8 1/2 x 11 8 Continuous 88
8 1/2 x 11 6 Sheet 54
Label 6 - 6

1.210 11-10

MARGINS

TOP — Top margin is the number of lines from the top of the

printable area of a page that you do not want to print to.
This value is measured from the top of the printable area. For
example, a one inch top margin on continuous feed printing,
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using "6 lines per inch" spacing, would require a Top Margin
value of 6. On a continuous feed printer, there will already
be a top margin equal to the non-printable area at the top of
the page.

BOTTOM

Bottom margin is the number of lines from the bottom of the
printable area of a page that you want to print on. If you are
using a sheet fed printer, there will already be an area at
the bottom of the page where printing can not occur.

LEFT

Left margin is the number of characters from the left of the

printable area of the page that you do not want to print on.

For example, a one inch left margin using Pica (10 characters
per inch) pitch would mean a Left Margin value of 10.

RIGHT - Right margin is measured from the left side of the printable
area of a page. It defines the maximum width to print on. For
example, on a page with a printable area of 8 inches, using
Elite (12 characters per inch) pitch, a one inch Right Margin
would require a value of 84 ((8 inches - linch)x12 characters
per inch).

FIRST - First margin is the number of characters from the left side of
the printable area of a page you want to indent when printing

the first line of a paragraph.
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PITCH - Pitch defines which mono-spaced printer font you want to print
with. Pica gives you 10 characters per inch, Elite gives you
12 characters per inch, and Fine gives you condensed print.

SPACING - Spacing defines the vertical placement of lines on a page as a
function of lines per inch.

QUALITY - Quality defines the type of printer font you want to print
with.

1.212 11-11a

POSTSCRIPT PRINTING

If you have a PostScript laser printer, or if you know someone who does,
you can use Final Writer'‘s built-in PostScript printer driver.

Final Writer'‘s PostScript output can be directed to your Amiga‘s
parallel (PAR:) or serial (SER:) device. It may also be re-directed to a
file which can be taken to a typesetting service and printed.
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1.213 11-11b

COMMUNICATING WITH THE SERIAL PORT

Final Writer will communicate through the serial (SER:) device to a
PostScript printer using the current Serial Preferences. The output
generated is strict (7-bit) ASCII to provide widest acceptance on the
host PostScript printer.

PREFERENCES

Making sure your Amiga has the proper serial connection with the printer
is very dependent on the output device. The default settings of either
9600 or 1200 baud, 8 bits/char, No parity, 1 stop bit, and XON/XOFF
handshaking usually work with no problems.

HANDSHAKING

Often, when a simple document is printed it works fine, but when a
complex document is printed, the printer produces no output. In most
cases, this is due to a handshaking problem and can be corrected by
matching the handshake between the Amiga and the printer.
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To find out what handshaking your printer uses run the PostScript
program shown below. Use a text editor like emacs or ed. You can also use
Final Writer but make sure you save the file as ASCII.

/HELVETICA FINDFONT 20 SCALEFONT SETFONT
40 200 MOVETO

STATUSDICT BEGIN

25 SCCBATCH

(THE OPTIONS NUMBER IS ) SHOW

10 STRING CVS SHOW

(. THE BAUD RATE IS ) SHOW

10 STRING CVS SHOW

END

SHOWPAGE

Save this file as "shake" and exit the editor. From the CLI, copy the
"shake" file to the serial port with a command such as "copy

shake ser:". This will send the PostScript program to the printer where
it will be run. The printer should print a sheet of paper. If nothing
seems to happen, cycle the power on the printer, wait a moment and try
again. The output should read.

THE OPTIONS NUMBER IS 0. THE BAUD RATE IS 9600

If your options number is in the range 0 - 3, the handshake is properly
set to XON/XOFF. If your options number is in the range 4 - 7, there is a
problem - the printer is set to DTR handshake. This won‘t work well with
the Amiga.

The option number is interpreted as follows:
0 or 4 Ignore parity
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1 or 5 0dd parity
2 or 6 Even parity
3 or 7 No parity

For the Amiga the options should be set to 0.

Some printers have switches or front panel controls for the options and
baud rate. If you have one of these, look in your manual for the correct
settings. Other printers require a PostScript program, like the one below

Replace BAUD and OPTIONS with the numbers you wish set.

SERVERDICT BEGIN 0000 EXITSERVER
STATUSDICT BEGIN

25 BAUD OPTIONS SETSCCBATCH

END
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Type the program in using your text editor and run it by copying it to
the SER: device as described above. This will change the internal baud
and options settings. The settings will stay in effect even if you turn
the power off. You should not change the settings more often than
necessary, through. The EEPROM device that stores the settings wears out
after about 10,000 uses.

After running the program, either send a CTRL-D to the printer or wait
30 seconds for the changes to take effect.

1.214 11-13

ADVANCED TOPICS

THE "SW_PROLOGUE.PS" FILE

Located in the "FWFiles" drawer is the file, "sw_prologue.ps". This file
must be available for Final Writer to generate PostScript output. If
Final Writer is properly installed, this file will be available at all
times. Please do not modify "sw_prolog.ps". PostScript programmers can do
customized procedures using the "user_def.ps" file.

THE "USERDEF.PS" FILE

Although the file "user_def.ps" is not included on your Final Writer
disks, a PostScript programmer may want to create a few custom PostScript
procedures for doing such things as colour separations, page,
registration marks, etc. Final Writer leaves these options open for the
PostScript programmer.

When printing, Final Writer looks in the "FWFiles" directory for the
file "user_def.ps". If the file is found, it is inserted into the
PostScript output, giving the user a chance to define a few custom
PostScript procedures that will be called while the document is printing.
These PostScript procedures names are:

USERDOC
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USERBOP
USEREOP

UserDoc 1is called right before the document begins printing. This gives
the PostScript programmer the ability to set up device dependent
information such as undercolour removal, halftone screens and the like.
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UserBOP is called at the beginning of each page, and UserEOP is called
right before each page is ejected from the printer. These two procedures
can be used to print registration marks or other information that you
want to print on each page.

Final Writer also keeps a few PostScript variables current while the
document is printing. These variable are:

u_doc — The document name

u_time — The current time (as printing)
u_date — The current date

u_page - What page number when printing
u_copy — What copy of this page is printing
u_pageht/u_pagewd - The document ‘s page dimensions

The variables"u_doc","u_time" and "u_date" are updated when the document
begins printing, and can be used inside the user‘s procedures to print
cover sheets or for typesetters information printed in the margins of
each page.

The variables "u_page" and "u_copy" are also useful for typesetting
information printed on each page. "u_copy" is particularly useful for
doing colour separations. You may specify that Final Writer print four
copies of the document, and your "UserDoc" or "UserBOP" procedure may use
the variable "U_cop" to set up halftone screens and colour separations
for Cyan, Magenta, Yellow and Black.
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PRODUCING FORM LETTERS

Producing form letters .........oiiiiieeeenn. 12-2
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Tips for setting up a data file ........ 12-4

Saving a data file ...ttt e 12-5
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Creating a form letter ..............vv.n. 12-6
Changing type attributes ............... 12-8
Changing data name .......iiiiunnnennnn 12-8a
Removing a merge field.................. 12-9
Saving a form letter ............. ... ... 12-9a
Merging data with a form letter ............. 12-9b
1.216 12-1

FROM LETTERS
With Final Writer, you can create a form letter, a list of recipients
and print an individualized copy of the form letter for each recipient.
Included in this chapter are instructions on:
* Creating and saving merge data.
* Creating a form letter.

* Merging data with a form letter.
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PRODUCING FORM LETTERS

To print form letters in Final Writer, you need:

* A form letter document containing the text that is the same for every

copy of the letter, and indication where custom data unique for each
copy is to be inserted.

* A data file containing actual information that is different for each
letter, such as names and addresses of recipients.

The form letter and the data file are combined using the "Print Merge"
command to print individualized form letter.

* kK See Fig 12-1 * kK
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CREATING A DATA FILE

In the discussions that follow, "row" is used to refer to a collection
of related data: and "field" is used to refer to a piece of data within
a row. For example in a name and address data file, a row refers to all
the information for one person; while field refers to a person'‘s name.
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A data file is an ASCII disk file where fields are separated by comma or
tab characters, and rows are separated by a NEWLINE (0x0Oa) or RETURN
(0x0d) character. For example, in a name and address data file, each
person‘s name and address information (row) is separated from another
person‘s name and address, by a NEWLINE or RETURN character. Within each
row the name, address, city, state, etc., fields are separated from each
other by either a comma or tab character. Although either a tab or comma
can be used to separate data, only one method can be used in any given
data file. Therefore, if data is separated with a tab for one row of
data, a comma can not be used to separate data in another row.

Final Writer uses the first row of a data file to determine the names
field. Therefore in a name and address data file, the first row could
contain the words "First" "Last" "Address" "City", etc. Subsequent rows
would contain the actual names and address.

To summarize, the rules governing the format of data files that can be
used in Final Writer‘'s Form Letter feature are:? ?$\timesS$#G7 ?
* Data file must be an ASCII data file.

* Rows within a data file are separated by either a NEW LINE or a RETURN
character.

* Fields within a row are separated by either tab or comma character.
Only one method of separating fields can be used in any given data

file.

* The first row of a data file must contain the names of the fields
contained in the file.

* The sequence of fields within a row must follow the sequence of field
names used in the first row.

A typical name and address data file might appear as:

FIRST MIDDLE LAST STREET CITY STATE Z1P

Woody Williams 120 Company Str. Tempe AZ 12345
Terry R. Wright 43 Sailboat Ave. Tempe AZ 32321
Mary B. Unes 55 Golf Street Phoenix AZ 39393
Pat Brouilette 23 Rock Climb Rd. Tempe AZ 38290
Ben Fuller 553 Amiga Lane Mesa AZ 3234

NOTE. Where a field does not exist within a row, only the separating
character is entered.
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TIPS FOR SETTING UP A DATA FILE DOCUMENT

You may want to modify two preference settings to make entering, saving,
and opening a data file more convenient. These preferences are:

"TAB EVERY" VALUE
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Final Writer has a default tab distance value that is set in the
"Document Preferences" requester. This value specifies the distance the
program will move the insertion point whenever you press the TAB key

where no tab stops are set. When you are creating a data file, and intend

to use a tab character to separate data, you may want to set this value
larger than Final Writer's original default value. We recommend setting
the "Tabs Every" value in the "Document Preferences" requester to at
least .75 inches.

* Kk See Fig 12-2 * % K

ASCII I/O PREFERENCES

We recommend the following settings for the ASCII I/0O Preferences used
to read and write your data file.

* %k See Fig 12-3 * %k
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SAVING A DATA FILE

If you use Final Writer to edit and save your data file, you will need

to save it as an ASCII file. In order to do this properly, always use the

"Save Copy of Document" feature rather than "Save". The reason for this
is that "Save" will always save an existing file as a formatted Final

Writer document. By using the "Save As" feature, you can specify that the

ASCII format is used.
TO SAVE A DATA FILE IN FINAL WRITER:
1. Choose "Save As ..." from the "Project” memu.
* kK See Fig 12-4 * kK
A file requester will appear.

* kK See Fig 12-5 * kK

2. Use the file requester to locate where you want the data file to be
saved.

3. Insert in "File" whatever name you want to save the file as. If you
are saving a data file that already been saved, click the mouse on
the name of the file in the file requester‘s list.

4. Click on the "Export ..." button in the file requester.

A list of formats will be shown.

* Kk See Fig 12-6 * % K

5. Click on the word "ASCII", and then click on the "Save".
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The file will be saved as an ASCII file.
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CREATING A FORM LETTER
A form letter is created in Final Writer like any other document. The
only difference is that wherever you want data merged into the text from
a data file, you will choose the "Insert Merge Field" menu item and
specify the name of the field that is to be merged. Once a merge field
definition has been inserted, you can change it, remove it, and even
change its type attributes.
TO INSERT A MERGE FIELD DEFINITION:

1. Make sure the insertion point is where you want data to be inserted
from the data file.

* Kk See Fig 12-7 * % K

2. Choose "Merge Field" from the "Insert item" sub-menu located in the
"Edit" menu.

The "Select Merge Field" requester will be displayed.
* % K See Fig 12-8 * %k
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3. If the "Fields" list is empty:
A. Click on the "Select ..." button.
A file requester will appear.
* kK See Fig 12-9 * % Kk

B. Use the requester to locate a data file that contains the names of
the merge fields in the first row of the file.

C. Once the data file is located, double-click the mouse on its name.

Final Writer will read the data file, locate the field names, and
place the names into the "Fields Names" list.

* kK See Fig 12-10 * kK

4. Double-click the mouse on the name of the field in the "Field Names"
list whose data is to be merged.

Final Writer will remove the requester, and insert the field'‘s name
into your document surrounded by double-bracket characters.
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For example, "<<First>>".

5. Continue typing your form letter and repeat the above steps for each
merge field.
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CHANGING A MERGE FIELD'S TYPE ATTRIBUTES
A merge field created by Final Writer has its own unique type
attributes. For example, your form letter could be in Times—-Roman while
data merged into a particular merge field could be Times-Bold.
TO CHANGE A MERGE FIELD'S TYPE ATTRIBUTES:

1. Click the mouse on the merge field whose attributes are to be
changed.

Final Writer will select the entire merge field including its
surrounding brackets.

2. Set the type attributes using the Text menu items or the "Type Specs"
requester.

1.223 12-8a

CHANGING A MERGE FIELD'S DATA NAME

You can change your mind as to what field is to be merged in a merge
field that is already defined.

TO CHANGE A MERGE FIELD'S DATA NAME:

1. Click the mouse on the merge field whose data name is to be changed.
Final Writer will select the entire field including its surrounding
brackets.

2. Choose "Merge Field" from the "Update item" sub-menu located in the
"Edit" menu.

* k% See Fig 12-7 * % %

The "Select Merge Field" requester will be displayed.
3. If the "Fields Names" list is empty:
A. Click on the "Select..." button.

A file requester will appear.
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B. Use the requester to locate a data file that contains the names of
the merge fields in the first row of the file.

C. Once the data file is located, double-click the mouse on its name.
Form Letters Page 12-8

Final Writer will read the data file, locate the field names, and
place the names into the "Fields Names" list.

4. Double-click the mouse on the name of the field in the "Field Names"
list whose data is to be merged.

Final Writer will remove the requester, and insert the field'‘s name
into your document replacing the name that was there before.

1.224 12-9

REMOVING A MERGE FIELD
You can remove a merge field from a form letter at any time.
TO REMOVE A MERGE FIELD:

1. Click the mouse on the merge field to be removed.
Final Writer will select the entire field including its surrounding
brackets.

2. Press the DELETE or BACKSPACE key.

The merge field will be removed from the document.

1.225 12-9a

SAVING A FORM LETTER

A form letter is saved as a Final Writer document. There is nothing
special about saving a form letter - do it just as you save any other
document.

1.226 12-9b

MERGING DATA WITH A FORM LETTER

Once you have created a from letter and a data file you can instruct
Final Writer to merge the data file with the form letter. This process
will print an individualized copy of the letter for each recipient in the
data file.
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TO MERGE DATA WITH A FORM LETTER:

1.If the form letter document is not already open , choose "Open" from
the "Project" menu, and open the form letter like you do for any other
document that you open.
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2. Choose "Print Merge" from the "Project" menu.

* ko See Fig 12-11 * kK

Final Writer will display the "Select Merge Data" file requester.

3. Use the file requester to locate the data file you want to use for
the merge.

* % * See Fig 12-11 * K *

4. Once the data file is located , double-click the mouse on its name in

the file requester’s list.
The "Select Merge Records" requester will appear.

* Kk See Fig 12-12 * kK

Final Writer will analyse the data file and determine the number of
rows (records) contained in the file. It will put the number "1" in
the "From" range, and the last record number found in the "To"
range. This gives you the ability to select which group of data
records to be merged. This feature is handy if you have to restart a
merge because of printer error or some other problem.

5. If you want to print all rows in the data file, click the mouse on
"All". If you want to print a range of rows, click the mouse on the
"Range", enter the beginning row # in the area labelled "From", and
enter the ending row # in the area labelled "To".
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6. Click on the "OK" button in the "Select Merge Rows" requester.
Final Writer will display a requester.

* %k See Fig 12-13 * %k

7. Use this requester just as you would if printing a single document.
Refer to Chapter 11 for details on using this requester.

Final Writer will display the "Printing Document ..." requester and
you will begin to merge rows of data with the form letter. Each page
of the form letter will be printed for each data record merged. You
can cancel this process at any time by clicking the mouse on the
"Stop" button.

* %k See Fig 12-13 * kK
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1.228 13-1

AREXX SUPPORT

Advanced users can use Final Writer’s ARexx facility to create "macro"
programs. These macros can execute Final Writer commands as well as
commands understood by other programs. In order to use ARexx it must be
installed on your system. ARexx 1is included as part of the Amiga 2.0
operating, system, but must be purchased separately in earlier versions.

This chapter describes commands that can be used in an ARexx macro to
execute Final Writer.
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USING AREXX IN FINAL WRITER

To use ARexx in Final Writer you must have ARexx installed on your
computer and be familiar with the ARexx language. ARexx is considered a
feature for "advanced users.

An ARexx macro program is usually created in a text editor, but can also
be created in Final Copy and saved as an ASCII file. The name of this
port always begins with "FinalW." and ends with a number indicating the
order in which the window was opened. For example, the first window
opened has an ARexx port name of "FinalW.1l"; the second window opened has
a port name of "FinalW.2".

1.229 13-2

RUNNING AREXX SCRIPTS.

You can create as many ARexx scripts as you want to execute Final Writer
commands. these scripts can be run from within Final Writer as well as
from other programs including the CLI. Within Fianl Writer you can access
ARexx scripts in several ways.
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1. Clicking on a "User Button Strip" icon to which you have assigned an
ARexx script.

2. Selecting a "User Menu" item or pressing a function key to which you
have assigned an ARexx script.

3. Loacating and selecting a script from a file requester.

1.230 13-2a

AREXX ERRORS

Final Writer returns one of the following numbers in the ARexx variable
"RC" after each ARexx command it processes.

0 No errors

5 Warning

10 Command failed

20 Command has invalid arguments

100 Unknown or invalid command
200 Can’t open fcarexx.library
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COMMANDS SYNTAX

The command arguments are given using the standard AmigaDOS arguments
template in which the arguments are seperated by commas and followed by a
slash and a capital letter which indicates the type of argument. The
slash and the following letter, which are not to be typed as part of the
command, are explaind below:

argument /A (Always This menas that the argument must always be given
a value on the command line.

option/K (Keyword) This menas that the argument is optional. The
option will only be filled if the keyword appears on the
command line before the value to be assigned to the
option.

option/S (Switch) This also means that the argument is optional.
However, with this option, only the keyword is specified
on the command line (without wvalue).

string/F (Final) This means that the argument is a string which
must be the final argument on the command line. The
remainder of the command line will be taken as the desired
string.
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1.232 13-3a

The following is an alphabetical list of Final Writer’s ARexx conmmands.

COMMAND LIST

After each command is a brief description of what the command is used
for. Refer to the next section, Command definitions" for complete
descriptions of each command.

COMMAND

AddIndexEntry
Add Index Words
AltDown

AltUp
ASCIIPREFS
BackSpace
BibPrefs

DESCRIPTION

Add a word or a phrase to the index list.
Add words to the index entry list.

Set ALT key status to DOWN.

Set ALT key status to UP.

Change the ASCII I/O preferences.

Same as typing backspace key.

Change the bibliography creation settings.
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BoxPrefs

Bullet

Case
ChangeWindow
Clear

ClearDoc

Close

Copy

CopyRuler
Create

CtrlDown

CtrlUp
CurrentObject
Cursor

Cut

Delete
DeleteIndexEntry
DeleteObject
DisplayPrefs
DocColorPrefs
DocIltemPrefs
DraftPrintPrefs
DrawBox
DrawLine
DrawOval
DrawTextBlock
EditBibliography
EditBody
EditEndNotes
EditIndexList
EditLeftMaster
EditRightMaster
EndNotePrefs
Extract

Find

Change the box drawing settings.

Bullet the current or selected paragraph.
Change the font case to the specified case.
Change the window position and size.
Delete selected text or graphic objects.
Clear out the entire document.

Close the document

Copy selected text or gprphics to clipboard.
Copy the current ruler settings.

Create aa new section.

Set CTRL key status to DOWN.

Set CTRL key status to UP.

Get the current object ID.

Move the insertion point.

Copy text or objects to the clipboard.
Same as typing the delete key.

Delete an entry from the index list.
Delete a graphic object.

Change the display preference.

Change document colour prefernces.
Change document item prefernces.

Change the draft print prefernces.

Draw a box.

Draw a line.

Draw an oval.

Draw a text block.

Present the edit bibligrahhy requester.
Edit the document’s body page.

Present the edit endnotes requester.
Present the edit index requester.

Edit the document’s left master page.
Edit the document’s right master page.
Change the endnote creation settings.
Get document text.

Find a text string.
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FindCursor Scroll to find the insertion point.

FindNext Find the next occurrence of a text string.
FindReplace Present the Find/Replace requester.
FirstObject Get the object ID of the first graphic object.
Font Change the font.

FontColor Change the font colour.

FontSize Change the font size.

GetASCIIPrefs Get ASCII I/O preferences.
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GetBibPrefs Get bibliography creation preferences.
GetBoxPrefs Get box drawing preferences.
GetDisplayPrefs Get display preferences.
GetDocColorPrefs Get document colour preferences.
GetDocItemPrefs Get document item preferences.
GetDraftPrefs Get draft print preferences.
GetEndNotesPrefs Get endnote creation preferences.
GetGfxPrintPrefs Get graphics print preferences.
GetImportPrefs Get a list of all import preferences.
GetIndexPrefs Get graphics import preferences.
GetLinePrefs Get line drawing preferences.
GetObjectCoords Get the object coordinates of an object.
GetObjectParams Get the parameters of an object.
GetObjectRotation Get the rotation of an object.
GetObjectTitle Get the title of an object.
GetObjectType Get the type of an object.
GetObjectTypeSpecs Get the type specs of a text block.
GetOutlinePrefs Get the outline creation preferences.
GetOvalPrefs Get the oval drawing preferences.
GetPageSetup Get the page setup preferences.
GetPrintSetup Get the print setup preferences.
GetPSPrintPrefs Get the postscript print preferences.
GetSectionlList Get a list of the document’s section.
GetSectionSetup Get the section preferences.
GetTextBlocksPrefs Get the text block drawing preferences.
GetTextBlockText Get the text of a text block.
GetTextBlockTypePrefs Get the block type preferences.
GetTOCPrefs Get the table of contents preferences.
GetTOIPrefs Get the table of illustrations preferences.
GfxPrintPrefs Change the graphic print preferences.
GoToPage Scroll to another page.

GoToSection Switch to an existing section
GraphicTool Make the graphic tool the current tool.
Group Group all selected graphic objects.
HotZone Change the hyphenation zone.

Hyphen Turn hyphenation on or off.

ImportPrefs Change the graphic import preferences.
Indent Change Paragraph indent.

IndentLeft Indent the paragraph to the left.
IndentRight Indent the paragraph to the right.
IndexPrefs Change the index creation preferences.
Insert Insert a special item into the document.
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InsertEndNote Insert a new endnote and marker.
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SelectObject
SetFind
SetMeasure
SetObjectCoords
SetObjectParams

SetObjectRotation

SetObjectTitle

SetObjectTypeSpecs

SetTab
SetTextBlockText
ShiftDown
ShiftUp
ShowMessage

Select (or deselect) graphic objects.
Set options for find.

Sets the measurment units.

Change parameters of an object.

Change parameters of a graphic object.
Set the rotation of a graphic object.
Set the title of an object.

Change an object ‘s type specification.
Set a tab stop.

Change the text of a text block object.
Set SHIFT key status to DOWN.

Set SHIFT key status to UP.

Display a message requester to the user.
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InsertImage Import a graphic image.

InsertPageBreak Insert a page break.

Justify Change paragraph Jjustification.

Leading Change the font leading value.

LeftMargin Change paragraph left margin.

LinePrefs Change the line drawing preferences.

Lock Lock the selected graphic objects in place.
MoveTo Line Move in sertion point to a different position.
MoveToPara Move insertion point to a different position.
MoveWindow Move the document ‘s window.

New Create a new document window.

NewParagraph Create a new paragraph.

NewSection Create a new section.

NextObject Get object ID of the next graphic object.
ObjectToBack Send an object behind all others.
ObjectToFront Bring an object to the front of all others.
Oblique Change the font oblique angle.

Open Open a document.

OutlinePrefs Change the outline creation settings.
OvalPrefs Change the oval drawing preferences.
PageSetup Change the page setup options.

Paragraph Present the paragraph settings requester.
Paste Paste text or graphic into the documnet.
PasteRuler Paste copied ruler settings.

Position Change the font script.

PostScriptFile Set the PostScript output file name.
Preferences Present a preference requester.

Print Print using the current print settings.
PrintSetup Change the current print settings.
PSPrintPrefs Change the PostScript print preferences.
Quit Quit the program.

Redraw Reformat and redraw the document.
RemovePageBreak Remove a page break.

RemoveSection Remove a section from the document.
RequesterText Request information fron the user.
RightMargin Change paragraph right margin.

Save Save the document to a disk file.

SaveAs Present the "Save Document" requester.
ScreenToBack Send screen behind all others screens.
ScreenToFront Bring the screen in front of all others.
SelectAll Select all the text.
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in
ShowRulers Show or hide the rulers
SizeWindow Change the width and height of a window.
Sort Sort the paragrphs.
Spacing Change the line spacing.
Speller Present the speller requester.
Statistics Presents the statistics requester.
Status Get various document information.
Style Change the font style.
StyleSheet Change the paragraph's stylesheet.
TextBlockPrefs Change the text block drawing prefernces.
TextBlockTypePrefs Change the text block drawing type specs.
TextTool Make the text tool the current tool.
Thesaurus Present the thesaurus requester.
TOCPrefs Change table of contents creation settings.
TOIPrefs Change table of illustrations settings.
Type Insert the characters into a document.
TypeSpecs Present the type specs requester.
Ungroup Ungroup the selected objects.
Unlock Unlock the selected graphic objects.
UpdateDate Update auto date strings.
UpdateTime Update auto time strings.
View Change the current view size.
Width Change the font width.
WinToBack Send window behind all others.
WinToFront Bring window to front of all others.
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COMMAND DEFINITIONS

The ARexx commands require Workbench 2.0 or graeter.
below, the keyboards are capitalized to help distinguish them from the
values they are given. When a command returns results in the ARexx Result
variable the options are put into the result string in the order in which

they appear in the command‘s argument template NOT in the order in which

they are specified on the command line.

AddIndexEntry "Entry/A/F"
Add a word or a phrase to the index entry list.
See also AddIndexWords.

Entry - The word or phrase to add to the index list.

Examples:
AddIndexEntry
AddIndexEntry

AddIndexWords

is selected and

"ONEENTRY"

"SoftWood"
"Outline Fonts"

"ONEENTRY/S"

Add words to the index entry list.
add the word at the insertion point to the index list.
selected, then add each word in the range to the index list.
is specified, then add the text in the range

as one entry to the list.

In the examples

If a range is not selected, then
If a range 1is
If a range
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Examples:
AddIndexWords
AddIndexWords ONEENTRY
AltDown
Used with "Cursor" command. Set ALT key status to DOWN.
See also AltUp, CtrlDown, CtrlUp, ShiftDown, ShiftUp.
AltUp
Used with "Cursor" command. Set ALT key status to UP.
See Also AltDown, CtrlDown, CtrlUp, ShiftDown, ShiftUp.
ASCIIPrefs

"ParaNewLine/K, ParaBlankLine/K, InsertNewLine/K, InsertBlankLine/K, PROMPTS/
S"
Change the ASCII Input/Output preferences

ParaNewLine Set the Input option for marking a paragraph at each
newline character.

YES Turn the option on.

NO turn the option off.
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ParaBlankLine Set the input for making a paragraph at each blank
line.
YES Turn the option on.
NO Turn the option off.

InsertNewLine Set the Output for inserting a newline after each
line.
YES Turn the option on.
No Turn the option off.

InsertBlankLine Set the option for inserting a blank line after each
paragraph.
YES Turn the option on.
No Turn the option off.

PROMPT If specified, presents the ASCII I/0 requester,
ignoring all other arguments.

Examples:

ASCIIPrefs PARANEWLINE Yes PARABLANKLINE No
Turns on the first input option and turns off the second input
option.

ASCIIPrefs PROMPT
Presents the ASCII I/O requester.

BACKSPACE
Erase the character to the left of the insertion point. If a range of
text is selected, then delete the text in the range. This is the same
as typing the backspace key.
See also Delete
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BibPrefs "Title/K, Indent/K"
Change the bibliography creation settings.

Title

Indent

Examples:

Set the bibliography title option.

Choose one of the following:

Yes Include the bibliography title when creating
the bibliography.

No do not inclide the bibliography title.

Indent specification in ruler or micropoints. (.125
— 5 inches)

BibPrefs TITLE Yes INDENT .5
Includes the title and make the indent .5 inches.
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BoxPrefs

"TextFlow/K,FlowDist /K, LineWt/K/LineColor/K,Fill/K,FillColor/K,PROMPT/S"
Change the box drawing settings.

TextFlow

FlowDist

LineWt

LineColor

Fill

FillColor

PROMPT

Bullet

Change the text flow option. Choose one of the
following:

LeftVert Set to left vertical.

LeftCont Set to left contour.

RightVert Set to right vertical.

RightCont Set to right contour.

None Set to no text flow.

Change the flow distance between box and text,
specified in ruler or micropoints (0.025 - 2.0
inches) .

Change the line weight. Choose one of the following:
Change the line colour to a colour specified by a
colour name.

Change the fill option. Choose one of the following:
Solid Set the fill to solid.

Transparent Set the fill to transparent.

Change the fill color to a colour specified by a
colour name.

Present box settings requester ignoring all other
arguments.

Bullet the current or selected paragraphs.

Case "Case/A"

Change the font case to the specified case.

Case

Examples:
Case Normal
Case AllCaps

Change the font case. Choose one of the following

Normal Set case to Normal.
SmallCaps Set case to Small Caps.
AllCaps Set case to All Caps.




in 160 /239

ChangeWindow "Left/A, Top/A,Width/A, Height /A"
Change a document ‘s window position and size.
See also MoveWindow, SizeWindow.

Left Left coordinate of window in absolute screen pixels.
Top Top coordinate of window in absolute screen pixels.
Width Width of window in absolute screen pixels.

Height Height of window in absolute screen pixels.
Examples:

ChangeWindow 10 20 400 300

Clear
Delete the selected text or graphic objects from the document
depending on the current tool. If the current is set to the text
tool, then the command will clear any selected text, otherwise, it
will clear any selected graphic objects.
See also Cut, Copy, Paste, GraphicTool, TextTool.

ClearDoc "FORCE/S"
Clear out the entire document prompting to save any changes.

FORCE If specified, clear the document regardless of any
changes made to the document.

Examples:
ClearDoc
ClearDoc FORCE

Close "FORCE/S"
Close the document prompting to save changes.

FORCE Close the document no question asked.

Examples:
Close
Close FORCE
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Copy
Copy the selected text or graphic objects to the clipboard depending
on the current tool. If the current tool is set to the text tool,
then the command will copy any selected text, otherwise, it will copy
any selected graphic objects.
See also Cut, Paste, Clear, GraphicTool, TextTool.

CopyRuler

Copy tthe ruller settings of paragraph that the insertion point is
in.
See also PasteRuler.

Create Section/A,PROMPT/S"
Create one of the special sections using its current settings.
Section The section type to create. Choose one of the following:
Bibliography Create bibliography
Contents Create a table of contents.
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EndNotes Create endnotes.

Illustrations Create index.

Index Create index.

Outline Create outline.

PROMPT Specify to present the settings requester

before creating the section.

Examples:
Create Index
Create Contents PROMPT

CtrlDown
Used with "Cursor" command, Set CTRL key status to DOWN.
See also AltDown, AltUp, CtrlUp, ShiftDown, ShiftUp.

CtrlUp
Used with "Cursor" command, Set CTRL key status to UP.
See also AltDown, AltUp, CtrlDown, ShiftDown, ShiftUp.

CurrentObject
Return in Result the object ID of the current (selected) graphic
object. If there is not a current object, then Result is set to 0.

Cursor "Direction/A"
Move the insertion point in the specified direction. Additional
action is determined by the ALT, SHIFT, and CTRL key status.
See AltDown, AltUp, CtrlDown, CtrlUp, ShiftDown, ShiftUp,
MoveToLine, MoveToPara.
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Direction The direction to move. Choose one of the following:
Left Same as pressing left arrow.
Right Same as pressing right arrow.
Up Same as pressing up arrow.
Down Same as pressing down.

Examples:
Cursor LEFT
Cursor UP

Cut
Copy the selected text or graphic objercts to the clipboard, then
clear the selection from the document depending on the current tool.
If the current tool is set to the text tool, then the command will
cut any selected text, otherwise, it will copy any selected graphic
objects.
See also Copy, Paste, Clear, GraphicTool, TextTool.

Delete
Erase the character to the left of the insertion point. If a range of
text is selected, delete the text in the range. Same as typing the
delete key.
See also Backspace.

DeleteIndexEntry "Entry/A/F"
Delete an entry from the index list.
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Entry The text of the entry to delete.

Examples:
DeleteIndexEntry "house"

Remove the word "house" from the index entry list.
DeleteIndexEntry "monthly report"

Removes "monthly report2 from the index entry list.

DeleteObject "Objectid"
Delete a graphic object. If "Objectid" is not specified, then delete
all the selected objects.

Objectid The object ID of the graphic object to delete.

Examples:
DeleteObject
Deletes all selected objects.
DeleteObject 4
Deletes the object with an object ID of 4.
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DisplayPrefs
"Horizontal/K,Vertical/K,Guides/K,Rulers/K,Measures/K, Shading/K,WBDocCol
or/K,PROMPT/S"
Change the display preferences.

Horizontal Set the Horizontal Screen DPI. Value from 40 to 600.
Vertical Set the vertical Screen DPI. Value from 40 to 600.
Guides Set what page guides are to be shown.

This is a combination of letters. Specify:

P for Print Area guides

E for Edit Area guides

H for Header/Footer guides

C for Columns guides
specify any other character to turn everything off.
i.e. "PE", "PEHC", "E", etc.

Rulers Set the rulers to be displayed. Choose one of the
following:
None Display no rulers.
Top Display only the top ruler.
All Display both left and top ruler.

Measure Set the ruler measurment sytem. Choose one of the
following:
Inches Use inch measurments.
Metric Use metric measurments (centimeters).
Pica Use pica measurment (1 inch = 6 picas).

Shading Set the Imported Graphic On Screen Shading method.
Choose one of the following:
NTSCGray Use NTSC gray mapping.
LightGray Use light gray mapping.
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WBDocColor

PROMPT

Color Use color mapping.

Set document page color. Choose one of the following:
Pen0 Use Pen 0 color

HighLightPen Use the highlight color.

Present the display preference requester ignoring all
other arguments.
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Examples:

DisplayPrefs Guides pe Rulers All

set up the document to have print and edit guides and both rulers.
DisplayPrefs PROMPT

presents the display preferences requester.

DocColorPrefs "ColorName/A,R/A,G/A,B/A, NewName/K"
Change the RGB color values for a color in the document color
preferences.
ColorName Name of the document color to set.
R The red color value 0-15.
G The green color value 0-15
B The blue color value 0-15
NewName A new name for the color (optional).
Examples:
DocColorPrefs White 14 14 15
Change the wvalues for the color named White.
DocColorPrefs Green 0 9 0 NEWNAME ‘"Dark Green"‘
Change the values for color Green and rename it Dark Green.
DocltemPrefs

"Tabs/K,Decimal/K,DateFormat/K,DateOreder/K, TimeFormat /K, PROMPT/S"
Change the options in the document item preferences.

Tabs

Decimal

DateFormat

Change the default tab stops in ruler or micropoints
(0.125 - 10.0 inches).

the decimal character for use in numbers.
one of the following:

Use the period ‘.‘ character.

Use the comma ', ' character.

Change
Choose
Period
Comma

Change the format to use in date strings.
Choose one of the following:

07/22/92
Jul 22,
July, 22, 1992
Mon, Jul, 22,
Monday, July,

1992

1992
22,

g w N

1992
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DateOrder

Change the order in which the month day and year appear
in strings.
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TimeFormat

PROMPT

Examples:

Choose one of the following
MDY Month Day Year
YMD Year Month Day
DMY Dar Month Year

Change the format to use for time strings.
Choose one of the following.

12 12 hour format

24 24 hour format

Specify to present the document item requester (all
other arguments ignored).

DocItemPrefs Tabs 1.0

sets the de
DocItemPrefs D
sets dates
DocItemPrefs P

faut tab stop ti be 1 inch.
ATEFORMAT 1 DATEORDER MDY
to appear as "5/15/93".
ROMPT

presents the requester.

DraftprintPrefs

"Top/K,Bottom/K, Left/K,Right/K,First/K, LinesPerPage/K,Pitch/K,Quality

/K, Spacing/

Kll

Change the draft print preferences.

Top
Bottom
Left
Right

First

LinesPerPage

Pitch

Quality

Spacing
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Examples:
DraftPrintPref
DraftPrintPref

Number of lines for the top matgin.

Number of lines for the bottom margin.

Number of character spaces for the left margin.
Number of character spaces for the right margin.

Number of character spaces for the first margin (aka
indent) .

Total number of lines on a page.

Print pitch. Choose one of the following:
Pica, Elite, Fine.

Print quality. Choose one of the following:
Draft, Letter.

Printer line spacing in lines per inch.
Choose one of the following:

Six, Eight.

age 13-16

s TOP 6 BOTTOM 6 LEFT 10 RIGHT 70
s PITCH Pica QUALITY Letter SPACING Eight.

DrawBox "Page/A,Left/A,Top/A,Width/A,Height/A,BEVEL/S"

Draw a box u

sing the current box settings. The box will become the




165 /239

current object. Result will contain the object ID of the new box. Use
the Redraw command to show the image and reformat any text.

Page
Left

Top
Width
Height
BEVEL
Examples:

DrawBox 1
DrawBox 1

Page number to draw the shape on (starting from page 1).
Left horizontal position in ruler or micropints.

Top vertical position in ruler or micropoints.

Width of box in ruler or micropoints.

Height of box in ruler or micropoints.

Specify to draw a devel box (rounded corners).

2
3

3.5 2.5
11

1
2 BEVEL

DrawLine "Page/A,X1/A,Y1/A,X2/A,Y2/A, ARROWS/S"
Draw a line using the current line settings. The line will become the
current object. Results will contain the object ID of he new line.
Use the Redraw command to show the image and reformat any text.

Page
x1

vyl

X2

y2

Page number to draw the shape on (starting from page 1).
Beginning horizontal position in ruler or micropoints.
Beginning vertical position in ruler or micropoints.
Ending horizontal position in ruler or micropoints.

Ending vertical position in ruler or micropoints.
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ARROW

Examples:

DrawLine 1 1
DrawLine 1 3

Specify to draw an arrow line. The arrow tip is at the
ending position (x2, y2).

1 2
1 1

2
.5 1.75 1.5 ARROW

DrawOval "Page/A,Left/A,Top/A,Width/A,Height /A"
Draw an oval using the current using the current oval settings. The
oval will become the current object. Result will contain the object
ID of the new oval. Use the Redraw command to show the image and
reformat any text.

Page

Left

Top

Width

Page number to draw the shape on (starting from page 1).
Beginning horizontal position in ruler or micropoints.
Beginnin horizontal position in ruler or micropoints.

Horizontal diameter in ruler or micropoints.
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Height Vertical diameter in ruler or micropoints.

Examples:
DrawOval 1 2 2 1 1.5

DrawTextItem "Page/A,Left/A, Top/A, Text/A/F"
Draw a text block object using the current text block settings. The
text block will become the current object. Result will contain the
object ID of the new text block. The width and height of the text
will be set by the program based on the size of the font and width of
the characters. Use the Redraw command to show the image and reformat

any text.

Page Page number to draw the shape on (starting from page 1).

Left Left horizontal position in ruler or micropoints.

Top Top vertical position in ruler or micropoints.

Text The text to go into the text block (up to 30 characters).
Examples

DrawTextBlock 1 2 1 "Hello there"
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EditBibliography
Present the edit bibliography requester.

EditBody
Switch to edit the document’s body pages.
See also EditLeftMaster, EditRightMaster.

EditEndNotes
Presents the edit endnotes requester.

EditIndexList
Presents the edit index requester.

EditLeftmaster
Switch to edit the document’s left master page.
See also EditBody, EditRightMaster.

EditRightmaster
Switch to edit the document’s right master page.
See also EditBody, EditLeftMaster.

EditNotePrefs "Title/K,Names/K,Format/K, Indent/K,Marker/K"
Change the endnote section creation settings.

Title Change the endnote title option.
Choose one of the following.
Yes 1Include the endnote title when creating the endnote
section.
No Do not include title.

Names Change the section names option.
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Choose one of the following.
Yes Show section names in endnote list.
No Don’t show section names in list.

Format Change the indenting format.
Choose one of the following.
FlushLeft Lines even with left margin.
FlushHang First line even with left margin, subsequent
lines indented.
Indented First line indented, subsequent lines even with

left margin.

Indent Amount to indent in ruler or micropoints (.125 to 5 inches).
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Marker Change the marker style
Choose on of the following:

Superscript Superscript the endnote markers.

Normal Don’t superscript markers.
Examples:
EndNotePrefs TITLE Yes NAMES No FORMAT Indented INDENT .5 MARKER
Normal.

EndNotePRefs INDENT .25

Extract

Get the text of a selected range or the next character into Result. If
there is a selected range, the text of the range is placed into the
Result. Paragraphs will be separated by a newline character (ASCII 10
or 0x0A). If a range is not selected, the character after the
insertion point will be placed into Result. If the insertion point is
at the end of a paragraph, a newline character will be returned.

Find "String/F"

If the requester is not open, then present the find requester. If the
String is given, then open the requester with the given text string.
If the find requester is already open, then search for the given
string.

See Also FindNext, SetFind.

String The text String to search for
Examples:

Find
Find "Final Writer"

FindCursor

Scroll the document to the location of the insertion point.

FindNext

Find the next occurrence of the text string specified in the Find
requester (The find requester must be open).
See also Find, SetFind.

FindReplace
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Present the Find/Replace requester.

FirstObject "SELECTOR/S"

Return in Result the object ID of the first graphic object. If there
are no graphic objects, then Result will be set to 0. Is SELECTED
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is specified then Result will be set to the ID of the first selected
object.
See Also CurrentObject, NextObject.

Examples:
FirstObject
FirstObject SELECTED.

Font "FontName/F"

Present the font requester to change to a different font of skip the

requester by specifying a font to change to.

FontName If a font is specified, change to this font without the
font requester. The fontname can be just the font name or
it can be a full font path name. If there is not a path
name, then the font is looked for in the
FWFonts/SWolfFonts drawer.

Examples:

Font

Font "SoftSans_BoldItalic"

Font "Work:SoftFaces/Rageltalic"

FontColor "ColorName/F"

Present the font color requester to change the font color.

ColorName If specified, change the font color to ColorName without
requester.

Examples:

FontColor

FontColor Red
FontColor Black

FontSize "PointSize"

Present the font size requester to change the font size.

PointSize If specified, change the font size to PointSize without
requester.

Examples:

FontSize

FontSize 24
FontSize 10

GetASCIIPRefs

"ParaNewLine/S,ParaBlankLine/S, InsertNewLine/S, InsertBlankLine/S/"
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Return in Result the specified ASCII I/O preference settings.
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See the ASCIIPrefs command for the values returned.

Examples:
GetASCIIPrefs PARANEWLINE INSERTNEWLINE
might return "Yes No"

GetBibPrefs "Title/S,Indent/S"
Return in Result the specified bibliography creation preferences.
See the BibPrefs command for the values returned.

Example:
GetBibPrefs TITLE INDENT
might return "Yes 0.5"

GetBoxPrefs
"TextFlow/S,FlowDist /S, NewLineWt/S, LineColor/S,Fi11/S,FillColor/s"
Return in Result the specified box drawing preferences.

See the BoxPrefs command for the values returned.

Example:
GetBoxPrefs LINEWT LINECOLR FILL FILLCOLOR
might return "2 Black Solid Red"

GetDisplyPrefs
"Horizontal/S,Vertical/S,Guides/S,Rulers/S,Measure/S, Shading/S,
WBDocColor/S"

Return in Result the specified display preferences.
See the DisplayPrefs command for the values returned.

Examples:
GetDisplayPrefs HORIZONTAL VERTICAL
might return "80 72".
GetDisplayPrefs GUIDES
might return "PEH"

GetDocColorPrefs "ColorName/A"
Get the red green blue (RGB) color values for the named document
color.
ColorName Name of the document color to get the RGB values for.
Examples:
GetDocColorPrefs Black

might return "0 O O"

GetDocColorPrefs White
might return "15 15 15"

GetDocColorPrefs Brown
might return "10 5 2"
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GetDocItemPrefs
"Tabs/S,Decimal/S,DataFormat/S,DateOreder/s, TimeFormat/S"
Return in Result the specified document item preferences.
See the DocItemPrefs command for the values returned.

Examples:
GetDocItemPrefs DATEFORMAT DATEORDER TIMEFORMAT
might return "2 MDY 24"

GetDraftPrefs
"Top/S,Bottom/S, Left/S,Right/S,Fist/S, LinesPerPAge/S,Pitch/S,
Quality/S, Spacing/S
Return in Result the specified draft print preferences.
See the DraftPrintPrefs command for the values returned.

Examples:

GetDraftPrefs TOP BOTTOM LEFT RIGHT
might return "6 6 10 70"

GetDraftPrefs PITCH QUALITY SPACING
might return "Pica Letter Eight".

GetEndNotesPrefs "Title/S,Names/S,Format/S, Indent/S,Marker/S"
Return in Result the specified endnote creation preferences.
See the EndNotePrefs command for the values returned.

Examples:
GetEndNotePrefs FORMAT MARKER

might return "FlushHang Superscript".
GetEndNotePrefs INDENT

might return "0.25".

GetGEFXPrintPrefs
"Density/S, Threshold/S,Color,Correct/S,Dithering/S, Shading/S"
Return in Result the specified graphics print preferences.
See the
GFXPrintPrefs command for the values returned.

Examples:

GetGFXPrintPrefs DENSITY THRESHOLD
might return "4 12"

GetGFXPrintPrefs COLORCORRECT SHADING
might return "GB Color"

GetImportPrefs
"TextFlow/S,FlowDist/S, LineWt/S,LineColor/S,Fi11/S,Linked/S,Display/S"
Return in Result the specified graphics import preferences.
See the ImportPrefs command for the values returned.
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Examples:
GetImportPrefs TEXTFLOW FLOWDIST LINEWT LINECOLOR
might return "LeftVert .25 2 Black"
GetImportPrefs FILL LINECOLOR
might return "Transparent Blue".

GetIndexList "Seperator"
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Get a list of all the index entries into Result

Seperator Specify a character to sperate the index entries. If not
specific, the entries will be separated with a newline
character (Decimal 10, Hex 0xO0A).

Examples:
GetIndexList
Retrieve the index list each entry separated by a newline.
GetIndexList "#"
Each entry separated by the number sign character.
GetIndexList D2C(9)
Each entry separated by a tab. (D2c is an internal ARexx function
which converts decimal numbers to a character. Tab is decimal 9.)

GetIndexPrefs "Title/S,Headers/S"
Return in Result the specified index creation preferences.
See the IndexPrefs command for the values returned.

Examples:
GetIndexPrefs TITLE HEADERS
might return "Yes No"

GetLinePrefs "TextFlow/S,FlowDist/S,LineWt/s,LineColor/S"
Return in Result the specified line drawing preferences.
See the LinePrefs command for the values returned.

Examples:
GetLinePrefs TEXTFLOW FLOWDIST LINECOLOR
might return "LeftVert .25 Black".

GetObjectCoords "ObjectId"
Return in Result the coordinates for the current or a specific
graphic object. The coordinates are returned as a string with the
format: "Page Left Top Width Height2 for boxes, ovals, images. The
coordinates will be in ruler or micropoints. The object specified
will become the current object.
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Objectid ObjectID for the object to get coordinates for. If
objectid is not specified or is 0, then the command will
return the parameters for the current object.

Examples:
GetObjectCoords

might return "1 2 2 5 4"
GetObjectCoords 4

might return "3 1 3 1.5 2.75"

GetObjectParams
"Objectid/S, TextFlow/S,FlowDist/S,LineWt/S, LineColor/S,Fill/sS,
FillColor/S,Linked/S,Display/S"
Return in Result the requested parameters for the current or a
specific graphic object. The object will become the current object.
(Not available for group objects.)
See the SetObjectParams command for the values returned.
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Objectid

Examples

GetObjectParams
might return
GetObjectParams
might return

Object ID for the object to get parameters for. If

objectid is 0, then the command will return the
parameters for the current object.

0 LINEWT LINECOLOR FILL FILLCOLOR
"4 Blue Solid Red".

4 TEXTFLOW LINKED

"LeftVert no"

GetObjectRotation "Objectid"
Return in Result the title of the specified graphic object. The
object will become the current object.

Objectid The

Examples

ID of the graphic object to get rotation of. If
objectid is not specified or it is 0, then return the
rotation for the current object. The object specified will
become the current object.

GetObjectRotation 4

GetObjectTi

Objectid

tle "Objectid"
Return in Result the title of the specified graphic object. The
object will become the current object.

The

ID of the graphic object to get title of. If
objectid is not specified or it is 0, then the
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Examples
GetObjec

command will return the title for the current object.

tTitle

GetObjectTitle 4

GetObjectTy

Objectid

pe "Objectid"
Return in Result the type of the specified graphic object. The
object will become the current object.

The object ID of the graphic to get the type of. If not
specified or is 0, then the command will return the type
for the current object. The object specified by the
Objectid will become the current object.

The possible return values are as follows:

The
- The
— The
- The
The
- The
- The
- The

0 J oy Ul W
|

object
object
object
object
object
object
object
Object

is
is
is
is
is
is
is
is

an Imported Graphic File i.e. ILBM or EPS.
a line.

an arrow tipped line.

a Box.

a Bevelled Box.

an Oval.

a text block.

a group of other objects.
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Examples:
GetObjectType 0
GetObjectType 8

GetObjectTypeSpecs
"Objectid/S,Size/S, Leading/S,Width/S,0Oblique/S, position/S, Case/S,
Style/S,Color/S,Font/S"
Return in Result the specified text block type specification for a
text block object. The object will become the current object.
See the TextBlockTypePrefs command for the wvalues returned.

Objectid The Id of the object to get type specs for. If 0, then
get the current object.

Examples:
GetObjecttypeSpecs 0 SIZE WIDTH COLOR
might return "12 100 Black".
GetObjecttypeSpecs 4 SIZE FONT
might return "24 Work:PSFont/Courier".

GetOutlinePrefs "Title/S,Format/S, Indent/S"
Return in result the specified outline creation preferences.
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See the OutlinePrefs command for the values returned.

Examples:
GetOutlinePrefs TITLE FORMAT INDENT
might return "Yes Roman 0.5"

GetOvalPrefs
"TextFlow/S,FlowDist/S,LineWt/S,LineColor/S,Fill/S,FillColor/S"
Return in Result the specified oval drawing preferences.
See the BoxPrefs command for the values returned.

Examples:
GetOvalPrefs LINEWT LINECOLOR FILL FILLCOLOR
might return "2 black Solid Red".

GetPageSetup
"Pagetype/S,Width/S,Height/S,Orient/S,Pages/S,PrinterType/S, Top/S,
Bottom/S,Left/S,Right/S, Number/S, FirstPage/S"

Return in Result the specified page setup preference.
See the PageSetup command for the values returned.

Examples:
GetPageSetup WIDTH HEIGHT
might return "8.5 11.0".
GetPageSetup TOP BOTTOM LEFT RIGHT
might return "0.1875 .375 .25 .25"
GetPrintSetup
"Copies/S, Sections/S,Pages/S,FormPage/S, ToPage/S,Collate/S,Order/S,
PrintTo/S,Feed/S"
Return in Result the specified print preferences.
See the PrintSetup command for the value returned.
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Examples:
GetPrintSetup COLLATE ORDER PRINTTO FEED

might return "All FrontToBack PSFile SingleSheet".
GetPrintSetup COPIES PAGES FROMPAGE TO PAGE

might return "4 Range 5 10".

GetPSPrintPrefs
"Port/S, Shade/S,Download/S,Halftone/S,LPI/s,Angle/S, Spot/S, Thumbnails/
S,Scale,Cropmarks/S,PageType/S, CustomWidth/S, CustomHeight /S, Orient/S"
Return in Result the specified postscript print preferences.
See the PSPrintPrefs command for the values returned.

Examples:
SetPostPrefs PORT
might return "Serial".
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GetPostPrefs HALFTONE LPI ANGLE SPOT
might return "Custom 60 45 RoundDot".

GetSectionList "Separator”
Return in Result a list of the document ‘s section names.

Separator Specifies a character to sperate the section names. If
not specified, then the entries will be separated with a
newline character (Decimal 10, Hex 0xO0A).

SetSectionSetup
"Section/S,Names/S, Top/S,Bottom/S, Inside/S,Outside/S, PagePrefix/S,
FirstPage/S,PageNumFormat/S, Columns/S, ColumnGap/S, Header/S,Footer/S"

Return in Result the specified section preferences.

Section The name of the section to get info for. If section is
not specified, then information is returned for the
current section.

Name The name of the section.
See the SectionSetup command for other values returned.

Examples:
GetSectionSetup NAME PAGENUMEFORMAT
might return "Index RomanUpper".
GetSectionSetup TOP BOTTOM INSIDE OUTSIDE
might return "1.0 1.0 0.5 0.5".

GetTextBlockPrefs "TextFlow/S,FlowDist/S, Text/S"
Return in Result the specified text block drawing preferences.
See the TextBlockPrefs command for the values returned.

Examples:
GetTextBlockPrefs TEXT
might return "Hello World".

GetTextBlockText "Objectid"
Return in Result the text of the specified text block.
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The object will become the current object.

Objectid The ID of the object to get the text of. If Objectid is
not specified or is 0, then get the text of the current
object.

Examples:
GetTextBlockText 2
might return "Hello World".
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GetTextBlockTypePrefs

Size/S,Leading/S,Width/S,Oblique/S,Position/S,Case/S, Style/S,Color/S,
Fonts/S"

Return in Result the specified text block type preferences.

See the TextBlockTypePrefs command for the values returned.

Examples:
GetTextBlockTypePrefs SIZE WIDTH COLOR
might return "12 100 Red".
GetTextBlockTypePrefs SIZE COLOR FONT
might return "24 Black Work:FWFonts/SWOLFonts/SoftSans".

GetTOCPrefs "Title/S,Level/S"

Return in Result the specified table of contents preferences.
See TOCPrefs command for the values returned.

Examples:
GetTOCPrefs command for the values returned.
might return "Yes No Yes".

GfxPrintPrefs

"Density/K, Threshold/S,ColorCorrect/K,Dithering/K, Shading/K"
Change the graphic print preferences.

Density Print density 1-7

Threshold Print threshold 1-14

ColorCorrect Color correction mode. Combination of the letters R, G,

and B. Specify R for red, B for blue, and G for green
correction. Specify any other character to turn Red,
Green, and Blue all off. For example "RGB", "GB", "B",
etc., to turn on color corrections or "X" to clear all
colour corrections.
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Dithering Change the dithering method. Choose one of the following:

Ordered Use ordered dithering.
Halftone Use halftone dithering.

Shading Change the shading mode. Choose one of the following:
BlackWhite Print in black and white.
GreyScale Print in grey scale.
Color Print in color.
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Examples:
GfxPrintPrefs DENSITY 4 THRESHOLD 5
GfxPrintPrefs COLORCORRECT RB SHADING Color

GoToPage "Page"
Scroll the document to another page. Note: this does not change the
location of the insertion point, it Jjust changes which page is in

view.

Page Scroll the document to this page. If page is not specified,
then present the "Go TO Page" requester.

Examples:

GoToPage

GoToPage 5

GoToSection "SectionName/A/F"
Switch to another existing section in the document.

Section The name of the section to switch to.

Examples:
GoToSection Index

GraphicTool
Make the graphic select tool the current tool. The graphic tool must
be they current tool to perform Cut, Copy, and Clear commands with
graphic objects. The current selected graphic objects will not be
selected.
See also TextTool.

Group
Put all selected objects into a group. All objects in the group will
act as a single graphic object. The group will become the current
object.
See also Ungroup.
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HotZone "Zone/a"
Change the hyphenation zone for the current or selected paragraphs.

Zone Hyphenation hot zone specified in ruler or micropoints.

Examples:
HotZone 0.5

Hyphen "Status"
Turn hyphenation on or off for the current or selected paragraphs.

Status The hyphenation status. If not specified the n hyphenation
is turned on. Choose one of the following:
On Turn hyphenation on.
Off Turn hyphenation off.

Examples:
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Hyphen
Hyphen OFF
ImportPrefs
"TextFlow/K,FlowDist/K, LineWt/K, LineColor/K,Fill/K, Linked/K, Display/K,
PROMPTS/S"
Change the graphic import preferences.
TextFlow Change the text flow option. Choose one of the following:
LeftVert Set to left vertical.
LeftCont Set to left contour.
RightVert Set to right vertical.
RightCont Set to right contour.
None Set to no textflow.
FlowDist Change the flow distance between graphic and text,
specified in ruler or micropoints (0.025 - 2.0 inches).
LineWt Change the border weight. Choose one of the following:
None, Hairline, .5, 1, 2, 4, 6, 8, 10, 12
LineColor Change the border color to a color specified by a color

ARexx Support

Fill

Linked

Display

Prompt

Examples:

ImportPrefs
ImportPrefs
ImportPrefs

name.
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Change the fill (background) option.
Choose one of the following:

Solid

Transparent

Change the Save/Link option.

Choose one of the following:

Yes Save the entire image with the document.

No Save a link (filenameO to the image with the document.

Change the display option.
Choose one of the following:

Crossbox Display a crossbox.
Preview Display a preview.
Full Display the full image.

Present the import graphic preferences requester ignoring
all other arguments.

TEXTFLOW LeftVert FLOWDIST .25 LINEWT 2 LINECOLR Black
FILL Transparent LINECOLR Blue
PROMPT

Indent "Indent/A"

Change the

Indent

Examples:

paragraph indent for the current or selected paragraphs.

Change the paragraph indent, specified in ruler or
micropoints.
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Indent 0.25
Indent 1.25

IndentLeft

Move the first and left margins of the current or selected paragraphs
to the left by the amount of the default tab setting.
See also IndentRight.

IndentRight

Move the first and left margins of the current or selected paragraphs
to the right by the amount of the default tab setting.
See also Indentleft.

IndexPrefs

"Title/K, Header/K"

Change the index creation preferences.
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Title

Headers

Examples:

Change the index title option. Choose one of the following:
Yes 1Include the index title when creating the index.
No Do not include the index title.

Change the index letter header option.

Choose one of the following

Yes 1Include letter headers when creating the index.
No Do not include the letter headers.

IndexPrefs TITLE No
IndexPrefs TITLE Yes Headers No

Insert "Item/A"
Insert a special item into the document.

Item The item to insert.
Choose one of the following:
Date Insert an auto date string.
Time Insert an auto time string.
PageNumber 1Insert auto page number (Must be editing a master
page.)
MergeField 1Insert a merge field w/requester.
Graphic Import a graphic image using the "import Image"
requester.
Examples:

Insert Date
Insert PageNumber

InsertEndNote
Present requester to insert a new endnote and marker at the insertion

point.

InsertImage "Filename/A,POSITION/S,Page,Left, Top,Width,Height, LINKED/S"
Import a graphic image into the document by passing the import
requester. Result will contain the object ID of the image. The image
will become the current object. Use the Redraw command to draw the
image and reformat any text.
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See also "In
Filename

POSITION

Page

Left

Width

Height

LINKED

Examples:

InsertImage

InsertImage

InsertPageBreak
Insert a pag

age 13-33
set Graphic" command.
Complete path name of the image file.

Optional switch parameter that indicates that the
following five position and size parameters are present.
If not specified, then the program will determine the
size and position of the image.

Page number to place the image on (starting from page 1).

Location of the left edge of the image in ruler or
micropoints. If -1, the program will determine the top
edge.

Width of the image in ruler or micropoints. If -1, the
program will determine the width.

Height of the image in ruler or micropoints. If -1, the
program will determine the height.

If specified, a link to the image will be saved with the
file instead of the image data.

"Work :Bunny" POSITION 2 1.0 3.0 "-1" "-1"

will insert the image on page 2 with left edge at 1 inch,
top edge at 3 inches and width and height determined by
the program.

"Work :Bunny"

will insert the image with the program determining the
size and position of the image.

e break at insertion point.

See also RemovePageBreak.

Justify "Mode/A"

Change the p
paragraphs.

ARexx Support P

Mode The ty
Choose
Left
Right
Center

Examples:
Justify Left

Leading "Leadin
Change the f

aragraph justification for the current or selected

age 13-34

pe of Jjustification.
one of the following:
Set to Left Jjustify.
Set to right justify.
Set to Center justify.

gll
ont leading value.
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Leading Leading value in points (from 4 to 255). If not specified,
then present the font leading requester.

Examples:
Leading 24

LeftMargin "Margin/A"
Change the left margin of the current or selected paragraphs.

Margin Value to set the left margin to in ruler or micropoints.

Examples:
LeftMargin .25
LeftMargin 1.25

LinePrefs "TextFlow/K,FlowDist/K,LineColor/K/PROMPT/S"
Change the line drawing preferences.

TextFlow Change the text flow option.
Choose one of the following:
LeftVert Set text flow to left vertical.
LeftCont Set text flow to left contour.
RightVert Set text flow to right vertical.
RightCont Set the right contour.

None Set to no text flow.

FlowDist Change the flow distance between line and text, specified
in ruler or micropoints (0.025 - 2.0 inches).

LineWt Change the line weight.

Choose one of the following:
None, Hairline, .5, 1, 2, 4, 6, 8, 10, 12
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LineColor Change the line color to a color specified by a color
name.

PROMPT Presents the line setting requester ignoring all other
arguments.

Examples:

LinePrefs PROMPT

LinePrefs LINECOLOR Blue

LinePrefs TEXTFLOW None FLOWDIST .25 LINEWT 2

Lock
Lock the selected graphic objects in place.
See also Unlock.

MoveToLine "Line/A,Pos/A"
Move the insertion point to a line and position within the line. If
the SHIFT status is down , then the text will be selected.
See also ShiftDown, ShiftDown, Cursor, MoveToPara.

Line Line number to move to (starting with 1).
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Pos Offset into the line (0 is at the beginning of the line).

Examples:
MoveToLine 1 0

move the insertion point to the beginning of the document.
MoveToLine 5 10

move the insertion point to offset 10 of the 5th line.

MoveToPara "Para/A,Pas/A"

Move the insertion point to a paragraph and position within the
paragraph. If the SHIFT status is down, text will be selected
See Also ShiftDown, ShiftUp, Cursor, MoveToLine.

Para Paragraph number to move to (starting with 1).

Pos Offset into the paragraph (0 is at the beginning of the
paragraph) .
Examples:

MoveToPara 1 0

moves the insertion point to the beginning of the first paragraph.
MoveToPara 5 10

moves the insertion point to offset 10 of the 5th paragraph.
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MoveWindow "Left/A, Top/A"

Move the document‘'s window to a new location on the screen.
Left Absolute screen pixel of the left edge of the window.
Top Absolute screen pixel of the top edge of the window.

Examples:
MoveWindow 100 50

New

Create a new document window.

NewParagraph

Create a new paragraph at the insertion point. This is the same as
pressing the RETURN key from the keyboard.

NewSection "Type/A,Name/K,BEFORE/S,AFTER/S"

Create a new section. Only one section of each type may be created
except for the Text section type which may have many sections.

Type The type of section to create.
Choose one of the following:
Outline
TitlePage
Preface
Contents
Illustrations
Text
EndNotes
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Bibliography
Index

Name The name for the new section. If not specified, use the
default name. The length of the name must be between 1 and 31
characters.

BEFORE Place the new text section before the current section.
AFTER Place the new text section after the current section.

If neither the BEFORE or AFTER switch is specified the new text
section will be place at the end of the text sections.
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Examples:
NewSection Index
NewSection Text "Chapter 2"

NextObject "Objectid, SELECTED/S"

Return in Result the object ID of the next graphic obiject.
See also Firstobject, CurrentObject.

Objectid Get the ID of the object that follows the object with
this ID. If Objectid is not specified or is 0, then the
object ID of the object following the current object
following the current object is returned. If there are no
graphic objects after the specified object, then Result
will be set to 0.

SELECTED If specified, then the command will set Result to the ID
of the next selected object.

Examples:
NextObject 2
might return 8.
NextObject 4 SELECTED
might return 10.

ObjectToBack "Objectid"

Send a graphic object behind all others. The object will become the
current object. Use the Redraw command to redraw the object.
See also ObjectToFront.

Objectid The ID of the graphic object to send to the back. If an
Objectid is not specified or is 0, send the current
object to the back.

Examples:
ObjectToBack 8

ObjectToFront "Objectid"

Bring a graphic object to the front of all others. The object will
become the current object. Use the Redraw command to redraw the
object.

See also ObjectToBack.
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Objectid The ID of the graphic object to bring to the front. If
an Objectid is not specified or is 0, send the current
object to the front.

Examples:
ObjectToFront 4
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Oblique "Percent"
Change the text oblique angle.

Percent Oblique percent value -20 through 20. If not specified,
present the oblique requester.

Examples:
Oblique
Oblique 5

Open "File/F"
Open a document file.

File The complete path name of the file to open. If a path is
not specified, present the file requester to open a
document.

Examples:

Open

Open "Work:FWDocs/Monthly Report"

OutlinePrefs "Title/F,Format/K, Indent/K"
Change the outline creation settings.

Title Change the outline title option.
Choose one of the following:
Yes 1Include the outline title when creating the index.
No Do not include the outline title.

Format Change the outline numbering format option.
Choose one of the following:
Roman Number the highest level with Roman numbers.
Alpha Number the highest level with Alphabetic
characters.

Indent Set the Indent specification in ruler or micropoints (.125
— 5 inches).

Oval
"TextFlow/K,FlowDist /K, LineWt /K, LineColor/K,Fill/K,FillColor/K, PROMPT/S"
Change the oval drawing preferences. See the BoxPrefs command for

parameter values and meanings.

Examples:
OvalPrefs LINEWT 2 LINECOLOR Black FILL Solid FILLCOLOR Red
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OvalPrefs TEXTFLOW RightVert
OvalPrefs PROMPT

PageSetup

"PageType/K,Width/K, Height /K, Orient /K, Pages/K,Printertype/K, Top/K, Bottom/
K, Left/K,Right /K, Number/K,FirstPage/K, PROMPT/S"
Change the page setup options.

PageType

Width

Height

Orient

Pages

PrinterType

Top

Change the page type.

Choose one of the following:
USLetter Use US Letter paper size.
USLegal Use US Legal paper size.

A3 Use A3 paper size.
A4 Use A4 paper size.
A5 Use A5 paper Size.
B5 Use B5 paper size.
Custom Use a custom page size.

Change the custom page width. This value is ignored
unless a page type of custom is specified or the page
type is already set to Custom.

Change the custom page height. This wvalue is ignored
unless a page of custom is specified or the page is
already set to Custom.

Change the page orientation.
Choose on of the following:
Tall Set the orientation to tall.
Wide Set the orientation to wide.

Change pages to be right only or left and right.
RightOnly Use right pages only.
LeftRight Use left/right pages.

Choose on of the Print area’s printer types:
Laser

Deskjet

Sheetfed

Continuous

Other

Change the print area’s top margin, specified in ruler
or micropoints.

ARexx Support Page 13-40

Bottom

Left

Right

Change the print area’s bottom margin, specified in
ruler or micropoints.

Change the print area’s left margin, specified in ruler
or micropoints.

Change the print area’s right margin, specified in ruler
or micropoints.
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Number Number the document page using one of the following:
ByDocument Number by document.
BySection number by section.

FirstPage Change the document’s first page number.

PROMPT If specified then present the page setup requester

ignoring all other arguments.

Examples:

PageSetUp PROMPT

PageSetUp PAGETYPE USLetter ORIENT TALL

PageSetUp TOP .1875 BOTTOM .375 LEFT .25 RIGHT .25

Paragraph
Present the paragraph setting requester.

Paste
Paste text or graphic data on the clipboard into the document.
See also Cut, Copy, Clear.

PasteRuler
Change the ruler settings of the current or selected paragraphs to
the ruler settings from the previous CopyRuler operation.
See Also CopyRuler.

Position "Script/A"
Change the font script.

Script The script to change to.
Choose one of the following:
Normal
SuperScript
SubScript

Examples:

Position Normal
Position SubScript

ARexx Support Page 13-41

PostScriptFile "File/A/F"
Change the file name for printing to a PostScript file.

File The path name for the PostScript file.

Examples:
PostScriptFile "Work:PSPrint"
PostScriptFile "Rad:Report.PS"

Preferences "Pref/A"
Present a preferences requesters.

Pref Which requester to present.
Choose one of the following:
UserMenu User Menu.
ButtonStrip User Button Strip.
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Display Display.

ASCIT ASCII I/O.

Startup Startup.

Speller Speller & Hyphenation.
Hyphenation Speller & Hyphenation.
Document Document Item.

Color Document Colors.
ScreenColor Screen Colors.

DocumentSave Document Save.

Examples:

Preferences Display

Preferences Speller

Print "PROMPT/S"

Print using the current settings and by-passing the print requester.

PROMPT

Examples:
Print

If specified, then the print requester will be presented
before printing.

Print PROMPT

PrintSetup

"Copies/K, Section/K,Pages/K, FromPage/K, ToPage/K,Collate/K,Order/K,PrintTo

/K,Feed/K"

Change the current print settings.

Copies

Section

ARexx Support

Pages

FromPage
ToPage

Collate

Order

PrintTo

Change the number of copies to be printed.

Change which section to print. Specify the section name or

"Al11l" to print all sections.
Page 13-42
Change the range of pages to print

Choose one of the following:
All Print all pages.

Range Print a range of pages from FromPage to ToPage.

When range is chosen start printing from this page.
When range is chosen the last page to print.

Change the collating method.

Choose one of the following:

All Print all pages.

0ddOnly Print only odd numbered pages.
EvenOnly Print only even numbered pages.

Change the order to print the pages.

Choose one of the following:

FrontToBack Print pages from front to back.
BackToFront Print pages back to front.

Change the type of printer to print to.
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Choose one of the following.

GfxPrinter Print to a graphic printer in Final Mode.
Draftprinter Print to a graphic printer on Draft Mode.
PSPrinter Print to a PostScript printer.
PSFile Print to a PostScript file.
Feed Change the printer’s paper feed type.
Choose one of the following:
Continuous Printer is using continuous (tractor) feed.
SingleSheet Printer is using single sheet feed.
Examples:

PrintSetUp COPIES 3 SECTION ALL PRINTTO GFXPRINTER
will setup to print 3 copies of all sections to a graphics printer.
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PrintSetup ORDER BackToFront
will setup to printer the pages in reverse order.

PSPrintPrefs
"Port /K, Shade/K,Download/K,Halftone/K,LPI/K,Angle/K, Spot/K, Thumbnails/K,
Scale/K,CropMarkers/K, PageType/K, CustomWidth/K, CustomHeight /K, Orient /K"

Change the PostScript print preferences.

Port Change the port the printer is connected to.
Choose one of the following:
Parallel
Serial
Shade Change the print shading.
Choose one of the following:
GreyScale
Color
Download Change when to download fonts.
Choose one of the following:
Onetime Download a font only once.
EveryTime Download a font everytime the font is used.
Halftone Change the halftoning method.
Choose one of the following:
Default Use the default halftone method.
Custom Use a custom halftone method.

LPI

Angle

Spot

Thumbnails

Change the
Value from

Change the
Value from

Change the
Choose one
Line
RoundDot

Change the

custom halftone lines per inch.
1 to 200.

custom halftone screen function.
-360 to 360.

custom halftone spot function.
of the following:

Use a line spot function.
Use a round dot function.

number of thumbnails to print.




in 188 /239

0,1 Print normal (no thumbnails).
2-16 number of thumbnails to print per page.

Scale Change the scaling percentage. Values from 1 to 100.

CropMarks Change the crop marks.
Choose one of the following.
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Yes Print crop marks.

No Don’t print crop marks.
Pagetype Change the page type.

Choose one of the following.

USLetter

USLegal

A3

A4

A5

B5

Custom
CustomWidth Width of a custom page size.
CustomHeight Height of custom page size.
Orient Change the page orientation.

Choose one of the following.
Tall Use portrait mode.
Wide Use landscape mode.

Examples:
PSPrintPrefs HALFTONE Custom LPI 75 ANGLE 30 SPOT Line
PSPrintPrefs PORT Parallel SHADE GreyScale ORIENT Wide

Quit "Force/S"
Close all windows and quit the program prompting to save changes.

FORCE Close all documents and quit the program no questions
asked.

Examples:

Quit

Quit FORCE

Redraw
Reformat and redraw the document. This command must be used to
reformat and redraw the document after a series of graphic commands
are given to create and/or change graphic objects. Most of the
graphic commands do not update or draw the screen themselves. This
is to improve the performance of doing several graphic operations in
a row.

RemovePageBreaks
Remove a page break from the current paragraph.
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RemoveSection "Name/A,FORCE/S"
Remove a section from the document.

Name The name of the section to remove.
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FORCE Specify to by-pass confirming requesters.

Examples:

RemoveSection Index

RemoveSection Outline FORCE

RemoveSection ’"Chapter Two"’
two sets of quotes are used because of the space in the section
name.

RequestText "Title/A,Prompt/A,Default/F"
Present a string gadget to request information from the user.
Return in Result the text that is entered into the requester.
See also ShowMessage.

Title This string will appear in the requester’s title bar.
Prompt This string will appear above the string gadget.

Default This string will be the initial default string on string
gadget.

Examples:

RequestText ’"Font Size" "Points" "12"’

RequestText ’"Favourite Color" "What is your favourite color?"
"Green" 14

RightMargin "Margin/A"
Change the right margin of the current or selected paragraphs.

Margin Value to set the right margin to in ruler or micropoints.

Examples:
RightMargin .125
RightMargin 1.25

Save"ASCII/S,Filename/F"
Save the document to a disk file.

ASCII If specified and a filename is given, then the document
will be saved as an ASCII file. This switch is IGNORED if
no filename is given. If specified, ASCII must be first
argument.

Filename If filename is NOT given, then save the file to the
current name or present the file requester if the file has
not yet been saved.
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If filename IS given, then save the document to that
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filename. Filename should be a complete path name. If a
file with Filename already exists, then this command will
save the document over the existing file without warning.

Examples:

Save

Save ASCII "rad:MonthlyReport"
Save "Work:FWDocs/monthlyReport"

SaveAs
Present the file requester to save a document to a new file.

ScreenToBack
Send the screen behind all other screens.

ScreenToFront
Bring the screen in front of all other screens.

SectionSetup
"Name/K, NewLine/K, Top/K,Bottom/K, Inside/K,Outside/K, PagePrefix/K,
FirstPage/K,PageNumFormat /K, Columns/K, ColumnGap/K, Header/K, Footer/K,
PROMPT/S"
Change the section setup settings.

Name The section name of the section to change. If not
specified, then the change will be for the current
section.

NewName A new name for the section (no more than 31
characters) .

Top Set the edit area top.

Bottom Set the edit area bottom.

Inside Set the edit area inside.

Outside Set the edit area outside.

PagePrefix Set the page number prefix (no more than 8
characters) .

FistPage Set the first page number.

PageNumFormat Set the page number format.
Choose one of the following:
Normal Normal numbers (1 2 3).
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RomanUpper Upper case Roman numerals (I II III).

RomanLower Lower case roman numerals (i ii iii).

AlphaUpper Upper case alphabetical characters (A B
C).

Alphalower Lower case alphabetical characters (a b

c) .
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Columns Set the number of columns (1-6).

ColumnGap Set the column gap.

Header Set the header margin.

Footer Set the footer margin.

PROMPT Specify to present the section setup requester (all

other arguments ignored).

Examples:
SectionSetup TOP 1 BOTTOM .5 INSIDE .5 OUTSIDE .5
Changes the current section’s edit areas.
SectionSetup NAME Index COLUMNS 3
Changes the section "Index" to have 3 columns.

SelectAll

Select all the text in the section being edited.

SelectObject "Objectid,MULTIPLE/S"

Select (or deselect) graphic objects.

Objectid Deselect any selected objects and select the object
specified by Objectid. The object will become the
current object. If objectid is not specified or is O,
then all graphic objects will be deselected.

MULTIPLE If specified, then the graphic object will be selected
along with any other selected objects as a multiple
selection.

Examples:

SelectObject

deselect all graphic objects.
SelectObject 4
select object with ID of 4.
SelectObject 8 MULTIPLE
select object with ID of 8 along with other selected objects.
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SetFind "Case/K,Wrap/K"

Set various option for the "Find" requester.

Case
Same Characters must be the same case to match.
Ignore Ignore character case during the search.
Wrap
Yes Wrap to the top of the document after coming to
the end.
No Stop at the end of the document.

Examples:
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SetFind CASE Ignore WRAP No

SetMeasure "Mode/A"
Sets the units in which measurements will be given and returned. The
default is set to ruler measurements.

Mode Set the measurement mode.
Choose one of the following:
Micropoints Measurements will be given and accepted in
micropoints. (720 micropoints = 1 inch).

Ruler Measurements will be given and accepted in
the measurement system that the rulers are
set to either inches, centimeters, or picas.

Examples:
SetMeasure Ruler
SetMeasure Micropoints

SetObjectCoords "Objectid/A,Page/A,Left/A, Top/A,Width/A,Height/A"
Change the coordinates (size and position) of a graphic object.

Objectid The object ID of the graphic object to change. The
object will become the current object. If Objectid is
0, then the current object will be changed.

Page Page to move object to (starting from page 1).
Left (X1) Left edge position in ruler or micropoints.
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(Horizontal coordinates of the beginning point of a
line.)

Top (Y1) Top edge position in ruler or micropoints. (Vertical
coordinates of the end point of a line).

Width (X2) Width of graphic in ruler or micropoints. (Horizontal
coordinate of the end point of a line).

Height (Y2) Height of graphic in ruler or micropoints. (vertical
coordinate of the end point of a line

Examples:

SetObjectCoords 2 1 1.5 2.0 4.0 5.25
set object 2 to page 1, left edge at 1.5 inches, top edge at 2.0
inches width of 4.0 inches and height to 5.25 inches.

SetObjectParams
"Objectid/A, TextFlow/K,FlowDist/K, LineWt/K, LineColor/K,Fill/K,FillColor/K
,Linked/K,Display/K"
Change the parameters of a graphic object. The object will become
the current object.

Objectid Object ID of the graphic object to change the current
object.
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TextFlow

FlowDist

LineWt

LineColor

Fill

Change the text flow option of the object.
Choose one of the following:

LeftVert Set to left vertical.

LeftCont Set to left contour.

RightVert Set to right vertical.
RightCont Set to right contour.

None Set text flow to none.

Change the flow distance between the object and text,
specified in ruler or micropoints (0.025 - 2.0 inches).

Change the line weight of the object.
Choose one of the following:

None, Hairline, .5, 1, 2, 4, 6, 8, 10, 12

Change the line color of the object to a color specified
by a color name.

Change the fill (background) option. This
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FillColor

Linked

Display

Examples:

Option is ignored for the line objects.
Choose one of the following:

Solid Set fill to solid.
Transparent Set fill to transparent.

Change the fill color of the object to a color specified
by a color name. This option is ignored for all but boxes
and oval objects.

Change the Save/Link option. This option is ignored for
all but image files.
Choose one of the following:

Yes Save the graphic image with the document.
No Save a link (filename) to the image with the
document.

Change the display option. This option is ignored for all
but image files.

Choose one of the following:

Crossbox Display a crossbox.

Review Display a preview

Full Display the full image.

SetObjectParams 0 TEXTFLOW LeftVert
SetObjectParams 0 LINEWT 10 LINECOLOR Red FILL Solid FILLCOLOR Blue

SetObjectRotation "Objectid/A,Degrees, DELTA/S"
Set the rotation of the selected graphic objects. Note that imported
graphics will not be rotated.

Objectid

The ID of the object to rotate. If 0 is specified, then
rotate the current selected objects. The specified
objects will become the current object.
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Degrees the angle in degrees to rotate the object to. (0 to 360
degrees) . If the DELTA switch is specified, this is the
number of degrees to rotate the object from its current
rotation (-360 to 360). Id Degrees is not specified then
present the "Rotate Graphic To" requester or the "Rotate
Graphic" requester to rotate the object.
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DELTA If specified, then the object will be rotated from its
current rotation.

Examples:
SetObjectRotation 0 45

will rotate current objects to 45 degrees.
SetObjectRotation 4 10 DELTA

will rotate object with ID 4 an additional 10 degrees.

SetObjectTitle "Objectid/A,Title/A/F"
Set an object’s title which will appear in the table of
illustrations. The object will become the current object.

Objectid The object ID of graphic object to change. If 0, use
current object.

Title The text to become the new title (up to 32 characters).

Examples:
SetObjectTitle 4 "Monthly Sales Figures"

SetObjecttypeSpecs

"Objectid/A, Size/K, Leading/K,Width/K,Oblique/K, Position/K, Case/K, Style,

Color/K,Font/K/F"

Objectid The object OD of the object to change. If 0, change the

current objects.
See TextBlockTypePrefs for the other command options.
Currently Position,Case and Style options have no effect
on the object.

Examples

SetObjectTypeSpecs 0 SIZE 24 WIDTH 120 Color Blue
SetObjectTypeSpecs 4 SIZE 36 FONT "SoftSerif"
SetObjectTypeSpecs 2 FONT "Work:TypelFonts/Bodoni"

SetTab "Position/A, Type/A"
Set a tab stop in the current or selected paragraphs.

Position Position in ruler or micropoints of the new tab stop.

Type The type of tab stop.
Choose from one of the following:
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Left Set a Left Tab.
Right Set a Right Tab.
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Center Set a Center Tab.
Decimal Set a Decimal Tab.

Examples:
SetTab 3.75 Left

SetTextBlockText "Objectid/A, Text/A/F"
Set a text block’s text.

Objectid The object ID of the object to change. If 0, then set
text of the current object.

Text the new text for the text block. (Up to 31 characters).

Examples:
SetTextBlockText 0 "Hello World"

ShiftDown
Used with "Cursor" command. Set SHIFT key status DOWN.
See also AltDown, AltUp, CtrlDown, CtrlUp, ShiftUp.

ShiftUp
Used with "Cursor" command. Set SHIFT key status Up.
See also AltDown, AltUp, CtrlDown, CtrlUp, ShiftDown.

ShowMessage
"DefBut /A, Beep/A, Text1l/A, Text2/A, Text3/A, ButText1l/A, ButText2/A,
ButText3/A"
Display a message requester to the user and return a response in
Result. Result will be the number of the button that was selected.
The requester may have up to three lines and up to three buttons.

DefBut The default button number starting from left 1, 2, or 3.

Beep 0 = no beep. 1 = display beep.

Textl First line of text.

Text2 Second line of text or empty string if not used.
Text3 Third line of text or empty string if not used.
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ButTextl Text for first button.
ButText2 Text for second button or empty if not used.
ButText3 Text for third button or empty if not used.

Examples:

ShowMessage 1 1 ’'"Text Line 1" "Text Line 2" "Text line 3" "Buttonl"

"Button2" "Button3"’

ShowMessage 2 0 ’'"Do you want to continue" "or halt the operation?"

nn Hcontinue" "Halt" mwwr

ShowRulers "Mode/A"
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Show or hide the document rulers.

Mode Which rulers to display.
Choose on of the following:
None Hide all rulers.
Top Show only top ruler.
All Show top and left ruler.

Examples:
ShowRulers Top
ShowRulers None

SizeWindow "Width/A, Height/A"
Change the width and height of a document window.
See also ChangeWindow, MoveWindow.

Width Width of the window in absolute screen pixels.
Height Height of the window in absolute screen pixels.

Examples:
SizeWindow 500 300

Sort "Method"
Sort the paragraphs in a selected range.

Method The sort method. If Method is not specified, then sort will
be from low to high.
Choose one of the following:
LowToHigh Sort from low to high (abc).
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HighToLow Sort from high to low (cba).

Examples:
Sort LowToHigh

Spacing "Spacing/A"
Change the line spacing of the current or selected paragraphs.

Spacing The spacing method.
Choose one of the following:
Single Single spacing.
OneHalf One and a half spacing.
Double Double spacing.
Variable Variable - use leading value.

Examples:
Spacing Double

Speller
Present the speller requester.

Statistics
Present the statistics requester.
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Status "Option/A,Extral

Return in Result information for various options.

Option What to get status on.
See below for a list of the available options.

Style "Style/A"

Change the font style.

Style Change the font style.
Choose one of the following:
Normal Normal
Underline Underline
DUnderline Double underlined.
StrikeThru Strike through.

Examples:
Style Underline
Style Normal

StyleSheet "StyleName/A/F"
Change the style sheet for the current or selected paragraphs or
present the style define requester to define or change a style.

StyleName Change paragraph style to the named style sheet. If
StyleName is "Define", then the style definition
requester will be presented.
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Examples:
StyleSheet Define
StyleSheet "No Styl

5

e"

StyleSheet "Sub Topic 1"

TextBlockPrefs "TextFlow/K, TextFlow/K, Text/K/F,PROMPT/S"
drawing preferences.

Set the text block

TextFlow Change
Choose
Left
Right
None

the
one
Set
Set
Set

FlowDist Change the

micropoints

text flow around the text block.
of the following:

text flow to left

text flow to right.

text flow to none.

flow distance, specified in ruler or
(0.025 = 2 inches).

Text The text to appear in the text block (Up to 31

characters.

PROMPT Present the text block settings requester, ignoring all
other arguments.

Examples:

TextBlockPrefs TEXTFLOW Left TEXT "SoftWood"

TextBlockTypePrefs
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"Size/K, Leading/K,Width/K,Oblique/K,Position/K, Case/K,Style/K,Color/K,

Font/K/F"

Set the text block drawing type specs preferences.

Size
Leading
Width
Oblique

Position

Case

Style

ARexx Suppor

Color
Font

Examples

Change
Change
Change
Change
Change

Choose
Normal

Superscript

the

the

the

the

the
one

SubScript

Change
Choose
Normal

the
one

SmallCaps

AllCaps

Change
Choose
Normal

the
one

Underline

t Page 56

DUnderline
StrikeThru

Change

Change

the

the

font size (4

font leading

font width (4

- 360).

(4 — 255).

- 255).

font oblique percent (=20 20).

font script.
of the following:

font case.
of the following:

Set the case to Normal.

Set the case to Small Caps.
Set the case to All Caps.

font style.
of the following:

Normal.

Underlined.

Double underlined.
Strike through.

font color to the specified color name.

font to the specified colour name.

TextBlockTypePrefs SIZE 24 WIDTH 120 COLOR Blue
TextBlockTypePrefs SIZE 36 FONT "S
TextBlockTypePrefs FONT "Work:TypelFonts/Bondoni"

TextTool

oftSans"

Make the text tool the current tool. The text tool must be the
current tool to perform Cut,
selected graphic objects will become deselected.

See Also GraphicTool.

Thesaurus

Copy,

Present the thesaurus requester.

TOCPrefs "Title/K,Level/K"
Change table of contents creation settings.

Title

and Clear commands with text.

Change the table of contents title option.
Choose one of the following:

All
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Yes 1Include the table of contents title when creating the
table of contents.
No Do not include the title.

Level Set the level to begin page numbers with.
Choose 1-3.

Examples:
TOCPrefs TITLE No LEVEL 2

TOIPrefs "Title/K,BlankLine/K, Names/K"
Change the table of illustrations creation settings.

Title Change the table of illustrations title option.
Choose one of the following:
Yes Include the title when creating the Table of
Illustrations.
No Do not include the title.

BlankLine Change the blank line option.
Choose one of the following:
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Yes Separate sections with a blank line.

No Don’t separate with a blank line.
Names Change the section names option.

Choose one of the following:

Yes Show section names in the list.

No Don’t show section names in the list.

Examples:
TOIPrefs TITLE Yes BLANKLINE No NAMES Yes

Type "Text/A/F"
Enter the characters specified into the document at the insertion
point. (Same as typing the characters from the keyboard.)

Text Text to be inserted into the document.

Examples:
Type "Hello world"

TypeSpecs
Present the type specs requester.

Ungroup
Ungroup the selected objects.
See Also Group

Unlock
Unlock selected graphic objects so that they may be moved or
resized.
See Also Lock.

UpdateDate
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Update the auto date string in a selected range of text to the

current date. If no text is selected, then update all the auto date

strings in the current paragraph.

UpdateTime

Update the auto time string in a selected range of text to the

current time. If no text is selected, then update all the auto time

strings in the current paragraph.

View "Size"
Change t

Size

ARexx Suppor

Width "wWidth
Change t

Width

Examples
Width
Width 75
Width No
WinToBack
Send the
See also
WinToFront

Send the
See also

BodytextHeig

Filename

FontCase

FontColor

FontLeading

he view size of the document.

Change the view size. If size is not specified, then set the
view to normal or,

Choose one of the following:

25, 50, 75, 100, 125, 150, 200, 400

t Page 13-58

he font width.
Change the font width to the given value. If not specified
then present the text width requester.

4 -255 Set the width to the percent value.
Normal Set the font width to normal or 100%.

rmal

document window behind all other windows.
WinToFront.

document window to the front of all other windows.
WinToBack.
LIST OF STATU COMMAND OPTIONS:

ht Return the total height of the document’s body text in
ruler or micropoints.

Return the file name of the document (without a path).
See also Status Pathname.

Return the font case of the text at the insertion point
("Normal" "AllCaps" "SmallCaps").

Return the color name of the text at the insertion
point.

Return the leading value of the text at the insertion
point.
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FontName "ID"

Examples:

Status Fontname
Status FontName 4

If "ID" is not specified, return the filename (without
path) of the font at the insertion point. If "ID" is
specified, then return the filename of the
corresponding font. The valid range for "ID" is from 1
to the number of fonts in the document in the document.
See also Status FontPath, Status NumFonts.
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FontOblique

FontPath "ID"

FontPosition

FontSize

FontStyle

FontWidth

HotZone

Hyphen

Indent

Justify

LeftMargin

LineHeight

LinePos

Return the oblique value of the text at the insertion
point.

If "ID is not specified, return the complete pathname
of the font at the insertion point. If "ID" is
specified, then return the filename of the
corresponding font. The valid range for "ID" is from 1
to the number of fonts in the document.

See Also Status FontPath, Status NumFonts.

Return the font position (script) of the text at the
insertion point. ("Normal" "Subscript" "Superscript").

Return the point size of the text at the insertion
point.

Return the font style of the text at the insertion
point. ("Normal" "Underline" "DUnderline" "StrikThru")

Return the font width of the text at the insertion
point.

Return the current paragraph’s hyphenation hot zone in
ruler or micropoints.

Return the current paragraph’s hyphenation status. ("On
"Off") )

Return the current paragraph’s indent in ruler or
micropoints.

Return the current paragraph’s justification. ("Left"
"Right" "Center" "Full").

Return the current paragraph’s left margin settings in
ruler or micropoints.

Return the height of the current line in ruler or
micropoints.

Return the position of the insertion point as "Line

position", Where Line is the line number and Position
on the line. (0 is at the beginning of a line.) If a
range of text is selected, then result is returned as




202 / 239

NumFonts

Page "Insert"

"BegLine BegPosition EndLine EndPosition".
Return the number of fonts opened in the document.
Return the page number currently in view. If "Insert"

is specified, then return the page number that the
insertion point is in.
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Pages

ParaChars

ParaPos

Pathname

PortName
PostScriptFile

RightMargin

Screen

Spacing

ScrollPos

StyleSheet

View

Window

Return the number of pages in the current section.

Return the number of characters in the current
paragraph or the first paragraph of a selected range.
(This is not the number of characters in the range but
rather the number of characters in the paragraph.)

Return the position of the insertion point as "Para
Position", where Para is the paragraph number and
Position is the character beginning of the paragraph.)
If a range of text is selected, then Result is
returned as "BegPara BegPosition EndPara EndPosition".

Return the complete pathname and file name of the
document.

See also Status Filename.

Return the ARexx port name for the document.

Return the filename for printing to a PostScript file.

Return the current paragraph’s right margin settings
in ruler or micropoints.

Return the screen’s width and height as "Width Height"
in screen pixels.

Return the spacing of the current paragraph. "Single"
"one and One Half" "Double" "Variable").

Returns the X Y position of the document at the upper
left corner of the window in ruler or micropoints.

Return the stylesheet name of the current paragraph.

Return the current view size. "25", "50", "75", "100",
n125|v, "150", "150"’ "200", or "400".

Return information about the size and location of the
document’s window as "Left top Width Height MinWidth
MinHeight MaxWidth MaxHeight".

ARexx Support Page 13-61
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1.234 14-0
14 REFERENCES
MENUS OVER VIEW

Project MEeNU v v vttt ittt ettt tneeeeeeennneenn 14-2
e I 1Yo G 14-3
e I 1T o 14-4
TexXt MeNU .. ittt it ittt et et et e aeaeeeeenens 14-5
GraphiCs MEeNU .+ v vt ittt ittt e e et e e eeeeaenans 14-6
EXTra MeNU &ttt ittt ittt et ettt et eeeeeeeeneas 14-7
SEYle MENU vttt ittt ettt et aeeennsanns 14-8
AREXX MENU 4 v v e v o v et e et neeneesneeneeeneeneeas 14-8a

THE RULERS
The rUlers .ottt ittt et e e et et e et et eeeeann 14-9

STARTING FINAL WRITER FROM THE CLI

Starting Final Writer from the CLI .......... 14-10
TOOLTYPES

TOO L T P S ettt et e ettt et et eeeeeesaeneeesanens 14-10a

Defining ToOltyPEeS t ittt ittt eeeeeeennennn 14-11

OTHER TOPICS

FIWMacCroS SCripPLS vt vi ittt ittt eeeeeeeeennns 14-12
Bold, Italic, and BoldItalic text ........... 14-13
Opening foreign documents ........eeieeennnnsn 14-14
Program and document settings ............... 14-14a
Automatic page numbering ........... 000000, 14-15
1.235 14-1
REFERENCE

This chapter contains descriptions of Final Writer’s menus, rulers,
and startup options. These descriptions may include page numbers of this
manual where additional information may be found.
Reference Page 14-1
MENUS
Below are descriptions of Final Writer’s menus. The page numbers that

accompany the descriptions refer to pages in this manual where additional
information can be found.

1.236 14-2

PROJECT MENU

* Kk See Fig 14-1 * % K
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COMMAND ACTION

wew Brings up a mew (page 5-2).

OPEN. .. Open an existing document (page 6-2).

SAVE Save a document.

SAVE AS... Save a text clip

PRINT Print a document and/or make print settings (Chapter 10)

PRINT MERGE

DELETE

PREFERENCES. ..

ABOUT

QUIT

Print form letters using current document and a data
file (Chapter 11).

Delete a file from disk.

Set program preferences (Chapter 3).

Access information about Final Writer (its licensers, and
applicable patent numbers), as well as information about
SoftWood, Inc. (address and phone number for technical

support) (page 1-11).

Exit Final Writer program (pages 1-10 and 2-16).

Reference Page 14-2

1.237 14-3
EDIT MENU
* Kk See Fig 14-1 * % K

COMMAND ACTION

cor Removes selected text from the document and places it on
the Clipboard.

COPY Copies selected text to the Clipboard (page 6-6).

PASTE Transfers text from the Clipboard into your document at
the insertion point (page 6-6).

CLEAR Removes selected text from the document.

SELECT ALL

F'IND

REPLACE

GO TO PAGE

Select all text in the part of the document being edited
(Body, Header, or Footer) (page 5-4).

Locate specific text in your document (page 6-8).

Replace specific text in a document with other text
(page 6-10).

Go to a specific page (page 6-10).
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GO TO SECTION

GO TO SELECTION

INSERT ITEM

UPDATE ITEM

COPY RULER

PASTE RULER

Go to a specific section (page 10-4).
Go to any selected text in document.

Insert the item named in the sub-menu at the insertion
point. Insert Merge Field displays a requester so you
can choose a data name (page 6-12).

Update all instances of inserted dates and times in a
document by choosing "Date" or "Time" from the "Update"
sub-menu. Update selected "Merge Field" by

choosing a data name from the requester (page 6-13)

Makes a copy of the ruler settings for the paragraph in
which the insertion point is set.

Transfer copied ruler settings into the paragraph in
which the insertion point is.

Reference Page 14-3

1.238 14-4
VIEW MENU
* Kk See Fig 14-1 * % K
COMMAND ACTION
pacE viEw Changes page view magnification (page 7-2).

LEFT MASTER

RIGHT MASTER

BODY

TOP RULER

TOP/LEFT RULERS

NO RULERS

Access Left Master page.
Access Right Master page.
Access Body of document.
Show top ruler only.

Show top and left rulers.

Hide top and left rulers.

SHOW BUTTON STRIP Show button strip.

HIDE BUTTON STRIP Hide button strip.

Reference Page 14-4

1.239 14-5
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* kK See Fig 14-2

COMMAND

PAGE SETUP

SECTION SETUP

PARAGRAPH

DEFINE STYLES

APPLY STYLE

BULLET

INDENT RIGHT

INDENT LEFT

HANGING INDENT

NEW SECTION

REMOVE SECTION

INSERT PAGE BREAK

REMOVE PAGE BREAK

LAYOUT MENU

* Kk %
ACTION
Page parameters for entire document (Chapter 4).

Page parameters for a section (Chapter 4).

Set parameters for the current paragraph and/or
program default values (page 7-52).

Commands to create and edit Paragraph styles
(Chapter 7).

Commands to apply paragraph styles.

Convert current or selected paragraphs to bullet
format.

Indent current or selected paragraphs to the right.
Indent current or selected paragraphs to the left.

Convert current or selected paragraphs to a hanging
indent format.

Create a new section of a specific type (page 10-3).
Delete a section from the document (page 10-4).

Insert a page break at the insertion point (page 7-
29) .

Remove a page break in a paragraph in which the
insertion point appears (page 7-29).

References Page 14-5
1.240 14-6
TEXT MENU
* kK See Fig 14-2 * kK
COMMAND ACTION
vt Open fonts or choose fonts that have already been

opened (page 7-12).

TEXT STYLE Commands to create, edit, and assign Text Styles
(Chapter 7).
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SIZE

LEADING

STYLE

POSITION

WIDTH

CASE

COLOR

OBLIQUE PERCENT

TYPE SPECS...

Specify size of text (page 7-13).

Specify leading (line spacing) of your text for
paragraphs with "Variable" line spacing (page 7-14).

Specify the style of text to use - normal, underline,
double underline, or strike through (page 7-14).

Specify the position of text - normal, subscript, or
superscript (page 7-15).

Specify the width of text (page 7-15).

Specify the case of your text - normal, small caps, or
all caps (page 7-16).

Specify the colour of text (page 7-16).

Specify the slant percentage of the italicized text
(page 7-17).

Changes any or all characteristics of existing or
about-to-be-entered text (page 7-18).

Reference Page 14-6

1.241 14-7
GRAPHICS MENU
* % K See Fig 14-2 * kK
COMMAND ACTION
IMPORT Import an IFF ILBM or EPS image into your document
(page 8-8).
SETTINGS Access default settings for various graphic object
types (page 8-2).
ROTATE TO Rotate a graphic object to a spscific degree
(page 8-15).
ROTATE Rotate a graphic object to a specific degree

BRING TO FRONT

SEND TO BACK

GROUP

increment (page 8-15).

Bring a selected graphic item to the front of
several layers of graphic items.

Send a selected graphic item to the back of several
layers of graphic items.

Place multiple selected graphic objects into a
single group.
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UNGROUP

LOCK

UNLOCK

DELETE

Reference Page 14-7

1.242 14-8

o See Fig 14-3

COMMAND

SPELLER

THESAURUS

STATISTICS

OUTLINE

TABLE OF CONTENTS

Remove objects from a group (page 8-18).

Lock the position and size of selected graphic
object (s) .

Unlock the position and size of selected graphic
object (s) .

Delete the selected graphic object (s) (page 8-12).

TOOLS MENU

* K K

ACTION

Access Speller (Chapter 9).

Access Thesaurus (page 9-7).

Displays a document statistics (page 9-8).
Create Outline section (page 10-6).

Create a Table of Contents section (page 10-
8) .

TABLE OF ILLUSTRATIONS .. Create a Table of Illustrations sections (page

ENDNOTES

BIBLIOGRAPHY

INDEX

SORT PARAGRAPHS

1.243 14-8a

* %% See Fig 14-3

10-10).

Commands to insert and edit endnotes and to
create the Endnotes section (page 10-11).

Commands to create bibliography entries and to
create the Bibliography section (page 10-14).

Commands to add to and edit indexed entries
and to create the Index section (page 10-16).

Sort paragraphs from low to high or from high
to low.

USER MENU

* kK
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in
COMMANDS ACTION
OTHER Commands to select an ARexx script, select a text

clip, and execute a string command.

Reference Page 14-8

1.244 14-9

THE RULERS

Final Writer’s rulers are used to show horizontal and vertical distances
in a document. In addition, the horizontal ruler provides an easy, visual
way to set paragraph characteristics. A paragraph is defined as zero or
more keyboard characters terminated by a RETURN key. Every paragraph in a
Final Writer document can have its own ruler settings. When you terminate
one paragraph by pressing the RETURN key, the program automatically
copies the ruler settings of the paragraph just terminated to the new
paragraph. The following settings can be made using the ruler:

Left margin

Right margin

First line indent

Tab stops

Hyphenation "hot-zone"
Paragraph justification
Line Spacing
Hyphenation ON/OFF

L S S R e S

In addition to making the paragraph settings, the ruler amy also be used
to select master pages and various drawing tools, and to specify which
rulers are actually visible on the screen.

* Kk See Fig 14-4 * %k
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1.245 14-10

STARTING FINAL WRITER FROM THE CLI

Final Writer can be operated in either its own custom screen or on the
Workbench screen. The program’s custom screen is a four colour screen
that uses predefined colours that you cannot change. If you want control
over screen colours you will need to operate Final Writer on your
Workbench screen.

You can start Final Writer from either its Workbench icon, a Workbench
icon of a Final Writer document, or from the CLI. When you start Final
Writer from the CLI you can specify an optional command line parameter to
specify the type of screen you want to use. The options for this
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parameter are:

-WB Workbench screen

—-CL Custom interlace screen
—-CN Custom non-interlace screen

Below are example of starting Final Copy from the CLI: These
examples?assume you are within the Final Writer drawer.

FINALWRITER —-CL WORK:DOCS/LETTER Start FinalWriter on a custom

FINALWRITER —-WB

1.246 14-10a

interlace screen, and open the
document titled "Letter".

Start FinalWriter on the Workbench
screen.

TOOL TYPES

The following can be added to Final Writer’s tooltypes that you can
define. The term "PATHNAME" below means the complete path that identifies
a director. For example, WORK:FinalWriter/FWMacros is the pathname
containing the ARexx macros that comes with Final Writer. To assign this
directory as the default MACRODRAWER, set the tooltype as
"MACRODRAWER=WORK:FinalWriter/FWMacros".

NOICON

DOCDRAWER=pathname

GFXDRAWER=pathname

Reference Page 14-10

MACRODRAWER=pathname

FONTDRAWER=pathname

MAKEBACKUP

Don’t create icons for saved documents.

Use "pathname" as the default drawer when opening
or saving a document.

Use "pathname" as the default drawer when
inserting an IFF ILBM graphic.

Use "pathname" as the default drawer when "Other"
is selected from the ARexx menu.

Use "pathname as the default drawer when opening a
font.

Instructs Final Writer to make a backup copy of a
document as it existed the last time it was saved.
The name of the backup document is the same as the
original with ".BAK" appended to the end. For
example, "Hello.BAK" would be the backup copy of
"Hello". Use of this tooltype ensures that you
have a back up of a document prior to new changes
you make. The only down side is that the backup
copy requires disk space.
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1.247 14-11

DEFINING TOOL TYPES

Final Writer tool types are defined from the Workbench "Information"

requester.
TO ACCESS THE "INFORMATION" REQUESTER FOR FINAL WRITER:
1. Locate the "Final Writer" program icon.
2. Click the mouse once on the icon to select it.
3. Select "Information" from the "Icon" menu.
A requester will be displayed showing information about the Final
Writer program's icon. In the list titled "Tool Types" are the Final
Writer's tool types listed above. If the tool type is enclosed in
parenthesis, the tool type is disabled. Tool types not enclosed in
parenthesis are active.
TO DEFINE OR DISABLE A TOOL TYPE:
1. In the "ToolTypes" list, click the mouse on the tool type to be
defined or disabled.
The tool types will be shown in the data entry area.
2. Make the desired changes to the text and press the RETURN key.
3. After all changes have been made, click on "Save".

Reference Page 14-11

1.248 14-12

FWMACROS SCRIPTS

Final Writer comes with several useful ARexx macro scripts that you ~can

use
the

to enhance the power of Final Writer. These scripts are located in
"FWMacros" drawer. You can assign these scripts to buttons in the

User Button Strip and to their purpose are:

SCRIPT PURPOSE

GfxDuplicate Make copy of selected graphic object.
GfxLineWt_Decr Decrement selected graphic'‘s line weight.
GfxLineWt_Incr Increment selected graphic's line weight.
GfxNudge_Down Move selected graphic's position down.
GfxNudge_Up Move selected graphic's position up.
GfxNudge_Right Move selected graphic'‘s position to the right.
GfxNudge_Left Move selected graphic's position to the left.
GfxShadowBow Create shadow of selected graphic.

GfxClip Create a graphic clip macro file.
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Magnify_ Down Reduce page view magnification.

Magnify_Up Increase page view magnification.

SectNumCols_1 Set current section to 1 column.

SectNumCols_2 Set current section to 2 column.

SectNumCols_3 Set current section to 3 column.

TxtDelete_ToEndOfLine Delete text from insertion point to end of line.

TxtLeading_Decr Decrement by 1 point the leading paragraph whose
line spacing is set to variable by.

TxtLeading_Incr Increment by 1 point the leading paragraph whose
line spacing is set to variable.

TxtSelect_Off Unselect selected text.

TxtSize_Decr Decrement text size by 1 point.

TxtSize_Incr Increment text size by 1 point.

TxtStyle_Bold Open "_Bold" version of font.

TxtStyle_Bolditalic Open "_Bolditalic" version of font.

TxtStyle_Italic Open "_TItalic" version of font.

TxtStyle_Plain Open plain version of font.

TxtWidth_Decr Decrement text width.

TxtWidth_Incr Increment text width.

Reference Page 14-12

1.249 14-13

BOLD, ITALIC, AND BOLDITALIC TEXT

Final Writer‘'s outline font engine uses sperate fonts for the plain,
bold, italic, and bolditalic styles. Therefore, if you are typing in
"SofSans_Bold" typeface. Once a bold, italic, or bolditalic typeface is
used for the document, it will be in the "Font" sub-menu. However,
opening the font and later selecting if from the menu can be nuisance.

Four of the ARexx scripts in Final Writer'‘s FWMacros drawer can be used
to connivently open the bold, italic, and bolditalic versions of the
typeface. The names of these macros are:

TxtStyle_Bold

TxtStyle_TItalic

TxtStyle_Bolditalic

TxtStyle_Plain
For maximum convenience you can assign these macros to buttons in a User
Button Strip. For example, once these macros have been assigned to
buttons, you can set text to bold by clicking on the button that has been
assigned the "TxtStyle_Bold" macro. Refer to the "User Button Strip"
section of Chapter 3 - Preferences for details on working with the button
strip. When you choose buttons to use for these macros, you may want to
use the ones provided for this purpose.

You can also assign the above ARexx macro scripts to menu items in the
"User" menu. Refer to the "User Menu" section of Chapter 3 for details on
working with the "User" menu item is to assign an Amiga function key to
the item. For example, if you assign "F1" to the menu item that has been
assigned "TxtStyle_Bold", you simply press the "F1" key to set your text
to bold.
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1.250 14-14

OPENING FOREIGN DOCUMENTS

Final Writer can open documents created in WordPerfect, ProWrite, and
PenPal. You open a document created in any other word processors just as
you open documents created in Final Writer. There is no conversion
process that you are required to do. When you instruct Final Writer to
open a document, it checks to see who created the document. If the
document was created in one of the above word processors, Final Writer
document is opened. Warning, if you save the document, it will be saved
as a Final Writer document. There fore, if you want to retain the
document in its original format, you should make a copy of it before
opening it in Final Writer.

1.251 14-14a

PROGRAM AND DOCUMENT SETTINGS

When you run Final Writer after it is first installed on your hard
drive, preference and style settings are set by Final Writer to values
contained within the program itself. Whenever you save preference or
style settings they are saved to disk named "FW.Prefs" which is located
in the "FWFiles" drawer. From then on whenever you start Final Writer or
beginning a new document the preference and style settings are obtained
from the "FW.Prefs" file. If you ever want to revert back to the original
program settings that existed before the "FW.Prefs" file was created,
simply delete the "FW.Prefs" file. The easiest way to do this is to use
Final Writer‘'s file was created, simply delete the "FW.Prefs" file. The
easiest way to do this is to use Final Writer'‘s "Delete" command located
in the "Project" menu.

Based upon the "Document Save Preferences" Final Writer can save unique
preference and style settings with each document. When a document is
opened, Final Writer replaces its current preference and style settings
with any that are stored with the document. In some situations you may
wish to reset one or more of the preference and style settings saved with
a document to the final Writer default settings.

Reference Page 14-14

TO RESET A DOCUMENT 'S PREFERENCE OR STYLE SETTINGS TO THE PROGRAM
DEFAULTS:

1. Open the document.

2. Access the "Document Save Preferences" requester.

See the section "document Save Preferences" in Chapter 3 for details
on accessing this requester.
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3. Remove the check mark in

4. Click on "Use".

5. Save the document.

6. Close the document.

front of the setting you want to reset.

The next time you open the document, the settings will be reset.

1.252 14-15

AUTOMATIC PAGE NUMBERING

You can insert a page number anywhere on a master page in your document.

The "Page Setup" requester and the "Section Setup" requester (refer to
Chapter 4) allow you to specify the first number that Final Writer is to
use for numbering pages in your document when you use the automatic page

numbering feature.

TO USE THE AUTOMATIC PAGE NUMBERING FEATURE:

1. Click on the Master Page
(refer to page 2-13).

2. Move the insertion point
number to appear.

3. Select "Insert Item/Page
A "#" symbol will appear

4. Click on the "Body Page"
main body of the text.

icon you wish your page number to appear on

to the position where you want the page

Number" from the "Edit" menu.
at the insertion point.

icon (refer to page 2-15) to return to the

The correct page number will be displayed at the selected position.

Reference Page 14-15

1.253 a

APPENDIX A

CURSOR KEY FUNCTIONS

As you get used to using Final Writer,

keys on the right side of the keyboard. When pressed, the cursor keys
achieve the following actions:

CURSOR KEY CURSOR ACTION

you may wish to learn some of its
cursor key functions. The cursor keys are up, down, right, and left arrow
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Left_Arrow Move to previous character
Right_Arrow Move to next character
Up_Arrow Move to previous line
Down_Arrow Move to next line

The CTRL and ALT keys can be used to modify the action of the above
cursor keys. In the list that follows the "+" character indicates that
keys are pressed together. When cursor keys are pressed while holding the
CTRL, and/or ALT keys down, these actions result:

KEYS CURSOR ACTION

CTRL+Left_Arrow Move to beginning of current or previous word
CTRL+Right_Arrow Move to beginning of next word

CTRL+Up_Arrow Move to beginning of current or previous line
CTRL+Down_Arrow Move to beginning of next line

ALT+Left_Arrow Move to beginning of current or previous sentence
ALT+Right_Arrow Move to beginning of next sentence

ALT+Up_Arrow Move to beginning of current or previous paragraph
ALT+Down_Arrow Move to beginning of next paragraph

CTRL+ALT+Left_Arrow Move to beginning of current line
CTRL+ALT+Right_Arrow Move to end of current line
CTRL+ALT+Up_Arrow Move to beginning of document
CTRL+ALT+Down_Arrow Move to end of document

If you also depress the SHIFT key with any of the functions described

above, the text through which you are moving will be selected (if not
already selected) or deselected (is already selected).

1.254 b

APPENDIX B

KEYBOARD SHORTCUTS

Whenever a menu item appears with a letter to the far right of the
item’s border, you have the option of using the keyboard to choose the
menu item rather than using the mouse.

TO USE THE KEYBOARD TO CHOOSE A MENU ITEM:

1. Hold down the "A" (Right Amiga) key that is on the right side of the
spacebar on the keyboard.

2. While continuing to hold down the "A" (Right Amiga) key, press the
key that is appropriate for the menu item you want to choose.

| N New | X Cut | . Paragraph
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| O Open | C Copy | L Insert Page Break |
| S Save | V Paste +t——————— +
| W Save AS | D Clear |
| P Print | A Select All |
| Q Quit | 3 Insert Date
+————— + 5 Insert Time
| 7 Insert Page # |
| 8 Insert Merge Field |
| 4 Update Date |
| 6 Update Time |
| 9 Update Merge Field |
| 0 Copy Ruler |
| 1 Paste Ruler |
o +
Fo o Fom et T +
| TEXT MENU | GRAPHICS MENU | TOOLS MENU |
o o o +
| T Open Font | 2 Import | [ Speller
| B Normal Style | J Bring To Front | 1 Thesaurus |
| U Underline | K Send To Back Fm————— +
| E Double-Underline +———————————————-— +
| I Strike Thru |
| ! Normal Position |
| @ Superscript |
| # Subscript |
| $ Normal Case |
| % Small Caps |
| ~ All Caps |
| , Type Specs |
fom +

Keyboard Shortcuts B-1

1.255 c

APPENDIX C
HELPFUL HINTS FOR BETTER DOCUMENTS
READABILITY AND LAYOUT

The ultimate gaol of any documents is to be read. Your job, as the
creator of that document is to do everything in your power to make it
appealing and readable. Layout is merely a way of drawing a way of
drawing the reader through the pages and should never interfere with the
reader’s ability to read and understand the message of the document.

The following are some suggestions on how to make your document look

good and get read. These are just guidelines. There is no substitute for
your own instinct and experiment when it comes to making your document the
best it can be.

SERIF VS. SANS SERIF
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A serif typeface is one in which the strikes of the letters end with
small finishing strokes. Sans serif type do not.

MIXING TYPEFACES

Final Writer gives you the flexibility to combine any number of typefaces
in your documents. If you follow a few general guidelines when mixing,
your results will be very effective.

First, similar typefaces are normally not used together. That’s why you
should not use two serif (or two sans serif) faces on the same page. The
substitutes that make each typeface unique are lost when two more similar
faces are competing.

Second, minimize the number of typefaces, size, style, case formats,
etc. on each page. It may be tempting to use as many of Final Writer’s
exciting features as possible in each document, but the result would be a
very busy, confusing jumble. By all means, experiment with your type, but
keep each document clean and readable.

Third, provide a contrast between headlines and body text in your
document. You will notice that most publications use bold sans serif
typeface for headlines and a serif face for the text. There are reasons
for this tried and true practice. A bold sans serif face provides and

Helpful Hints for Better Documents C-1

instant "pop" of recognition and legibility (an important requirement for
headlines), while serif face gives the readability that is so important
in larger blocks of text.

BODY TEXT

Sans serif type gives a clean, less conventional look to your text, but
is not as readable in large quantities as serif text. So while you might
wish to use sans serif type face occasionally for your body text,
remember that it is not usually as readable as a serif face.

HEADLINES
In order to be effective, headlines should be left justified. This
guideline is based on the rudiments of reading. Your eyes naturally wants
to move to the right and downward. A left Jjustified headline has the
effect of pulling your reader’s eyes into the body text below.

Avoid all caps in a headline, too. A series of capital letters slows
down the readers ability to decipher the words, and you want the headline
to grab them quickly and pull them into the text.

Above all, be consistent. All headlines in a document should be of
uniform size and style.

COLUMNS AND LINE LENGTH

Studies have shown that seven to eight words per line are most readable
(a serif typeface may handle nine to ten words per line without
sacrificing too much readability). This may be achieved in several ways
using Final Writer’s columns and type features.
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First, consider increasing the number of columns if you have large
blocks of text. If you elect to use very narrow columns, use left
justified type to avoid hyphenation and spacing problems that can occur
with full justified type.

Second consider increasing the size of your type if it is wvery small.
Typical, body text is set in 10 or 12 point type. Anything smaller than
the alienates an older reader and impairs readability for readers of all
ages.

Helpful Hints for Better Documents C-2
WHITE SPACES

When designing your documents, do not hesitate to leave blank spots, or
white spaces in your documents. A page that is filled completely with
text and graphics can look overwhelming to a reader and decrease his or
her likelihood of actually reading your document. White space, however,
gives the page a feeling of openness and gives your reader room to
breathe.

White space may be achieved in may ways. Try using wide margins, or
leaving empty space before or after a headline. To see how white space is
used by designers, study a few magazines, paying special attention to the
advertisements. Then take what you like and apply it to your own
documents.

WIDOWS, ORPHANS, AND RIVERS

These are three big typographical problems with funny names. Avoiding
them whenever possible.

A widow occurs when a paragraph ends and leaves less than seven
characters in the last line (the last line is called the widow). This is
made even worse when the last line is only a portion of a hyphenated
word. Adding a word or widening a margin slightly will usually correct a
widow.

An orphan occurs when the last line of a paragraph is too long to fit
entirely at the bottom of a column and continues at the top of the next
column. An orphan may be corrected by removing words or lengthening a
column slightly.

A river occurs when the spaces between words becomes greater than the
space between the lines. The phenomenon typically occurs only when you
are working with fully justified text. Be alert to any rivers of white
running vertically through your text. It may be possible to correct this
problem by switching to left Jjustified text.

Helpful Hints for Better Documents C-3

1.256 d




219/239

APPENDIX D

GLOSSARY
ALL CAPS - All capital letters.
AREXX - Amiga ARexx macro language.
ASCENDER - The part of a lowercase letter that moves above the x—height
(letters with ascenders including h,t,f, and 1). Leading or
line spacing must allow enough room for ascenders.

ASCII - File format used in most text editors.

BASELINE - An imaginary line that runs along the bottom of letters. A
portion of some letters descend below the baseline.

BODY COPY - A page or column of body type.
BODY TYPE - Type sized 12 points or smaller.

BOLDFACE TYPE - Type that is blacker and heavier than its normal
appearance.

BULLET - A bold dot or mark that is used to draw attention or to set off
an element in a series or list.

CACHE - An internal-memory listing used by the speller to store recently
used words, thereby eliminating the need for disk accesses to
verify their spelling.

COLUMN - A section of a page that runs from top to bottom.

COPY - A word used to refer to written material.

DESCENDER - The part of a lowercase that descends below the baseline.

Leading or line spacing must leave enough room for

descenders.

DISPLAY TYPE - Any type larger than 12 points, such as that used for
headlines and titles.

FLUSH LEFT - Type that is aligned even with the left margin.
FLUSH RIGHT - Type that is aligned even with the right margin.
Glossary D-1

FONT - The word used to refer to a complete family of type in a
particular style or design.

GADGETS - Areas on a window or requester that are clicked on to perform
some action.

HANGING INDENT - An indent where the second and all following lines of a
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paragraph are indented a preset amount of space.

HYPHEN HOT ZONE - The point in a line of text where a word becomes
eligible for hyphenation.

ITALIC TYPE - Type that slants to the right. May be used instead of
underlining to designate names of publications, etc. Also

may be used for emphasis or decoration.

LEADING - The amount of space between lines of type, as measured in
points. Leading rhymes with bedding.

LOWERCASE - Small (non-capitilized) letters.

ORPHAN - A solitary line of type at the top of a page or column: usually
the continuation of text in the previous column.

PICA - One-sixth of an inch, or 12 points.

POINT - A unit of measure applied to type. There are 72 points in an
inch.

RAM - The abbreviation for random access memory. This is your computer’s
internal memory bank which is used for running programs such as

Final Writer.

SANS SERIF TYPE - A typeface in which all strokes in the letter are
similar and do not have serifs.

SCRIPT - Type that resembles calligraphy or handwriting.

SCROLL GADGET - The Final Writer gadget that enables you to scroll
through your document. The scroll gadget has three
components: the scroll bar, the scroll box, and the
scroll arrows.

Glossary D-2

SERIF - Small finishing strokes appearing at the end of a letter stroke.
The definition portion of this entry appears in serif typeface.

SMALL CAPS - Capital letters that appear smaller than regular capital
letters for a specified point size.

TOMBSTONE HEADLINES - Side-by-side headlines in the same size and style
An undesirable occurrence.

TYPEFACE - A particular style of type.
UPPER CASE - Capital letters.

WHITE SPACE - The space on a page that is not occupied by text or
graphics.

WIDOW — A line of type at the bottom of a page or column; usually the
beginning of text in the next page or column.
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X-HEIGHT - The height of the lowercase x in a certain typeface.

Glossary D-3
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APPENDIX E
ACCESSING SPECIAL CHARACTERS

Accented characters contained in a font can be accessed through the use
of a "Dead Key" combination. A "Dead Key" combination is entered by
pressing the ALT key and anothe key at the same time. When the Dead Key
combination is pressed, nothing appears on the screen until you release

the keys pressed, and press a third key such as an "a", "e", "i", "o",
"y", lln", "A", "E", "I", IIO"’ "U", "Yll’ Or "N". For eXample, if Want the
the character "4&", first press the ALT and "f" keys at the same time,
release these keys, and then press the letter "a". If you do this

correctly, you will see the "&" character when you press the letter "a".

In the following chart the "+" character indicates the ALT key and the
character following the "+" is to be entered at the same time (don'‘t
press the "+" character). When a third character is shown, enter it after
the ALT key combination has been pressed and released.

NOTE. Not all typefaces contain these characters.

CHARACTER HOW TO ACCESS IT CHARACTER HOW TO ACCESS IT
& ALT+f a A ALT+F A
a ALT+g a A ALT+G A
a ALT+h a A ALT+H A
a ALT+j a A ALT+J A
a ALT+k a A ALT+K A
a ALT+qg A ALT+Q
é ALT+f e E ALT+F E
& ALT+g e E ALT+G E
é ALT+h e E ALT+H E
é ALT+j e E ALT+J E
i ALT+f 1 1 ALT+F I
i ALT+g 1 I ALT+G I
1 ALT+h 1 1 ALT+H I
i ALT+3 i I ALT+J I
6 ALT+f o 6 ALT+F O
o ALT+g o© O ALT+G O
5 ALT+h o 6 ALT+H O
& ALT+3 o O ALT+J O
o ALT+k o© O ALT+K O
4 ALT+f u U ALT+F U
u ALT+g u U ALT+G U
a ALT+h u 0 ALT+H U
5! ALT+k u U ALT+K U
fi ALT+3j n N  ALT+J N
% ALT+k k Y ALT+K Y
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Accessing Special Characters E-1
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APPENDIX F
EPS CLIP ART

You can import Encapsulated PostScript Clip Art (EPS Clip Art) into your
Final Writer documents. EPS clip art is to graphic images as outline
fonts are to type -- both are printed using the full resolution of a
printer. The result is a very sharp and clear image unlike the way
bitmapped images appear on printouts.

Final Writer will print EPS images on any graphic or PostScript printer.
In addition, you can view EPS images on screen. The only disadvantage of
EPS images is the amount of time it takes the computer to process an
image. When you print a document with an EPS image, it will take longer
to print the portion of the document containing an EPS image on the
screen, it will take considerably longer for the program to open or
resize the image.

Some EPS images contain text that is to be created using fonts in a
laser's PostScript ROM. If you are printing one of these images to a
PostScript printer, the text should appear correctly. If you are printing
to one of these images to a graphic printer, the text will not appear.

Because of the length of time needed to load and display an EPS image on
screen, Final Writer gives you the option of showing either a preview of
the image (if one exists), or simply a box that either a preview of the
image ‘s size and position. This option is set in the "Imported Graphic
Settings" requester. If you are about to import eps images, you may want
to first access the "Imported Graphic's Settings" requester and make sure
either the "Preview" or "Cross Box" option are selected. If you decide to
show the full EPS image on the screen, Final Writer will not display it
in colour on the screen. Whenever you print, all EPS images are printed
in full colour (if possible) and in full detail regardless of how they
are displayed on the screen.

The EPS images that are included with Final Writer are not Public
Domain. The owners of the images have agreed to let SoftWood include the
images with Final Writer in order to advertise their clip-art
collections. You can use these images in your documents, but the images
themselves may not be freely distributed or resold. On the following
pages of clip-art the copyright owner of the clip-art is mentioned at the
bottom of each page. At the end of the Appendix is information on each of
these companies.

EPS Clip Art F-1

1.259 ¢
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APPENDIX G
OUTLINE FONTS

Final writer supports 3 outline fonts formats: Type-1, ~Compugraphic,
~and ~NimbusQ. In order to use Compugraphic ~fonts, ~you must have
Workbench 2.1 or higher. The NimbusQ file format used in Final Writer is
similar to, but not the same as the NimbusQ format on other computers.

Compugraphic fonts are supported in Final Writer because at one time the
Compugraphic format was supposed to be the standard outline format for
the Amiga, Type - 1 fonts are supported because there are thousands
available and are more industry standard than Compugraphic fonts. Through
public domain sources one can find hundreds of Type-1 fonts that can be
used with Final Writer. Unfortunately most of the public domain Type-1
fonts were not created by professional typeface designers, and are not as
good as ones available commercially. NimbusQ fonts are faster to use than
either Compugraphic or Type-1 fonts, yet they have the same and sometimes
better quality.

There are over 100 outline typfaces included with Final Writer -- all in
the NimbusQ format. 100 of these typefaces are licenced from B&P Graphics
from their "Serials" collection. On the following pages fonts from B&P
Graphics are shown in three categories: SansSerif Fonts, Serif Fonts, and
Decorative Fonts. All fonts listed in the remaining pages of this
Appendix are Copyright B&P Graphics, Inc.

Outline Fonts G-1
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"About’ command 14-2
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inserting 6-12
updating 6-13
Decimal style 3-12
"Define TextStyles’ requester 7-20

Deleting
blank lines (RETURN character)
block of text 2-5
character 5-6
files 14-2
object 8-12a
selected text 5-6a
Density 11-6

Display Preferences
IFF 'On Screen’ colours 3-6
Measure in 3-6
page guides 3-6
Rulers 3-6
Screen DPI 3-6
WB Document Color 3-6
Window size 3-6

Index - 1
Dithering

halftone 11-7
ordered 11-7

Document
closing 2-7
5-7
creating 2-2
formatting 2-8
7-1
opening 2-8
6-2
preferences 3-12
3-14
3-16
revising 2-4
6-1
saving 2-7
5-7
settings 14-14a

statistics 9-8
Document Color preferences 3-14

Document Item preferences
Date Format and Order 3-12
Decimal 3-12
Tabs Every 3-12
Time Format 3-12

Document Save Preferences 14-14a
Save With Each Document 3-16

"Document Scan’ mode 9-3
Double-click 1-3

5-6b
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DPI 3-6
Draft mode printing 11-1

Draft Preferences’ requester
lines per page 11-9a
margins 11-10
Pitch 11-11
quality 11-11
spacing 11-11

Drag 1-3

Edit area 4-5
"Edit’ menu 1-6

14-3
Encapsulated PostScript 8-8a
Endnotes 10-11
"Endnodes’ command 14-8
EPS Clip Art F

Error Reporting 3-10

Final mode printing 11-1
"Find’ command 14-3
Finding and replacing text 6-10

Finding text
next occurrence of specified text
specified text in document 6-8
First line indent margin 7-5

Fonts
changing font size 2-11
opening 7-12
selecting 7-12a

size 2-11
7-13
Footers 2-12
4-6
7-28a

Form Letters
creating 12-6
merge field 12-8
merging data 12-9Db
producing 12-2
removing a merge field 12-9
saving 12-9a
Format 4-6
Front to back gadget 1-10
FW.Prefs 14-14a
FWMacros scripts 14-12
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Glossary Appendix D

"Go To’ commands
go to selected text in a document 6-4
go to specific page in a document 6-4
"Go to Page’ command 14-3
"Go to Section’ command 14-3
"Go to Selection’ command 14-3
"Graphic Final Print Preferences’ requester 11-5a

Graphic Preferences
color correct 11-7
density 11-6
dithering 11-7
printer driver 11-6
shade 11-7

Index - 2
threshold 11-6

Graphics,
Boxes
drawing 8-5
perfect squares 8-6
rounded cornered 8-6
cancelling graphic action 8-18
colours 8-19
constrained moving 8-14Db
creating 8-2a
deleting 8-12a
exact size and location 8-16a
HAM format 8-8a
IFF ILBM format 8-8a

IFF ILBM images
constrained sizing 8-13a
cropping 8-17
importing 8-8a
restoring 8-17

Lines
arrow-tipped 8-4
drawing new 8-3a
modified setting 8-16
moving 8-14a

Ovals
drawing new 8-7
drawing perfect circles 8-8
"Quick’ sizing 8-14
selecting 8-11
"Settings’ requesters 8-2
sizing 8-13
"Snap To’ moving 8-14c
"Snap To’ sizing 8-13b
"Graphics’ menu 1-6
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14-7
"Group’ command 14-7
Grouping objects 8-18a

"Hanging Indent’ command 1
Hardware required 1-2
Headers 2-12

4-6

7-28a

4-5

Helpful Hints for Better Documents Appendix C

Highlight 1-3

Hyphenation
"Hot Zone’ margin
"On/Off’ 1-7a
7-11
preferences 3-10

IFF ILBM 8-8

IFF ’On Screen’ Colours 3-
"Import’ command 14-7
"Imported Graphic Settings’
In List Show 4-4

"Indented Left’ command 14
"Indented Right’ command 1
"Index’ command 14-8
"Insert Item’ command 14-3

7-17

6
requester 8-9

-5
4-5

"Insert Page Break’ command 14-5

Inserting
blank lines 5-3b
characters 5-3a
date or time 6-12
text 2-4

Insertion point
setting 5-
Inside margin 4-5
Installing 1-4
Italic 14-13

3

Justification 1-7a
2—-8a
7-9

Keyboard Short-cuts Appendix B
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"Layout’

Leading

menu 1-6
14-5
7-14

"Leading’ command 14-6

Index — 3

Left margin 7-4
Left/Right pages 4-3
"Line Settings’ requester
"Lock’ commands 14-7

Margins

first line indent

Hyphen ’Hot Zone’
inside 4-5
left 1-7a

7-4
outside 4-5
right 1-7a

7-4
setting 2-10

Master pages

Measure
Menus 1
Merge fi

about 2-12

define left and/or right
headers and footers
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eld 12-6

Merging data with a form letter
Moving graphics 8-14a
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text 2-6
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Page
breaks 7-29
guides 3-6
left/right 4-3
number 1-7a
14-15
prefix and first # 4-6
right only 4-3
size 4-2
View 7-2

"Page Number’ icon
go to the first page of a document 6-4a
go to the last page of a document 6-4a
go to the next page 6-4a
go to the previous page 6-4a

"Page Setup’ requester
Number Pages and Page #s 4-3
Orientation 4-3
Page Size 4-2
Pages 4-3
Print Area 4-3
"Page View’ command 14-4

Paragraph
alignment 7-9
settings 7-4
setup 7-3
sorting 6-13a
spacing 7-10
"Paragraph’ command 14-5
"Paragraph’ requester 7-3a

Paragraph Styles
applying 7-22
defining 7-25
deleting 7-25b
modifying 7-25a
"Style Definition’ requester 7-23
Using the ’'Tabs’ requester 7-25c
Paste command 6-6
67
14-3
"Paste Ruler’ command 14-3
PenPal 14-14
Point 1-3
"Position’ command 14-6

PostScript Preferences
crop marks 11-9
download fonts 11-8a
halftoning 11-8a
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orientation 11-9
page mode 11-8a
page size 11-9
printer type 11-8a
scaling 11-9

shade 11-7

PostScript printing
advanced topics 11-13
communicating with Serial Port
handshaking 11-11b
preferences 11-11b

Preferences
ASCII I/0 3-8
Display 3-6
Document Colour 3-14
Document Items 3-12
Document Save 3-16
Screen Colours 3-18
Speller and hyphenation
Startup 3-9
User Button Strip 3-4
User Menu 3-2
"Preferences’ command 14-2
Press 1-3
Print Area 4-3
"Print’ command 14-2

"Print Document’ requester

collate 11-4

number of copies 11-4

order 11-5

pages 11-4

paper feed 11-5

preferences 11-4

print to 11-5

section 11-4

set default 11-5
"Print Merge’ command 14-2
Printer Driver 11-6

Printing a document

draft mode 11-1

final mode 11-1
how to stop 11-3

Program Command Strip 1-7a
Program settings 14-14a
"Project’ menu 1-6
14-2
ProWrite 14-14

"Quit’ command 14-2
Quitting 1-10a
2-16

11-11b

3-10
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RAM Directory 3-10
"Remove Page Break’ command 14-5
"Remove Section’ command 14-5
"Replace’ command 14-3

Replacing text

Finding and replacing text

Using the

Right Page

6-10

"Paste’ command 6-6
With new text 6-5

Right margin 7-4

Right only pages 4-3

4-5

"Rotate’ command 14-7

"Rotate Tof
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command 14-7

mode selectors 1-7a
options 3-7
settings 14-9

using 7-3

"Save’ command 14-2
Save With Each Document 3-16

Saving

changes 2-16
document 2-7

5=17

Screen Colour preferences 3-18

Screen DPI
Scroll bars

3-6
1-9

Scrolling text 6-3

Index - 5

"Section Set
Section Setu
Columns
Edit Area
Format 4
Headers a
In List S
Page #s:
Section L
Section N

Section Types

up’ command 14-5
p requester 4-4
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10-11
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table of contents 10-8
table of illustrations 10-10
title page 10-5

Sections
creating 10-3a
deleting 10-4a
going from one section to another 10-4
normal 10-3
printing 10-4b
reformatting special sections 10-18a
special 10-2
updating special sections 10-18

Select 1-3

"Select All’ command 14-3

Selecting
block of text 5-5
fonts 7-12
objects 8-11
single word 5-5
"Send to Back’ command 14-7
Setting margins 2-10
"Settings’ command 14-7
Settings requester 8-2
Shade 11-7
"Size’ command 14-6
Size gadget 1-10
Skip Cache Size 3-10

Index — 6

"Sort Paragraphs’ command 14-8
Sorting paragraphs 6-13a
Spacing 1-7a

Spacing, line
1-1/2 7-10
double 7-10
single 7-10
variable 7-10
Special characters E

Speller
adding words 9-6
"Alternatives’ list 9-5
correcting errors 9-4
deleting words 9-6a
"Document Scan’ mode 9-3
ignoring 9-5a
suggestions 9-4b
"Word Verify’ mode 9-2
"Speller’ command 14-8
Speller/Hyphenation preferences 3-10
Auto Suggest 3-10
Cache Size 3-10
Error Reporting 3-10
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Hyphenation 3-10

Memory Usage 3-10

RAM Dictionary 3-10

Skip Cache Size 3-10
Starting Final Writer 1-5
Starting Final Writer from
"Startup’ preferences 3-9
"Startup’ screen 1-5
Statistics 9-8
"Statistics’ command 14-8
"Style’ command 14-6
System software required 1

Tab stops 1-7a
center tab 7-6
decimal tab 7-6
deleting 7-6
left tab 7-6
moving 7-6

Index - 7

right tab 7-6

selectors 1-7a

setting 7-6
Table of Contents 10-8
"Table of Contents’ command
Table of Illustrations 10-

"Table Of illustrations’ command

Tabs Every 3-12
"Tabs’ requester 7-25c

Technical support
American English version
British English version
Limits on 1-11

Text
aligning 2-8a
case 7-16
7-18
colour 7-16a
7-18
copying 6-6a
correcting
deleting

5-4

2-5
5-6

finding 6-8

CLI 14-10

-2

14-8
10

1-11
1-11

finding and replacing 6-10

flow 8-5a
8-T7a
font size 2-11
7-13
7-18

inserting 2-4

14-8
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5-3
leading 7-14
7-18
moving 2-6
6-7

oblique percentage 7-
7_

position 7-15
7-18
replacing 6-5
selecting 5-4a
style 7-14a
7-18
width 7-15a
7-18

Text Blocks
changing the text settings
creating 8-10
Text Clips 5-8
"Text’ menu 1-6
14-6
Text Styles
adding 7-21
applying 7-20

17
18

8-10

"Define Text Styles’ requester

deleting 7-21b
modifying 7-21la
Thesaurus 9-7
"Thesaurus’ commands 14-8
Threshold 11-6

Time
format 3-12
inserting 6-12
updating 6-13
Title bar 1-7
Toolbox 1-7a
"Tools’ menu 1-6
14-8
ToolTypes 14-10a
"Type Specs’ commands 14-6
"Type Specs’ requester 7-18

"Ungroup’ command 14-7
"Unlock’ command 14-7
"Update Item’ command 14-3
Updating date and time 6-13
User Button Strip 1-7
14-13

User Button Strip preferences
User Command Strip 3-4

selectors 1-8
"User’ menu 1-6

14-8a

3-4

7-20a
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14-13
User Menu Preferences 3-2

"View’ menu 1-6
14-4

WB Document Colour 3-6
"Width’ command 14-6

Window
new 5-2
size 3-6

Window Gadgets
close box 1-10
front to back gadget 1-10
size gadget 1-10
Word Verify mode 9-2
WordPerfect 14-14

1.261 addendum

LSD
presents

Final Writer Release 2
Addendum to user Manual

Typed and edited by DIT

Please keep the addendum with your Final Writer Manual. It discusses new
features in Release 2 that are not covered in the User Manual. Included
in this addendum are descriptions of the following new features:

Undo/Redo

Font/Style Strip

Easy-to—-Select Bold, Italic, and Underline
Floating Palettes

"View" menu changes

*"Layout" menu changes

b S e

UNDO/REDO
* kK See Fig A-1 * kK

The "Undo" command is found in the "Edit" menu. You use "Undo" to
instruct Final Writer to return a document to the way it was before the
last typing, editing, or formatting command. Normally, instead of seeing
"Undo" in the "Edit" menu you will see "Undo" followed by some action as
"Undo Typing". The action description lets you know what you can undo.
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Once you choose "Undo" the menu item changes to "Redo". Use "Redo" to
instruct the program to return a document to the way it was before you
chose "Undo". Generally you can undo a command as long as you have not
preformed another command. For example, if you change the size of some
text, you can undo the size change as long as you don’t start typing
characters. If you perform an action that is not supported by undo, the
menu item will read "Can’t Undo".

FONT/STYLE STRIP

The FONT/STYLE Strip is an optional strip that appears at the top of a
document’s window. In Final Writer User Manual, all illustrations showing
a document window show the original "Tool Strip". Only one of these
strips can be visible at one time. You can save either one of these
strips as default for the program or for the document. Either strip can
be selected by choosing the appropriate menu in the "Paragraph Strip"
sub-menu within the "View" menu. You can also select the desired strip by
using the "Display" preferences requester.

* kK See Fig A-1 * kK

EASY-TO-SELECT BOLD, ITALIC,AND UNDERLINE

When the "Font/Style Strip" is visible you can click on icons to change
text to different combinations of Bold, Italic, and Underline. The Bold
and Italic icons will only work on text with a font that contains a Bold
and/or Italic font on your disk. All of Final Writer’s Serif and Sans
Serif have full bold, italic, or bolditalic using icons. You can,
however, use the Oblique feature to italicize any font regardless of
whether there is a italic version for the font or not.

* kK See Fig A-1 * kK

You use the bold, italic, and underline icons just as you use items in
the "Text" menu. In other words you can affect existing text by selecting
it with the mouse and clicking on an icon, or change new text to be
entered by positioning the insertion point in the document and clicking
on an icon.

FLOATING PALETTES
* kK See Fig A-2 * kK

there are three palettes available which you can use to select tools,
user buttons, and paragraph styles. You can show or hide palettes by
choosing the appropriate menu command from the "View" menu. Once a
palette is shown, you can move its window anywhere on your screen. You
can also resize the "User button" and "paragraph Styles" palettes. When
you quit Final Writer, the program will remember which palettes were
open, where they were on the screen, and their sizes. The next time you
start Final Writer, the palettes will be restored to their size and
position automatically.

Palettes are shared between document windows. Therefore, if you have
more than one document window open, only one set of palettes will be
used. When you activate a document window, the appropriate settings in
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each palette will be selected to agree with the active document. When you
choose an item in a palette window, the document window remains active -
not the palette window. However, if you click on a palette’s title bar,
or change the size of the palette, the palette window becomes active.
When this occurs you must click the mouse on the title bar of your
document window to reactivate the document window.

Palettes can be positioned and sized with the mouse. You can also
position and size palettes using the keyboard as follows:

x Left, Right, Up, and Down arrows - move palettes in medium sized
increments.

* Ctrl along with Left, Right, Up, and Down arrows — move palettes in
one-pixel increments.

* Shift along with left, Right, Up, and Down arrows — move palettes to
either side of screen.

* Space bar - sizes palette to exactly fit the buttons shown within it
for the current size.

All above keyboard manipulations require that you first select the
palette by clicking on its title bar.

Palette windows may be closed by:
* Choosing the appropriate "Hide" command in the "View" menu.
* Clicking in the palette window’s "Close" gadget.

* Pressing the "Esc" key once a palette window is active.

"VIEW" MENU CHANGES
The "View" menu has been rearranged to allow you to:
* Select Body, Left Master, or Right Master pages for editing.
* Show/Hide the three floating palettes.

* Choose which user button strip is active, or hide the user button
strip.

* Choose which paragraph strip is active, or hide the paragraph strip.
* Choose which rulers are to be visible.
* Choose which page guides are to be visible.

Most of the above actions can also be selected in the "Display"
preferences requester.

"LAYOUT" MENU CHANGES

The "Layout" menu has been rearranged to allow you to:
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Set paragraph text alignment to left, right, center, or full
justification.

Set line spacing to single, one and a half, double, or variable.

Bullet, Hanging Indent, Indent Left, and Indent Right are now in the
"Effects" sub-menu.
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